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HPE Software Support provides customer self-solve capabilities. It provides a fast and efficient way to access
interactive technical support tools needed to manage your business. As a valued support customer, you can benefit
by using the support website to:

Search for knowledge documents of interest

Submit and track support cases and enhancement requests
Download software patches

Manage support contracts

Look up HPE support contacts

Review information about available services

Enter into discussions with other software customers
Research and register for software training

Most of the support areas require that you register as an HPE Passport user and sign in. Many also require a
support contract. To register for an HPE Passport ID, go to https://softwaresupport.hpe.com and click Register.

To find more information about access levels, go to:
https://softwaresupport.hpe.com/web/softwaresupport/access-levels

HPE Software Integrations and Solutions

Visit the Integrations and Solutions Catalog at https://softwaresupport.hpe.com/km/KM01702731 to explore how
the products in the HPE Software catalog work together, exchange information, and solve business needs.
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Chapter 1: Business Process Monitor
Overview

Business Process Monitor (BPM) is one of the HPE Application Performance Managementt (APM) data
collectors. BPM proactively monitors enterprise applications in real time, identifying performance and
availability problems before users experience them. It enables you to monitor sites from various locations,
emulating the end-user experience, and so assess site performance from different client perspectives.

This sectionchapter includes:

« "BPM Operations" below

« "BPM Installation" below

« "Configuration, Administration, and Troubleshooting" on the next page
« "Setting Up BPMs" on page 10

» "Changing the Time on the BPM Machine" on page 10

« "BPM Admin" on page 1

BPM Operations

The BPM service performs the following operations:

« Collecting transaction performance data (application response time and availability) from various points,
as well as from external locations.

« Retrieving business process configuration information (including applications, business transaction flows,
transactions, and recorded scripts) from the profile databases via the APM Gateway Server.

« Performing the work defined in the applications and business transaction flows (including running
transaction monitor scripts and WebTraces).

« Monitoring the task and aggregating relevant data, performing all necessary calculations.

« Reporting error information during the execution of tasks.

BPM sends the collected data to APM, where you can use the applications to view and analyze the data, in
order to monitor the performance of your business applications and infrastructure.

BPM Installation

You install BPM on host machines on your local network or on the Internet. Once installed, BPM runs
independently as a service on the host machine. You generally deploy BPMs on multiple host machines, but
you can also use each BPM installed on a host machine as the basis for many logical BPM instances. For
example, you may want to use each instance on the host machine to run tests for a different division of your
organization, or use duplicate instances during the staging period for APM upgrade to communicate with the
different APM versions.
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Each instance can be connected to a different APM platform, or there may be several instances connected to
a single APM platform (using a unique logical host name for each).

After installing BPM on a machine, the machine is added to the list of data collectors in EUM Administration.
Each additional BPM instance that you define is also added to the list of available data collectors. Each BPM
can then be designated as a host for your business process applications and business transaction flows,
which are defined in EUM Administration. For details on creating and managing applications and business
transaction flows, see "Business Process Monitor Administration User Interface" in the APM Application
Administration Guide.

You can install BPM on a Windows or Linux operating system. For system requirements, see "System
Requirements" in the Business Process Monitor Deployment Guide.

Configuration, Administration, and
Troubleshooting

In general, BPMs do not require configuration and administration. Where configuration, administration, or
troubleshooting is required, you generally access the web-based BPM Admin console (for details, see "How
to Access BPM Admin" on page 28). In addition, certain configuration changes can be made directly in the
BPM files, as described in "BPM Configuration Files" on page 153.

BPM Directories

BPM s installed in and uses a number of main directories, which are referred to extensively throughout this
documentation. The following table lists these directories, showing the name used in the documentation, their
default path, and a description of what they include:

Directory Name

(as used in the Operating

documentation) Description System Default Path Configurable
<BPM The directory in which the Windows = C:\HP\BPM\ Yes
installation BPM application is installed.

directory>

<BPM data The directory containing Windows | C:\ProgramData\HP\BPM No
directory> BPM configuration data.

<BPM root Contains both the BPM Linux /opt/HP/BPM No
directory> installation and the BPM

configuration data.

(This is similarto a
combination of the <BPM
installation directory> and
the <BPM data directory> for
Windows.)
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Directory Name

(as used in the Operating
documentation) Description System Default Path Configurable
<BPM BPM working directory Windows @ Windows: Yes
workspace . <BPM application
. Linux .
directory> directory>\workspace
Linux:
<BPM root
directory>/workspace
Note:

« Users require read-write access to these directories.
« Directory names cannot start or end with a space or include multiple spaces.

Users Without Admin Privileges

The following directories contain sensitive information. We recommend that you protect these directories
using NTFS permissions. BPM Administrators who do not have admin privileges on the BPM machine require
read-write access to these directories.

Note: In Windows 8.1, even users with admin privileges must be assigned read-write access to these
directories.

« Configuration Directory (by default <BPM application directory>\config)

« Tomcat Directory (by default <BPM application directory>\Tomcat)

o Workspace Directory (by default <BPM application directory>\workspace)
« BPM Installation directory (by default C:\HP\BPM\ - Windows only)

BPM Administrators who do not have admin privileges on the BPM machine also require read and execute
permissions for the following directories:

« BPM Installation directory (by default C:\HP\BPM\ - Windows only)
« LG Home directory (by default C:\HP\LoadGenerator - Windows only)
You can run an instance of BPM or a BPM application as a specific user.

« Forinformation and limitations running BPM instance as a specific user, see "Run as a Specific User
Area" on page 59.

« Forinformation and limitations running a BPM application as a specific user, see "How to Set Credentials
to Run BPM as a Specific User" on page 39.

Note: You cannot run an instance of BPM and a BPM application as a specific user at the same time.
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Setting Up BPMs

For a description of the process required to set up and use BPM to collect data on the performance of specific
business processes, see "How to Set up Business Process Monitors" in the APM User Guide. BPM saves
detailed log entries for every executed task, and for general BPM operations.

Changing the Time on the BPM Machine

BPM synchronizes time with the APM Gateway Server once an hour (default Time Poll Interval setting). If you
change the time on the BPM machine, the BPM reports may contain incorrect times until APM is next polled
for time synchronization. To avoid this, you should restart BPM/the relevant BPM instance (see "How to
Restart BPM" on page 29), or change the Time Poll Interval setting for an instance to a value smaller than 60
minutes (see "Application Performance Management Registration Properties Area" on page 57).

Note: BPM saves persistency information after registration with APM, and after each job update. This
enables you to continue to work even if the Gateway Server is temporarily unavailable.
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Chapter 2: General and Administration

You use the web based BPM Admin for managing and monitoring all BPM instances on a machine, and for
customizing BPM settings. BPM Admin is installed on the host machine during BPM installation.

You can use BPM Admin to:

« Manage the run of BPM on the host machine
« Configure new instances, and then modify settings and view activity for each BPM instance
« View transaction and page component breakdown for web-based scripts
« View transaction and component breakdown for non-web-based (TCP) scripts
« View reports for WebTrace requests
All BPM Admin events are reported to a log file.

Learn About

« "Supported Recording Tools" on the next page

« " Snapshot on Error Option" on the next page

« "Compatibility Matrixes" on page 15

« "Requirements and Limitations for Running Tasks" on page 20
« "Planning BPM Capacity" on page 25

« "BPM Configuration Tips" on page 27

Tasks

« "How to Run BPM" on page 28

« "How to Access BPM Admin" on page 28

« "How to Restart BPM" on page 29

« "How to Change the Language of the BPM User Interface" on page 29

Troubleshooting and Limitations

Unable to Access BPM Admin Console
If you are unable to access the BPM Admin console via SSL, check the following log files:

« catalina.<current date>.log files located in:

o Windows:
<BPM application directory>\Tomcat\logs
<BPM application directory>\ServletContainer\temp\logs
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o Linux:
<BPM root directory>/ServletContainer/temp/logs

« bpm_nanny.log file located in:
o Windows: <BPM installation directory>\yajsw\log

o Linux: <BPM root directory>/yajsw/log

Webtrace Fails to Run using TCP Protocol but Succeeds using ICMP Protocol

SRPACKET service is a LoadRunner service. It is required to run the Webtrace command line utility and the
Network Delay monitor in Controller.

Generally, the LoadRunner installation sets this service to start manually. In the registry, you can set how and
when the service starts:

Open registry key [HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\SRPACKET]
Set the value of Start to 3.
Open a command line and check if the service can run using the following command:

Net start SRPACKET

You should see the following output:

The requested service has already been started.

Supported Recording Tools

BPM 9.40 supports scripts recorded using the following HPE tools.

« HPE QuickTest Professional / Unified Functional Testing (run on Windows platforms only)
« HPE Virtual User Generator (VuGen)
You must install QTP/UFT on the BPM machine before BPM can run scripts recorded with that tool.

For the supported versions, see "Compatibility Matrixes" on page 15.
BPM supports the same client protocol versions as those supported by its compatible version of VuGen.

Note: You cannot use HPE WinRunner scripts with BPM. All WinRunner scripts should be converted to
QTP/UFT scripts.

Snapshot on Error Option

When recording scripts with TruClient, Virtual User Generator (VuGen), QuickTest Professional (QTP), or
Unified Functional Testing (UFT), you can enable the Snapshot on Error option.

After the Snapshot on Error option is enabled, APM saves a snapshot of a page as it appears when an error
occurs during the script run. The snapshots can be viewed in the EUM Error Log and in the Triage Raw Data
report. For details, see "Snapshot on Error" in the APM User Guide.

Note: In Internet Explorer, the snapshot resolution is based on the screen resolution of the machine
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running TruClient. This means that there will be different results if the script is run with different screen
resolutions.

Learn About

Enabling the Snapshot on Error Option
Snapshot on Error must be enabled for a script for BPM to record the snapshot and send it to APM.

To enable Snapshot on Error in the metadata file for each script, set the EnableSnapshotOnError to 1.

Supported Protocols

The following protocols support Snapshot on Error:
o Citrix

« Flex

« Mobile Application (HTML/HTTP)

o Oracle

« RDP

« SAP GUI

« TruClient - Firefox

« TruClient - Internet Explorer

o TruClient Web (includes Internet Explorer, Firefox, and Chromium)
o Web (HTTP/HTML)

« Selenium JUnit

« TruClient native Mobile (MC)

o UFT

The list of HP Virtual User Generator protocols for which APM supports Snapshot on Error is configured in the
SnapshotSupportedProtocols parameter in the agent1.cfg file. For details, see "Parameters in agent1.cfg"
on page 162.

Note: When APM records a snapshot for scripts recorded using one of the web protocols, it saves only
HTML code; resources such as images and JavaScript are not saved. This means that errors that occur
due to missing resources may be difficult to trace from the snapshot, especially in cases where the
missing resource problem has been fixed. For example, if an image resource is missing during a script
run, causing an error to be recorded, but the missing image problem is later fixed, the image will still be
present when you open the snapshot of the page.

Tasks

How to Enable Snapshots on Error

Note: The active protocol type of the script must belong to a protocol that supports Snapshot on Error.
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You can identify the protocol of the script in the model_persistency.xml file. Make sure that this
protocol is listed in the agent1.cfg file.

1. Inthefile <BPM application directory>\config\agent1.cfg, in the general section, apply one of the
following values to the SendSOEToBAC parameter:

« 1—Never send Snapshot on Error data to APM.
o 2—Send Snapshot on Error data to APM.

« 3—Snapshot on Error is based on script-level configuration as defined in the
SnapshotOnErrorActive or ReplaySnapshotMode, this value can be setin UFT, VuGen, or
TruClient.

2. Fornon-TruClient scripts the SnapshotOnErrorActive parameter should have a value of 1.
The SnapshotOnErrorActive parameter can be set in VuGen as follows:
a. Click Replay > Runtime Settings. The Runtime Settings dialog box opens.
b. Under General, click Miscellaneous.
c. Under Error Handling, select the Generate snapshot on error check box.
The SnapshotOnErrorActive parameter can be set in UFT as follows:
a. Right-click on a script and select Test Settings. The Run dialog box opens.
b. Select Save image of desktop when error occurs.

Note: If required, for individual scripts you can manually modify the SnapshotOnErrorActive value in
the default.cfg file.

3. For TruCilent scripts, the ReplaySnapshotMode parameter can be set in VuGen as follows:
a. Click Replay > Runtime Settings. The Runtime Settings dialog box opens.
b. Under Load, click Other Settings.
c. Under Snapshot generation > Replay snapshot generation, select one of the following:
o Never — Snapshot on Error is disabled (ReplaySnapshotMode = 0)
o On error — Only send a snapshot if there is an error (ReplaySnapshotMode = 1)
o Always — Always send a snapshot (ReplaySnapshotMode = 2)

Note: If required, for individual scripts you can manually modify the ReplaySnapshotMode
value in the default.cfg file.

Troubleshooting and Limitations

The VuGen SOAP (Web Services) Protocol (WS_SOAP) Does Not Support
Snapshot on Error

Workaround: Convert scripts to HTTP/web.

Convert the LoadRunner SOAP script to an HTTP/web script, using web_custom_requests and placing your
XML into the body argument.
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You will see normal snapshots in APM if you insert web_reg_find_statements before your request and
activate Snapshot on Error in VuGen.

Compatibility Matrixes

This section includes the following matrixes for various environments and components supported by BPM
versions:

« "BPM Compatibility Matrix" below

« "Unified Functional Testing (UFT)" below

o "LoadRunner Compatibility Matrix" on the next page

« "BPM Protocol Support Matrix" on page 18

« "BPM Supported Protocols " on the next page

« "Compatibility with VuGen" on page 17

« "Compatibility with Unified Functional Testing (UFT)" on page 17
« "BPM/VuGen - Citrix Compatibility Matrix " on page 17

In the tables below, v = "supported", and X = "not supported".

BPM Compatibility Matrix

All BPM versions since 9.13 are compatible with Business Service Management (BSM) 9.1x and 9.2x, and
Application Performance Management (APM).

Note: BSM 9.01 is not supported.

Unified Functional Testing (UFT)

Version of BPM BPM BPM BPM BPM BPM
UFT BPM 9.40 9.30 9.26 9.25 9.24 9.23 9.22
14.01 v X X X X X X
14 v X X X X X X
(recommended)

12.54 v v X X X X X
12.53 v v/ X X X X X
12.51 v v v X X X X
12.50 v v v X X X X
12.02 v v v v X X X
12.01 v v v v v X X
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LoadRunner Compatibility Matrix

Version of LoadRunner

12.55

12.53
(including 12.53 patch 3 and
patch 4)

12.51
12.50
12.02

12.01

BPM 9.40

v
(recommended)

v

v
v
v

v

BPM
9.30

X

AU NI NEIEN

For Mobile Center - Load Runner compatibility, see
https://admhelp.microfocus.com/mobilecenter/en/latest/Content/Resources/ TopNav/_TopNav_

Home.htm/Content/My_Product

_Matrix.htm.

BPM Supported Protocols
BPM for AppPulse Active supports the following private POP protocols:

o .NET

« CVUser

o Citrix

. COM/DCOM
« FTP

« IMAP

« JavaVuser

« LDAP (Listing Directory Service)

« MAPI (Microsoft Exchange)
« MMS (Media Player)

« MMS (Multimedia messaging Service)

. ODBC

« Oracle (2-tier)

« Oracle NCA

« POP 3 (Post Office Protocol)
« RDP

« SMTP

« TruClient - Firefox, Internet Explorer, Mobile Web

HPE Business Process Monitor (9.40)
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9.26

X

NN NS

BPM
9.25

X

< N X X

BPM
9.24

< X X X

BPM BPM
9.23 9.22
X X
X X
X X
X X
X X
X X
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e Web[HTTP/HTML]
« Windows sockets

Note:

« Forthe list of supported public POP protocols, see the Create Script Transactions section in the APM
help.

« Some of the protocols require the installation of additional software components and therefore are
platform dependent.

« BPM also supports all the protocols available through add-ins for the supported versions of QTP and
UFT.

Compatibility with VuGen

The recommended version of VuGen for BPM 9.40 is VuGen 12.55 (including any relevant patches and
hotfixes).

If you have an earlier version of VuGen installed, you need to uninstall it before installing the current version.
VuGen can be installed on the same machine as BPM, provided that it is installed after BPM has been
installed.

If you need to uninstall BPM, run VuGen Repair the Installation before reinstalling BPM.

If you need to repair or reinstall VuGen, you will also need to uninstall BPM and install it again before VuGen
has been repaired or reinstalled.

If you are using TruClient global function library, the library must be located on a shared location accessible by
all machines on which the script is going to run (VuGen or BPM).

Note: LoadRunner Java protocols require JDK 8 installed on the BPM server.

Set the JAVA_HOME system parameter to the JDK 8 path, or for each individual script set the replay
setting parameter to the JDK 8 path.

Java protocols include Java Record\Replay, Java Over HTTP, Java Vuser, Oracle — Web, and Oracle
NCA.

Compatibility with Unified Functional Testing (UFT)

The recommended version of Unified Functional Testing (UFT) for BPM 9.30 is UFT 12.53 (including any
relevant patches and hotfixes).

Note: We do not recommend using UFT 12.50 on Windows 7 32 bit due to possible performance issues.
We recommend using a different version of Windows such as Windows 7 64 bit.

BPM/VuGen - Citrix Compatibility Matrix
LoadRunner 12.55 / BPM 9.40 (Citrix ICA with Receiver for Windows)

Supported Client Version Supported Server
12.x Citrix XenApp 5.5, 5.6, 6.0, 6.5, 7.0, 7.5
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Supported Client Version Supported Server

13.x Citrix XenDesktop 7.0
14.x Citrix XenDesktop 7.5
14.1.200 Citrix XenDesktop 7.6

Citrix Access Gateway (with Receiver 14.7)

BPM Protocol Support Matrix
Protocol
Ajax - Click and Script
C VUser
Citrix
COM/DCOM
DNS (Domain Name Resolution)
Flex
FTP (File Transfer Protocol)
IMAP
JAVA over HTTP
JAVA Record\Replay
Java Vuser
LDAP (Listing Directory Service)
MAPI (Microsoft Exchange)
Mobile Application (HTML/HTTP)
MMS (Media Player)
MMS (Multimedia messaging Service)
ODBC
Oracle (2-tier)
Oracle NCA
Oracle - Web

POP 3 (Post Office Protocol)

HPE Business Process Monitor (9.40)
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Protocol

RDP

RTE (Remote Terminal Emulator)
SAP Click and Script

SAP GUI

SAP Web

Selenium (as a Junit test)
Siebel - Web

SMTP (Simple Mail Protocol)
SOAP (Web Services)
TruClient - Mobile Web

TruClient - Native Mobile

TruClient Web (includes Internet Explorer, Firefox, and Chromium)

Web (HTTP/HTML)

Windows Sockets

Note:

Windows

A N N N N N N N N N N N NN

Linux

N SN X X X X NN N N X X X X%

o TruClient Internet Explorer and TruClient Firefox have been replaced with TruClient Web, which also
supports Chromium. If you have Internet Explorer or Firefox scripts created with earlier versions of
TruClient, we recommend that you convert them to TruClient Web scripts to be able to use the latest
technology. In TruClient Web you can choose which browser to use for each script. LoadRunner has
a “TC Batch Conversion” tool (integrated in VuGen) which can convert old scripts to TruClient Web.

For details, see the LoadRunner documentation.

« Some of the protocols require the installation of additional software components and therefore are

platform dependent.

« BPM also supports all the protocols available through add-ins for the supported versions of QTP and

UFT.

« BPM does not support multiple iterations for a single transaction run, whether set via internal scripting

logic using loops, orin script Run Time Settings > Run Logic > Number of Iterations.
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Requirements and Limitations for Running
Tasks

BPM has the following requirements and limitations when running scripts and WebTrace:

"General" below

"Virtual User Generator Scripts" on the next page

"QuickTest Professional (QTP) and Unified Functional Testing (UFT) Scripts" on page 23
"Citrix Script Failing" on page 22

"WinRunner Scripts" on page 24

General

Note: Refer to the LoadRunner/VuGen documentation to determine the proper configuration for running a
specific script.

We recommend that you run scripts for all protocols (with the exception of web protocols) with the BPM
instance/whole BPM set to run as a specific user.

If there is a problem with a script (for example, due to a missing client installation, a download failure,
corruption in the script, and so forth), the script may fail to initialize. In this case, the application or
business transaction flow containing the script also fails to initialize, with the result that none of the
application or business transaction flow scripts, or WebTraces, is run on BPM.

When a script in an application or business transaction flow is run, but for some reason does not finish
successfully (that is, it does not end with a status of Finished properly or Finished (errors occurred)),
samples for transactions that were part of the script, but were not run, are sent to APM for inclusion in the
Triage report. For details on the Triage report, see "Triage Report" in the APM User Guide.

If the BPM server minimum disk space threshold is breached, BPM stops running scripts and WebTraces
until the minimum buffer above the BPM server minimum disk space threshold is reached. For details
about these thresholds, see "Parameters in topaz_agent_ctrl.cfg" on page 155. To change parameter
values within configuration files, see "How to Change Parameter Values Within a Configuration File" on
page 153.

Scripts that include an HTML replay mode cannot download Active-X components.

BPM is not case sensitive to transaction names, so you should ensure that each transaction within the
same business transaction flow has a unique name. Two transactions that have the same name, but with
case-sensitive differences, are handled as a single transaction by BPM. BPM reports both transactions to
APM using a single transaction ID, and the reports show results for only one transaction.

In Linux, if a script or application name contains a space, dollar sign ($), or grave accent (°), the script or
application does not run correctly. You should not use these symbols in the names of scripts or
applications intended to be run on a Linux platform.

Page component breakdown is supported only for certain VuGen protocols.

WebTrace does not support the use of domain names that begin with a digit, for example,
www . 1800hp . com. An error message is displayed. Instead, use the IP address for the destination.

Scripts of inactive applications or business transaction flows are still downloaded to BPM, so that if the
application or business transaction flow is made active, the BPM does not need to download the scripts.
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To avoid overload problem, you should remove BPM from the relevant application or business transaction
flow configurations.

TruClient scripts that monitor applications which are sensitive to screen resolution may fail due to Object
Not Found errors. To resolve this issue, use TruClient Web.

If you encounter a problem replaying a TruClient - Internet Explorer or Chromium script in BPM, but the
script replays successfully in VuGen, replay the script while running BPM as a process.

Torun BPM as a process, open a command prompt and run the following commands:
> CD <BPM installation directory>/BPM/ServletContainer/bin

> catalina.bat run

Virtual User Generator Scripts

If you are running scripts recorded with VuGen that include protocols which require a client to run (for
example, Oracle Client or RealPlayer), you must have the protocol’s client installed on the BPM machine.

Citrix recording and playback is supported only on Windows platforms.

LoadRunner requires the installation of a Citrix registry patch to record and replay scripts on Citrix client
version 10.0 and later. The first time a Citrix script runs on a BPM machine, LoadRunner prompts you to
install the Citrix registry patch on that machine. When prompted, click OK to accept the installation.

BPM supports VuGen scripts for all Oracle NCA protocols. If you run an Oracle NCA protocol task, you
can view transaction breakdown data for tasks that use http or Servlet connection methods (breakdown
data for Socket communication is not supported).

For successful Java Over HTTP script runs, install one of the following versions of Java (Oracle JDK, 32
Bit):
o 1.5

e 1.6.x
o 1.7.x (recommended)

Before running a TruClient script recorded in VuGen versions earlier than VuGen LR11.50 SP1, open the
script in VuGen LR11.50 SP2 and save it.

If you have added jars or classes to the classpath in VuGen and are running a java based protocol in BPM,
you must perform one of the following actions to ensure that the script can locate the jars:

« Remove the jar names from the run-time-settings > classpath list and place the jar files in the script
folder (where the .usr file is). The script searches for all jars in the script folder and automatically adds
them to the classpath.

« Specify afull path to the jar in the run-time-settings > classpath list. For example:

<BPM workspace directory>\agentl\Sitel\BPM_SANITY_
1bdf936f0f747829f519f144808577b4\13\IPetStore_TABLE_Param\wlclient.jar

« Ifascriptis anasynchronous protocol type (WebAjax, Web2UI, Web2UIMob, WebIE, or TC4Mobile),
and the script is aborted by BPM timeout, BPM will report to APM all transactions with status 1 (the
transaction finished to run with errors) and error message "Transaction is not finished to run. Task
stopped running because it timed-out".
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Citrix Script Failing

If Citrix scripts consistently fail, the version of Citrix on the client may not be compatible with the version of
Citrix on the server (including required patches).

To test if this is the problem, manually run the script using the Command Prompt. If you have incompatible
versions of Citrix, you will receive an error message similar to the following:

Citrix Registry Patch Installation E

@ LoadRunner needs to install a Citrix registry patch to replay on
| I this version of the Citrix clisnt,

TR Click OK to install the patch and continue replaving or Cancel to
stop replaving.

Cancel |

You should also confirm that a separate user session is not running the Citrix Connection Center, outside of
BPM. To resolve this issue, close all instances of concenter.exe and other citrix processes for all users.

To prevent the Citrix Connection Center from starting automatically:

In the Windows Registry, set the ConnectionCenter registry key to an empty value (""). This key can be found
at:

o 32-bit systems: HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Run

« 64-bit systems: HKEY _LOCAL _
MACHINE\SOFTWARE\Wow6432Node\Microsoft\Windows\CurrentVersion\Run

Citrix Scripts Fail to Start

When attempting to run Citrix scripts, the following error may appear:

Receiver.exe - Application Error x

f 7 1 The application was unable to start correctly (Oxc0000142). Click OK to
‘\d¥ close the application.

oK

To resolve this issue:

1. In APM, stop any other Citrix scripts that are already running. Right-click on the required applications and
select Management Operations > Deactivate BPM.

2. Inthe Windows Task Manager, manually stop all Citrix processes (processes with a name that starts
with Citrix) that are running under interactive sessions.

3. Log-off all existing sessions. This prevents Citrix processes from automatically restarting.

In APM, manually start the required scripts. Right-click on the required applications and select
Management Operations > Activate BPM.

HPE Business Process Monitor (9.40) Page 22 of 196



Business Process Monitor Administration Guide
Chapter 2: General and Administration

QuickTest Professional (QTP) and Unified Functional Testing (UFT) Scripts

For tips and recommendations on recording scripts in QTP or UFT to run on BPM, see "Guidelines for
Working with QuickTest Professional (QTP) and Unified Functional Testing (UFT)" in the APM
Application Administration Guide.

« UFT scripts refer to the scripts for UFT GUI tests.

« As of BPM 9.23, BPM must run as a service for executing QTP/UFT scripts. Therefore, no special BPM
startup is needed.

« If BPMis installed on Windows Server 2008 R2 or Windows 7 64 bit, do the following configuration steps
before running QTP/UFT scripts:

a. Stop BPM from the Start menu.
b. Disable Data Execution Prevention (DEP).
c. Disable Interactive Services Detection.

Note: For details on the above steps, refer to the Microsoft website, or other reference sources.

d. Start BPM.
« Ensure that QTP/UFT is closed on the computer before running a QTP/UFT in BPM.

o QTP/UFT cannot run tests on a computer that is logged off, locked, or running QTP/UFT as a non-
interactive service.

» The last step (may also be multiple last steps) in a QTP/UFT script should close the application being
tested, as well as any child processes that are running. This cleanup step enables the next run of the
script to open the application again.

However, if a script fails before it finishes running, it does not run the last step. From version 6.1, BPM
supports a special close application mechanism that automatically closes the application being tested,
when a QTP/UFT script fails. This mechanism is intended for fallback purposes only. Although the
mechanism closes the application being tested, it does not necessarily release all of the tested
application’s resources. Also, any unsaved data is lost.

This mechanism is enabled by default. If required, you can disable it for a specific test, as described in
"How to Disable the Close Application Mechanism" on page 186.

« BPM does not support QTP/UFT scripts that require access to external resources (such as shared object
repository, function library, external Data Table, external actions, and so forth). Scripts that require
external resources may fail to run on BPM. (However, if the resource can be found on the network,
QTP/UFT usesiit.)

« BPM can run only one QTP/UFT script at a time. Make sure there are not multiple applications or business
transaction flows with QTP/UFT scripts set to run concurrently, or an application or business transaction
flow with more than one QTP/UFT script set to run in Concurrent run mode. (For information on run modes,
see "Run Modes" on page 119.)

« Transaction breakdown is not supported for transaction files recorded with QTP/UFT.
« You cannot use the ResultDir QTP/UFT environment variable when running a script in BPM.

« If BPMis installed on Windows Server 2008 or Windows 7, ensure the following when you record the
script:

« Inthe Record And Run Setting (in the Automation/Record section), select the Record and run on
any open browser option.
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« Thefirst line of the script opens a browser and the last line of the script closes the browser. For
example:

SystemUtil.Run "URL to open"
Script content
Browser("script browser name").Close

WinRunner Scripts

You cannot use WinRunner scripts with BPM. You should convert all WinRunner scripts to QuickTest
Professional scripts.

Non-English Language Limitations

Virtual User Generator (VuGen) 12.0 has the following known limitations when working with non-English
character sets such as Cyrillic or Japanese:

« Script Names with Non-English Characters - In VuGen 12.02 you cannot include non-English
characters in script names or re-save scripts that were created with earlier versions of VuGen that include
non-English characters in the name. BPM can still run scripts with non-English characters in the script
name that were created with VuGen 11.51.

For a solution to this problem, see "\Workarounds" below.
« Script Parameters - BPM cannot run scripts that have non-English parameters.
For a solution to this problem, see "Script Parameters" below.

« Transaction Name - BPM cannot run scripts that have a transaction name that includes Japanese
characters. BPM can run scripts with Russian or German characters in the transaction name.

« Files - Scripts cannot contain files with non-English characters.

For a complete list of limitations, see the VuGen Help file in the section VuGen Help > Advanced Topics >
Non-English Language Support > Foreign Languages - Troubleshooting and Limitations.

Workarounds

Script Names with Non-English Characters

If there are script names with non-English characters, if you have VuGen 11.51 or earlier installed, open the
script in VuGen and save the script with a new name using only English Characters.

If you do not have an earlier version of VuGen, you can create a new script name with English characters and
transfer the old transactions to the new script.

1. InBSM, select Admin > End User Management > Monitoring and select a business transaction flow
in the Tree that appears in the left pane.

In the Scripts area, add a new script that contains the same transaction names as the old script.

Delete the old script that had non-English characters in the name.

Script Parameters

If you have script parameters that include non-English names, use the following procedures to create new
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parameters:

1. In APM, create a backup file of relevant parameters (if required):
a. Select Admin > End User Management > Monitoring > Search and Replace.
b. Select Entity type - Script Monitor Parameter.

Click Search.

Select the relevant parameters.

Click Export to Excel to create a backup file in Excel format.

2. InVuGen 12.02, rename the script parameters using English characters.

Open the script in Vugen 12.02

Open the Parameter List wizard.

© o ® 3 0 a0

Delete the old parameters, and create new parameters with English names.
d. Replace the parameters in the script with the new parameters.
3. If there are script names with non-English characters, update the script names:

a. Update the script names. For details, see "Script Names with Non-English Characters" on the
previous page.

b. Continue with step 5 below.
4. |If script names have English characters, upload the revised script:
a. Select Admin > End User Management > Script Repository.
b. Select the old script and check it out.
c. Upload the new script that you created in step 2 above.
5. Update parameters (if required):
a. Select Admin > End User Management > Monitoring > Search and Replace.

b. And update the new parameters values.

Planning BPM Capacity

The main factors that influence the load you can assign a BPM are:

« The hardware of the BPM machine (in terms of the processor, memory speed, processor L2 cache
memory, and so forth).

« The operating system. Since BPM uses services provided by the operating system, differences between
operating systems may impact BPM performance.

« The total number of concurrently running scripts on the BPM machine.

For details on hardware and operating system requirements, see "BPM System Requirements" in the
Business Process Monitor Deployment Guide.

Example of a Simple Configuration With No Concurrent Script Runs

An example of a simple configuration where all the scripts included in the configuration run sequentially is a
BPM running a single application that uses the default application schedule of 15 minutes and that includes 15
scripts that each take one minute to complete. In this configuration there will always be a single script
running, but no script will run concurrently with another.
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Changes to the configuration or its environment may cause scripts to run concurrently. For example, if a script
run time lasts longer than one minute due to slow performance.

Automatic Distribution of Concurrent Script Runs

When a BPM has more than one application or business transaction flow configured on it, a special
mechanism ensures that the distribution of concurrent running scripts is kept as low as possible.

To allow an even distribution of the BPM'’s use of resources (such as CPU, memory, and network), the BPM
assigns each application or business transaction flow (that has its own schedule) an offset. By using this
offset, BPM tries to reduce the number of concurrent script runs by staggering their start time. The offset
mechanism is applied whenever a new configuration is assigned to the BPM.

Factors Causing Concurrent Script Runs
Some of the main factors that may cause scripts to run concurrently are:

« Thework load assigned to the BPM. This includes:

o The number of instances configured for the BPM.

« The number of applications and business transaction flows (run units) per instance.
« The number of scripts per run unit.

« The number of transactions per script.

« The scheduled interval configured for run units.
« The average time it takes for a script or run unit to finish a single run.

« The availability and performance of monitored applications. Unavailable or slow applications result in
slower script runs.

« The type of the scripts. Some protocols may take a longer time to finish than others (for example, if there
is a need to work with FAT client that needs to be initialized).

« The unit run modes (classic, sequential, and so forth). Some modes (such as the stepped mode with a
step value of zero) enable you to run scripts concurrently. For details on run modes, see "Run Modes" on
page 119.

Note: Changing the default unit run mode overrides the automatic mechanism that distributes script
runs. This reduces the load that can be assigned to a BPM. We strongly recommend that you do not
change the default offset in high volume environments.

Sizing
Note: Changing any one of the parameters may impact the load you can run on a BPM.

Since there are a number of factors that affect the load on a BPM, and therefore the required configuration,
there are a large number of different possible configuration combinations. The following tables list some of the
load and system configurations that have been used.

Load Configuration: Simple TruClient / Firefox Transaction

Operating System: Windows 2012 R2
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Instances  Apps /Instance Scripts/ App Trx/ App ;c:sls Total Scripts Total Trx

1 250 2 5 250 500 1250
Load Configuration: Simple HTTP / Web Transaction
Operating System: Windows 2012 R2

Total

Instances Apps/Instance Scripts/ App Trx/ Script Apps Total Scripts Total Trx

1 250 2 3 250 500 1500

2 250 2 3 500 1000 3000

16 15 2 3 240 480 1440
System Configuration for Testing
The tests above were performed with the following Configuration:

System VM with Intel Xenon E5-2670 @2.60GHz (4 processors)

Memory 16 GB

Hard Drive HDD 120GB

Operating System Windows 2012 R2

BPM Configuration Tips

This section describes tips and recommendations for configuring BPM:
o BPM must run on a dedicated machine.
o Use the default run unit mode

« If you do not use one of the tried configuration sizes, use the following method to check your BPM
capacity.

To check Business Process Monitor capacity for a new configuration:

1. Load the BPM with the new configuration using a rump up method (cycles). In each cycle, assign only a
part of the configuration and check that the BPM’s capacity is not breached (that is, a very high usage of
system resources).

AfteraBPM is assigned a new configuration, it needs to readjust its scheduling mechanism to the new
work load. This readjustment phase (during which the BPM still runs the existing configuration) may take
afew minutes, depending on the work load of the existing configuration and the amount of new work
required by the new configuration. During the readjustment phase, the BPM’s CPU consumption may
increase, but should return to normal once the readjustment is complete.

Note: When changing a configuration, there may be a delay in transaction reports and in some
cases, transaction runs may be skipped. This applies to currently running scripts.

2. Wait until the readjustment phase stabilizes before applying additional parts of the new configuration.
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How to Run BPM

Once BPM is active on a host machine, it can continue running indefinitely. When BPM starts, it
automatically starts each BPM instance.

When you install BPM on a host machine, Business Process Monitor Service is added as a service on the
host. Business Process Monitor Service automatically starts BPM whenever the host machine is started.

To Start BPM

Windows 7, 2008: Select Start > Programs > Business Process Monitor > Start Business Process
Monitor Service.

Windows 8.1, 10, 2012: Select Windows > Run > Services.msc > Start BPM.
Linux: Run /opt/HP/BPM/bin/startBpmDaemon.sh.

To Stop BPM

Windows 7, 2008: Select Start > Programs > Business Process Monitor > Stop Business Process
Monitor Service.

Windows 8.1, 10, 2012: Select Windows > Run > Services.msc > Stop BPM.
Linux: Run /opt/HP/BPM/bin/stopBpmDaemon.sh.

How to Access BPM Admin

You access BPM Admin via a web browser on any computer connected to your intranet or to the Internet. The
BPM Admin console uses Java applet technology for which you must install JRE on each client machine.

To access BPM Admin, use one of the following options:

« Windows: On the BPM host machine, you can select Start > Programs > Business Process Monitor
> Business Process Monitor Admin. BPM Admin opens in a browser window.

o Linux: Inabrowser window, enter the URL http://<host machine>:2696, for example,
http://cats:2696.

o INAPM:
a. Access the Admin > End User Management > Settings > BPM Agents page.
b. Click the Open a Business Process Monitor Agent’s Console = putton. A BPM host opens the
BPM Admin for that host in a new browser window. (You must have the necessary permissions to

view and manage BPM agents in APM. For details on permissions, see "Permissions" in the APM
Platform Administration Guide.)

Note: The default port for BPM Admin is 2696. You can configure a new port if required. For details, see
"How to Change the Default Port" on page 184.
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How to Restart BPM

The Restart option enables you to restart BPM. When you select this option, BPM Admin restarts all BPM
instances on the host machine. Note that it may take a minute or longer for BPM Admin to reconnect to BPM.

Note: When multiple run units (applications and business transaction flows) are running on a host, BPM
generates start offset values to distribute script runs optimally over time. Restarting BPM prompts the
recalculation of the start offset values.

If you create or delete applications and business transaction flows in End User Management
Administration, you can restart BPM to reset the automatic distribution of script runs. For more
information on the automatic distribution feature, see "Start Offset" on page 118.

How to Change the Language of the BPM
User Interface

You can view the BPM user interface in the following languages in your web browser:

Language Language Preference in Web Browser
Chinese Chinese (China) [zh-cn]

English English (United States) [en-us]

French French (France) [fr]

Japanese @ Japanese [ja]

Korean Korean [ko]

Use the language preference option in your browser to select how to view BPM Admin. The language
preference chosen affects only the user’s local machine and not the BPM machine or any other user
accessing the same BPM. The language is determined when you first open BPM Admin. Changing the
language preference in your browser when you are working in BPM Admin has no affect until you close and
reopen BPM Admin.

To view BPM Admin in a specific language using Internet Explorer
Select Tools > Internet Options and click Languages. The Language Preference dialog box opens.
2. Select the language in which you want to view BPM Admin.

If the language you want is not listed in the dialog box, click Add to display the list of languages. Select
the language you want to add and click OK.

3. Click Move Up to move the selected language to the first row.
Click OK to save the settings.
5. Refresh the page. The BPM Admin user interface is displayed in the selected language.
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Notes and Limitations

« Thereis no language pack installation. All translated languages are integrated into BPM Multi-lingual User
interface (MLU).

« Data stays in the language it was entered in, even if the language of the web browser changes. Changing
the language of the web browser on your local machine does not change the language of BPM definitions
and configurations.

« If auserselects alanguage which is not supported by the BPM Multi-lingual User interface, the BPM
Admin user interface appears in English.

« Virtual User Generator (VuGen) has limitations when working with non-English character sets. For further
information see "Non-English Language Limitations" on page 24.

Notes and Limitations for BPM on Windows

This section includes notes and limitations for BPM when it is installed on Windows Server 2008 or Windows
7.

User Type

BPM on Windows Server 2008 R2, Windows Server 2012 R2, or Windows 7 must run under a user that has
Administrator privileges.

Disabling User Account Control

To run BPM on Windows Server 2008 R2, Windows Server 2012 R2, or Windows 7, User Account Control
(UAC) must be disabled for users with Administrator privileges.

Manual Procedure Before Installing BPM on Windows Server 2008 R2 64 Bit
Platforms

You must carry out the following procedure before installing BPM on a Windows Server 2008 R2 64-bit
platform:

Open Server Manager (Start > Administrative Tools > Server Manager).

Click Features in the left tree and then click Add Features in the right panel.

Select the .NET Framework 3.5.1 Features check box and follow the online instructions.
After NET Framework 3.5.1 is installed, restart the computer and start the BPM installation.

Ao Db =
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BPM agents are the BPM data collectors registered in APM.

To access
To open the Agent Manager dialog box, in the BPM Admin console, go to Tools > Agent Manager.

Learn About

Agent Manager Option

The Tools menu contains the Agent Manager option, which you use to add additional BPM agents to the
BPM Tree. Adding additional agents to the tree enables you to view and administer multiple BPM agents from
the same BPM Admin console. When you add a BPM host in the Agent Manager, the host is displayed in the
BPM Tree and the configuration is persistent (that is, if you close the browser and then reopen BPM Admin,
the BPM hosts that were added in the Agent Manager still appear).

Task

How to Add and Configure an Agent

In the Agent Manager dialog box, click the Add Agent =" button. The Add Agent dialog box opens. For
details, see "Add Agent Dialog Box" on the next page below.

How to Delete an Agent
In the Agent Manager dialog box, select the agent and click the Delete Agent X button.
How to Refresh the List of Agents

=
In the Agent Manager dialog box, click the Refresh B/ button.
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Ul Description

Agent Manager Dialog Box

User interface elements are described below:

Ul Element

Content Pane

=

b4

&

<Agents>

Description

Add Agent. Opens the Add Agent dialog box, where you configure an agent to add to the
BPM Tree.

Note: You should configure hosts using their fully qualified domain name (FQDN) or their
IP address. If you add the same host twice, once with the FQDN and once without, these
are considered as separate hosts and multiple entries are created in the hierarchical BPM
Tree. The same behavior occurs if you configure the same host twice, once with an IP
address and once with FQDN.

Edit Agent. Opens the Edit Agent dialog box, where you modify the settings of the
selected agent.

Delete Agent. Removes a selected agent from the BPM Tree.
Refresh. Refreshes the list of agents that have been added to the BPM Tree.

A list of the BPM agents that have been added to the BPM Tree.

Agent Details Pane

Protocol

Host
Port

Basic
authentication
user name

Server status

The communications protocol used to communicate with the selected BPM agent—http
or https.

The host name of the selected BPM agent.
The port number used to communicate with the selected BPM agent.

The user name for the agent machine’s Tomcat basic authentication, if used.

The current connection status of the selected BPM agent’s host machine.

Add Agent Dialog Box
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User interface elements are described below:

Ul Element Description

Protocol The communications protocol used to communicate with the BPM agent you
are adding—http or https.

Default value: http

Host name The host name of the selected BPM agent you are adding.

Note: Use a fully qualified domain name (FQDN).

Port The port number used to communicate with the BPM agent you are adding.

Default value: 2696

Basic authentication The user name for the agent machine’s Tomcat basic authentication, if used.
user name

Basic authentication The password for the agent machine’s Tomcat basic authentication, if used.
password
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The following BPM entities can be assigned to BPM instances on the host machine:
« Applications
« Business transaction flows
« Business transactions
« Profiles (only forinstances that connect to BSM systems earlier than version 9.00)

BPM instances and entities are represented by entity icons in a hierarchical tree called the BPM Tree, which
appears in the Browse tab. For information about the BPM Tree, see "Browse Tab" on the next page below.
For information about entity icons, see "Entity Icons" on page 36 below.

To access

To access the BPM Tree pane, open the BPM Admin console. For details, see "How to Access BPM Admin"
on page 28.

Learn About

« "BPM Instances" on page 44
« "BPM Applications" on page 64
« "Business Transaction Flows" on page 72

« "Business Transactions" on page 82

Tasks

How to View Information About an Entity

Inthe BPM Tree, hold the cursor over an entity to display its type and full name. Click an entity to display and
configure its settings in the right-hand pane of the BPM Admin console.

How to Search for an Entity

To search for an entity, enter a string in the Entity name field in Search tab. For details, see "Search Tab" on
the next page below.

How to Refresh the BPM Tree

=
To refresh the BPM Tree, click the Refresh Tree |E| button in the Browse tab toolbar.
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Ul Description

Browse Tab

The Browse tab appears in the left pane of the BPM Admin console. The BPM Tree appears in the Browse
tab.

The following is an example of the BPM Tree:

E-ES
[i]—fE, BPM_Instance2
[13—@ test_app
5 tu_fail
— 0 tx_1_failed
02 tx_2_failed
% param
o % jeptstore
— 2 welcome
—[0# =earch fish
— 2 login
— (02 update cart
— 2 add to cart
—[ 4 submit
— 2 logout
2 checkout
-8 Doc_BPM_spp2
EI—I:E BPM_Instance_1
58] Doc_BPM_App1

Clicking an entity in the BPM Tree displays the entity's details in the right pane of the BPM Admin console.
You can configure relevant settings for the selected entity.

Search Tab

In the Search tab, you can search for entities whose name contains a specified string. The search tab
includes the following areas:

. Search Definition Area

This area enables you to specify the string to search for in the entity names.
User interface elements are described below:

Ul Element Description
Entity name | Enter the string for which to search.
Search Click Search to run the search.

Clear Click Clear to clear the string in the Entity name element.
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. Search Results Area

This

area appears after running a search. It enables you to view the search results (that is, the entities

whose name include the specified string).

User interface elements are described below:

Ul Element Description

| o | Display in Business Process Monitor Tree. Displays the selected entity in the

o hierarchical tree in the Browse tab. For details, see "Browse Tab" on the previous page
above.

Entity The entity name.

hame Note: You can filter the list of search results by entering a string in the filter at the top of
this column.

Entity type The type of entity.

Entity

Anicon
used:

Icon
E&
(%33

ol

Wi

Note: You can filter the list of search results by selecting a specific entity type to display
from the drop-down list in the filter at the top of this column.

Icons

is displayed for each entity in the tree, enabling you to identify the entity type. The following icons are

Represents

BPM Host

Instance — registration data received (from APM or from persistence files), and no fatal errors
occurred for this instance.

Note: The displayed instance status is the status received in the last communication from APM.

Instance — problem occurred (for example, connectivity to APM failed, or failed to create a specific
user for that instance).

Note: The displayed instance status is the status received in the last communication from APM.

Application
Business Transaction Flow
Business Transaction

Profile

Note: Profiles are shown only for instances that connect to BSM systems earlier than version 9.00.

Action Buttons

The tool

bar of action buttons for BPM hosts and instances is located at the top of the Browse tab. Only the

actions that are applicable to the entity selected in the tree are enabled.
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For details on host actions, see "Host Action Buttons" on page 40.

For details on instance actions, see "Instance Action Buttons" on page 48.
= . . . y
The Refresh =] button, which you click to refresh the BPM Tree, is enabled for all entities.

Note: You can also access actions for a selected entity in the BPM Tree by right-clicking the entity to
display a Shortcut menu of applicable actions.
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The BPM Host page displays basic information about the BPM installation and the host machine on which it
is installed.
To access

To access the Host page, select the host entity in the BPM Tree displayed in the left pane of the BPM Admin
console. The host entity is the entity at the top of the tree. For details about the BPM Tree, see "Browse Tab"
on page 35.

Learn About

Setting User Credentials

By default, BPM is set to run as a system user. You can set BPM to run as a specific user (recommended) so
that all BPM-related processes, as well as all tasks defined for all BPM instances, run as that user. Running it
as a specific user limits access to resources, settings, and applications located on the local machine. (This
may not be true for resources located on remote machines, where a specific user may have different
privileges than the local system user.)

For details on setting user credentials, see "How to Set Credentials to Run BPM as a Specific User" on the
next page below.

You can set BPM to run as a specific user during BPM installation, or set an individual BPM instance to run as
a specific user (as described in "Run as a Specific User Area" on page 59).

Caution: If you want to run QuickTest Professional (QTP) or Unified Functional Testing (UFT) tests, do
not set BPM (or a relevant BPM instance) to run as a specific user.

Tip: We recommend that you run tests or scripts for all protocols (with the exception of QTP/UFT
protocols and web protocols) with the BPM instance/whole BPM set to run as a specific user.

Tasks

How to View Information About the BPM Host Machine

See "How to View Information About an Entity" on page 34.

How to Run a Page Component Breakdown Report

See "How to Run a Page Component Breakdown Report" on page 85.

How to Run WebTrace Reports
See "How to Run WebTrace Reports" on page 102.
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How to Set Credentials to Run BPM as a Specific User

Note:

« If you have enabled BPM integration with QTP/UFT, do not set specific user credentials for either an
individual instance of BPM or the whole BPM.

« Torun BPM as a specific user in Windows, the user must be part of the Windows Administrator
group.
« BPM WebTrace requires additional permissions on Linux.

« Forinformation and limitations running a BPM instance as a specific user, see "Run as a Specific
User Area" on page 59.

Stop BPM.

2. If you are setting the whole BPM to run as a specific user, ensure that no individual BPM instances are
set to run as a specific user.

3. Set full control permissions for the user as follows:
o Windows: User must be part of the Windows Administrator group.

e Linux: Inthe /opt/HP directory.

4. Inthe Actions menu, select the Set User Credentials option. The Set User Credentials on Agent dialog
box opens.

5. Inthe Set User Credentials on Agent dialog box, select Other user. For details, see "Set User
Credentials on Agent Dialog Box" on page 42 below.

How to set full user permissions on a Windows platform

1. Browse to the user Temp folder of the default user or the user that runs the BPM. The usual path of the
Temp folder is C:\Users\<User name>\AppData\Local\Temp

2. Inthe Temp directory, perform the following actions:
a. Right-click and select Properties. The Temp Properties dialog box opens.
b. Inthe Temp Properties dialog box, select the Security tab.
c. Select the userinthe Name area.
d. Inthe Permissions area select the Allow check box for Full Control.
e. Click OK to save your changes and close the dialog box.

3. Browse to the Temp directory in the Windows installation folder (usual path C:\<Windows installation
folder>\Temp) and repeat the actions described in step 2 of this procedure.

4. Browse to the default workspace directory for BPM and repeat the actions described in step 2 of this
procedure.

5. Browse to the default application directory for BPM and repeat the actions described in step 2 of this
procedure.

Note: For details on the default application directory, see "How a Silent Installation Assigns Values"
in the Business Process Monitor Deployment Guide.

6. Browse to the default configuration directory (usual path <BPM application directory>\config) and
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repeat the actions described in step 2 of this procedure.

7. If you have enabled BPM integration with QTP/UFT, browse to the <BPM application
directory>\config\agent1.cfg file and repeat the actions starting from step 2 of this procedure for the
user specified in the QtpUserName parameter.

8. (Windows Server 2008 R2 and 2012 R2 platforms) Assign the user the logon right Allow log on
locally. (For details, see http://technet.microsoft.com/en-us/library/cc756809(WS.10).aspx.)

How to Create Troubleshooting Files

The Create Troubleshooting File option enables you to create a zip file of various BPM directories and files
for analysis or support purposes. When you select this option, the Create Troubleshooting File dialog box
opens in a new window where you can select the following options:

« Zip BPM Config and Workspace directories. Select this to zip the entire contents of the Workspace
and Config directories.

« Include script directories. The zip file is created by default without the script directories, minimizing the
file size and enabling you to keep the script contents confidential. If the script directories are required,
select this option to include them in the file, but note that this may considerably increase the size of the zip
file.

Note: This option is enabled only when you select the Zip BPM Config and Workspace directories
option.

« Zip BPM client log files. These are files generated by the BPM Admin GUI on the client machine and
give information to assist in troubleshooting the application GUI.

By default, afile called BPM-<host name>-<date>-<time>.zip is created, but you can specify a different file
name and also select the location in which to save the file.

Ul Description

BPM Tree

See "Browse Tab" on page 35.

Host Action Buttons

When a BPM host is selected, the following action buttons are enabled in the Browse tab of the BPM Tree

pane:
For details, see the relevant help
Button Description section below
|_| Create New Instance. Opens the Create New Instance "How to Create an Instance" on
o wizard, which you use to create a new instance ona BPM | page 46
host.

Note: You can create a maximum of 16 instances on a
BPM host.
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For details, see the relevant help
Button Description section below

Open BPM in a new window. Opens the BPM Admin N/A
Console for the selected BPM host in a new window.

53 - Browse. Opens a menu with the following browse options:

Browse Workspace "How to Browse the Workspace
Directory" on page 107

Browse Configuration Folder "How to Browse the Configuration
Folder" on page 153

Run. Opens a menu with the following run options:

[l

Run Page Component Breakdown "How to Run a Page Component
Breakdown Report" on page 85

Run WebTrace "How to Run WebTrace Reports" on

page 102

|ﬁ| Create Troubleshooting File. "How to Create Troubleshooting

T Files" on the previous page above

|I| Set User Credentials. Sets the user used to run the BPM. ' "How to Set Credentials to Run

o BPM as a Specific User" on page 39
above

|6| Restart BPM. Restarts the BPM. "How to Run BPM" on page 28

Note: Restarting BPM causes the loss of any data that
has not yet been reported by BPM to APM.

Note: You can also right-click a selected host in the BPM Tree to display a Shortcut menu of the
applicable actions.

Business Process Monitor Host Page

User interface elements are described below:

Ul Element Description
Business Process The name of the BPM. The name is automatically assigned during installation and
Monitor name is derived from the name of the host machine on which the BPM is installed.
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Health

Business Process
Monitor operating
system

Configuration
directory

Workspace directory

Number of scripts

Number of
WebTraces

Number of
transactions
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Description

The health of the BPM. The valid health statuses are:

« OK

« Agent Launch Failed

« The agent was killed, failed to set a timer for restarting it
« Run as specific user - failed to switch to user

+ Run as specific user — invalid password

The operating system of the host machine on which the BPM is installed.

The BPM configuration directory.
Default value: <BPM application directory>\config

Users require read-write access to this directory.

The BPM workspace directory, which you configure during the installation of
BPM.

Default value: <BPM application directory>\workspace

Users require read-write access to this directory.

The total number of scripts configured in all of the host’s instances, and the
number of those whose configuration status in EUM Administration is set to
Active.

The total number of WebTraces configured in all of the host’s instances, and the
number of those whose configuration status in EUM Administration is set to
Active.

The total number of transactions configured in all of the host’s instances, and the
number of those whose configuration status in EUM Administration is set to
Active.

Set User Credentials on Agent Dialog Box

User interface elements are described below:

Ul Element Description

System
user

HPE Business Process Monitor (9.40)

Select this radio button to configure BPM to run as the system user.
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Ul Element Description

Other user = Select this radio button to configure BPM to run as a specific user and enter the following
information:
« Name. The specific user name.
« Password. The password for the specific user.
« Domain. The domain of the specific user.
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A single BPM installation can communicate with multiple APM installations, each with its own tasks. Each
such connection is called an instance.

You can view details about an instance in the BPM Instance page.

To access

To access the BPM Instance page, select an instance entity in the BPM Tree displayed in the left pane of the
BPM Admin console. For details about the BPM Tree, see "Browse Tab" on page 35.

Learn About

Multiple BPM Instances

Your BPM installation can be used as the basis for multiple BPM instances on the host machine. For
example, you may require additional instances on the host machine to work with different APM Gateway
Servers. Eachinstance runs its own tasks and reports independently to the relevant server. Multiple
instances can also serve the same APM installation with different logical host names.

Host Names

Each instance is assigned a unique host alias, referred to as the host name. This host alias is used when
designating hosts to run transactions for your applications in EUM Administration. (Note that the host name
does not imply the host machine name.)

Location Names

You define a location name for each instance, used to help identify the instance in EUM Administration and in
EUM reports. The same location name can be used for multiple instances, and does not need to be the
location of the BPM host machine. Changing a location name in the Location Manager in APM overrides the
location configured for the instance in BPM Admin.

Authentication Schemes

For each instance, you specify server authentication, SSL, and proxy server information, as necessary. BPM
supports basic and NTLM authentication schemes. (If you receive an error message when the server tries to
communicate with the instance, check which authentication scheme is in use, and that the correct
authentication and proxy information is defined for the instance.) For required parameter settings when
configuring NTLM authentication, see "Parameters in sconn.cfg" on page 170.

Note: You are required to specify the authentication user name and password parameters when creating
or editing an instance.

Retry on Failure

The Retry on Failure setting enables you to control how BPM responds when a script fails.
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If a script fails, this may be caused by a temporary problem not related to the script, for example a temporary
network or Internet error.

When this option is enabled, if a script fails the first attempt, BPM attempts again. Only the last attempt is
displayed in BPM reports.

Note: BPM will not re-run a script if the script receives one of the following status codes:

« 1007 (Protocol not supported by the operating system)
« 1008 (Sandbox validation failed)

« 1009 (No free users available for script segregation)

You can set Retry on Failure values at the instance level in the Configuration tab. For further information, see
"Retry on Failure Properties Area" on page 61. You can set a different value for individual scripts by modifying
the default.cfg file as described below. Values set at the script level override values set at the instance level.

How to set Retry on Failure values at the script level:

1. Unzip the script zip file and open the default.cfg file in a text editor.

2. Inthe General area, add or modify the following values as seen in the example below:
RetryOnFailure=[1 = enable | @ = disable]
RetryOnFailureDelay=<Number of seconds to wait before retrying>

RetryOnFailureCount=<Maximum number of retry attempts>
RetryOnFailureSendAdditionalErrorMessage=[1 = enable | @ = disable]

Example

RetryOnFailure=1

RetryOnFailureDelay=30
RetryOnFailureCount=1
RetryOnFailureSendAdditionalErrorMessage=1

3. Once you have made the changes to the file, zip the script and upload it.
4. Apply the uploaded script to the existing application, or create a new application with the new values.

If there are values that are not set at the script level (in the default.cfg file), or the values are not valid, BPM
takes values set at the instance level. If there are no valid values set at either the script or the instance level,
BPM uses the following default values for the missing parameters:

« Retry on failure: False (0)
« Retry on failure delay: 30 seconds
« Retry on failure count: 1
« Send additional error message = False (0)
If there are Retry on Failure values which are not valid, the log displays a warning message.
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Tasks

How to Create an Instance

You create an instance by using the Create New Instance wizard. To open this wizard, select a BPM host

machine in the BPM Tree and click the Create New Instance |_| button in the Browse tab toolbar. For
details on using the Create New Instance wizard, see "Create New Instance Wizard" on page 48.

After creating a new BPM instance, the host name for the instance is added to the list of available data
collectors for running applications and business transaction flows in EUM Administration. For details on
specifying hosts for applications and business transaction flows, see the APM Application Administration
Guide.

Note:

« Theinitial installation of BPM on the host machine automatically creates the first BPM instance in
BPM Admin. For details, see "Deploying Business Process Monitor" in the Business Process Monitor
Deployment Guide.

e You can create a maximum of 16 instances on a BPM host.

How to Delete an Instance

Select an instance in the BPM Tree and click the Remove Instance |E| button in the Browse tab toolbar.

How to Configure Instance Settings

Select aninstance in the BPM Tree and click the Configuration tab in the Instance page. For details, see
"Configuration Tab" on page 57.

How to Configure Forward Proxy Settings
See "Proxy Settings Area" on page 63.

How to Configure Authentication Parameters for a BPM Instance
See "Security Settings Area" on page 61.

How to Browse Instance Files

Select aninstance in the BPM Tree and click the Browse |°° "| button. In the drop-down menu, select the
Browse Instance Files option. The Browse Instance Files dialog box opens in a new window that includes the

following areas:

« Left pane. Displays a tree of the files included in the instance’s Site(n) directory (the root entry in the
tree), where (n) is an internal number assigned by BPM Admin to the instance. The files included are
configuration and script files.

Note: The following files are not included in the instance directory:
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« Logfiles for retrieving configurations from APM
» Logfiles for sending samples to APM

« Logfiles for APM business logic

« Right pane. Displays the contents of the file you select in the tree in the left pane. If the selected file is
empty, the right pane also remains empty.
Note:

« You cannot edit the files from BPM Admin, only view the file contents.

« Use CTRL+*F to find a specific string in afile.

How to Update Changes Made in EUM Admin to the BPM Instance

Click the Request Configuration Update |E| button in the Browse tab toolbar. For details, see "Instance
Action Buttons" on the next page.

How to Purge Samples

Select aninstance in the BPM Tree and click the Purge Samples |@| button. All task reports waiting to be
relayed to the APM Gateway Server is removed from the queue.

Caution: When you click the Purge Samples button, all waiting data is purged from the BPM memory
and cannot be retrieved.

How to Run a BPM Instance as a Specific User

In addition, you can configure the BPM instance to run as a specific user, so that all tasks defined for the
instance run as a specific user. Running the BPM instance as a specific user may be necessary to solve
access permission problems on your network.

You can also set all BPM instances on the machine to run as a specific user, as described in "How to Set
Credentials to Run BPM as a Specific User" on page 39.

Ul Descriptions

« "Instance Action Buttons" on the next page

« "Create New Instance Wizard" on the next page
« "Status Tab" on page 55

« "Configuration Tab" on page 57

HPE Business Process Monitor (9.40) Page 47 of 196



Business Process Monitor Administration Guide
Chapter 6: BPM Instances

Troubleshooting/Limitations

Limitation

A BPM instance does not run applications or business transaction flows when you change a host name.

Instance Action Buttons

When you select a BPM instance, the following action buttons are enabled in the Browse tab toolbar:

Button Description

1%
E

i

]

Remove Instance. Deletes the selected instance.

Browse. Opens a drop-down menu. Click the Browse Instance Files option. The instance log
files appear in a new window.

For details, see "How to Browse Instance Files" on page 46.

Request Configuration Update. Updates changes made in EUM Administration (in APM) to the
BPM instance. Clicking this button enables you to manually prompt BPM to poll for changes.
BPM also automatically polls for updates, according to the defined job poll interval for the
instance (default value: 2 minutes).

Purge Samples. Removes all task reports waiting to be relayed to the APM Gateway Server
from the queue.

Note: When you click the Purge Samples button, all waiting data is purged from the BPM
memory and cannot be retrieved.

Note: You can also right-click a selected instance in the BPM Tree to display a Shortcut menu of the
applicable actions.

Create New Instance Wizard

The elements included in the wizard pages are the same as the corresponding elements in the Instance page,
where you can view and edit an existing instance’s settings.

This wizard contains the following pages:

« "Define Identification Parameters Page" on the next page

« "RunInstance as User Page" on page 50

« "Proxy Connection Settings Page" on page 52

« "Security Settings Page" on page 53
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Define Identification Parameters Page

This page enables you to configure the connection settings to the APM Gateway server.

Note: The display, host, and location names must be entered in English. If you use non-English strings in
any of the names, BPM must be installed on an operating system that supports these characters.

User interface elements are described below:

Ul Element Description

Display The display name defined for the instance in BPM Admin. This name is only used within
name BPM Admin to identify the instance in the BPM Tree.

Syntax rules:

o Canbe up to 50 characters.
o Caninclude the following characters: 0-9, a-z, A-Z, hyphen (-), underscore ().
« Cannot start or end with a hyphen (-) or an underscore (_).
Gateway The full URL of the APM Default Virtual Gateway Server for Data Collectors as defined

Server in APM Platform settings, to which this instance sends collected data. The URL must be in
URL the following format:

http (or https)://<Gateway Server name or IP address>:<port number>/topaz/
If you do not specify a port number, the default port is used (80 for http and 443 for https).
Note:

« The URL s case sensitive.

« The URL cannot contain non-English characters. BPM does not support International
Domain Names for the Gateway Server URL.

Host name The host name defined for the instance. The host name is used to identify the instance in
EUM Administration and reports in APM.

The host name must be unique within the APM environment.

If you change the host name for an instance, APM assigns a new HostID value to the BPM
instance. As aresult, the BPM instance does not run applications or business transaction
flows (or profiles for systems earlier than BSM version 9.00) that use the original host name.
To enable applications and business transaction flows (or profiles) to run correctly after
changing the host name, you must update your applications and business transaction flows
(or profiles) in EUM Administration to use the new instance host name.

Syntax rules:

« Do not use special characters if these characters are not supported in APM. Unsupported
characters are blocked by BPM Admin.

« Canbe up to 50 characters.

« Caninclude the following characters: 09, a-z, A-Z, ~'@#$% " & *()_-+=[1{}
|1?.," ;<> (space).
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Ul Element

Location
name

Job poll
interval
(minutes)

Time poll
interval
(minutes)

Description

The location defined for the instance.

Note: Do not change the location for a BPM instance that is designated as the host for a
profile, when the database for the profile is down. Doing so removes the mapping from the
profile to the instance, with no recovery.

Syntax rules:

o Canbe up to 50 characters.
« Caninclude the following characters: 09, a-z, A-Z, ~'@#$% " & *()_-+=[1{}
|1?.,:; (space).

The defined frequency (in minutes) with which BPM polls for assigned tasks (for example,
running scripts or WebTrace) and changes to application configurations. This is a positive
integer of up to 4 digits.

Default value: 2

The defined frequency (in minutes) with which BPM polls APM for time synchronization. This
is a positive integer of up to 4 digits.

Default value: 60

Note: If a time change is made on the APM Gateway Server, for example, for daylight saving
time, then the time poll interval value should be changed to a value smaller than the default of
60 minutes, for each BPM instance.

If this is not done, it may take up to an hour for BPM to be synchronized with the time change
in APM, and during this period the BPM samples are reported with the wrong time stamp.

Run Instance as User Page

By default, each BPM instance runs on the host machine as the system user, unless you configured the
whole BPM to run as a specific user (as described in "How to Set Credentials to Run BPM as a Specific
User" on page 39).

This page enables you to configure an individual instance (and not the whole BPM) to run as a specific user.
Running an instance as a specific user limits access to resources, settings, and applications located on the
local machine. (This may not be true for resources located on remote machines, where a specific user may
have different privileges than the local system user.)

Note: If you want to run QuickTest Professional/Unified Functional Testing scripts as a specific user, we
recommend that you set each relevant BPM instance to run as a specific user before assigning the
QuickTest Professional/Unified Functional Testing scripts.

After running QuickTest Professional/Unified Functional Testing scripts as the system user, if you then
set the BPM instance to run as a specific user, the script may fail. In this case, restart the BPM machine.
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User interface elements are described below:

Ul Element Description

User name The specific user name.
Syntax rules:

o Canbe up to 24 characters.

« Cannot include spaces, non-Latin letters (such as Greek or
Cyrillic), or any of the following characters: (; : " <>*+=\]?,).

Group The user group.

Note: This field is for BPM on Linux only.

Password The password for the user.

Note: This field is for BPM on Windows only.

Domain The domain of the user.
Note: This field is for BPM on Windows only.
Syntax rules:
« Can be up to 67 characters long.

o Caninclude the following characters: 0-9, a-z, A-Z, hyphen (-).
« Cannot start or end with a hyphen (-), nor can it include spaces.

If you are running a BPM instance as a specific user without administrator permissions on the local machine,
you need to set additional permissions for the user.

Windows
Set additional permissions for a specific user without administrator permissions:

1. Assign Read & Execute permissions to the BPM installation directory.

2. Assign Full Control permissions to the relevant directory for the instance. For example, the first instance
must have access rights to the ..\Workspace\agent1\site1 directory.

3. Assign Write permissions to the ..\Workspace\agent1\data\snapshots directory.

4. Assign Write permissions to the default user temp directory. All MDRYV based programs in the system
use this directory for certain processes, for example when using a script with parameters. The directory
is usually located under:

« Windows Server 2003

C:\Documents and Settings\Default User\Local Settings\Temp

« Windows Server 2008 and Windows 7
C:\Users\<User name>\AppData\Local\Temp

Linux
Enable the instance Run as User feature for Linux:

1. Open the letc/sudoers file with a dedicated editor (for example, sudoedit).

2. Replace the line Defaults requiretty with Defaults !requiretty.
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3. Replacetheline root ALL=(ALL) ALL with root ALL=(ALL:ALL) ALL.
4. Atthe end of the Defaults env_keep definition section add:
Defaults env_keep +="PATH M_LROOT QTLIB QTINC PRODUCT_DIR"
Note: If there is no line beginning with Defaults env_keep= already in the file, then add the line:

Defaults env_keep = "PATH M_LROOT QTLIB QTINC PRODUCT _DIR" (there is no plus sign before
the equals sign)

5. Save.

Retry On Failure Settings Page

On this page you can configure how BPM should respond if a script in the instance fails. For further
information about this feature, see "Retry on Failure" on page 44.

User interface elements are described below:

Ul Element Description

Retry on Failure Select this option to activate the Retry on Failure option.

Retry on failure The number of seconds to wait before retrying. Note that a long failure delay may
delay cause the application to skip a scheduled run.

Retry on failure The maximum number of attempts to retry the script before the script is defined as
count "Failed".

Send additional Select this option to include the number of attempts in the failure error message.

error message

Proxy Connection Settings Page

On this page, you configure forward proxy settings if the BPM machine requires a proxy server for access to
external servers (for example, a APM virtual server such as the APM Gateway Server or aload
balancer/reverse proxy in front of a APM Gateway Server).

Note:

« To configure access to APM through a reverse proxy, do not use these proxy settings, but configure
the reverse proxy server URL instead of the Gateway Server URL in "Define Identification
Parameters Page" on page 49 above.

« Ifyou create an instance with proxy settings and the instance gives errors and does not function
properly, delete the instance, recreate it without proxy settings, and then add the required proxy
settings to the recreated instance.

« You cannot connect a forward proxy configured for NTLM authentication to a APM server configured
for SSL.
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User interface elements are described below:

Ul Element Description

Proxy user name The user name for the proxy server.

Note: To configure a user name, you must also configure the proxy server

URL.
Proxy password The password for the user.
Proxy domain The domain of the user.
Proxy URL The URL for the proxy server.

Note: The proxy URL must be in the following format:
http (or https)://<host name or IP address>:<port number>/URL path.

Proxy authentication The type of authentication—Basic or NTLM.

type Default value: Basic
Security Settings Page

On this page, you configure authentication parameters for the BPM instance to support the authentication
scheme in use by the APM Virtual Gateway Server for Data Collectors (basic or NTLM authentication). It also
enables you to define SSL settings if the BPM instance is communicating with APM using SSL.

For more information on using basic authentication in APM, see the APM Hardening Guide.
For more information on supporting SSL communication, see "Configuring BPM to Run Over a Secure
Connection" on page 174.

Note:

« Todefine basic authentication requirements for accessing BPM Admin, see "How to Configure
Authentication for BPM Admin" on page 179.

« Forrequired parameter settings when configuring NTLM authentication, see "Parameters in
sconn.cfg" on page 170.

User interface elements are described below:

Ul Element Description

Authentication Settings

Authentication user The name of the user (recognized by the APM Gateway Server) for
name authentication.

Authentication The password for the configured user.

password

Authentication domain = The domain for the configured user.
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Description

The type of authentication—Basic or NTLM.

Default value: Basic

For details on obtaining a CA root certificate, see "How to Configure TLS Support for BPM with an
APM Connection" on page 174 below.

Truststore path

Truststore type

Truststore password

Keystore path

Keystore type
Keystore password
Private key password

Validate that the server
certificates are trusted

Validate host names on
server certificates

Validate that the server
certificates are not
expired

HPE Business Process Monitor (9.40)

The full path and file name of the truststore file containing the trusted root
certificates. The truststore file must be a java keystore file (JKS).

Note: Configure this field only if you do not want to use the default JRE
truststore (/lopt/HP/BPM/JRE/lib/security/cacerts).

The type of truststore file. BPM supports PKCS#12 and JKS truststore types.
We recommend using JKS.
The password for the truststore file.

The full path and file name of the keystore file containing the client certificate
and its private key. The keystore file must be either a java keystore file (JKS)
or PKCS#12 type file.

Note:

« Configure this field only if APM connection requires a client certificate.
« Request a client certificate from your CA with keys marked as exportable.

The type of keystore file—JKS or PKCS#12.
The password for the keystore file.
The password for the private key located in the keystore file.

Select this check box to validate that the authority that issued the APM server
certificate is trusted by BPM (that is, the certificate of the issuing authority has
been imported to the BPM truststore).

Select this check box to validate that the configured APM server host name
matches the name in the server certificate.

Select this check box to validate that the certificate is current.
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Status Tab

The Status tab displays general information about the instance, its monitoring status, and the run units
included in the instance. The status tab includes the following areas:

« "General Information Area" below
« "Monitoring Status Area" below

« "Run Units Area" on the next page

General Information Area

This area enables you to view general information about the instance.

User interface elements are described below:

Ul Element Description

Display name The display name defined for the instance in BPM Admin. This name is used within BPM
Admin only to identify the instance in the BPM tree displayed in the left pane of the BPM
Admin console.

Health The communication status for the instance with APM. If an error is displayed, click the
details link to display the original error message in its raw format.

Instance ID BPM internal ID for the instance.

Tip: The ID may help you identify relevant folders in the BPM workspace.

Last update The last time that BPM polled for changes made in EUM Administration to BPM.

configuration Note: BPM also automatically polls for updates, according to the defined job poll interval

request (default value: 2 minutes).

Last The time of the last change made to the instance configuration.
configuration

update

Monitoring Status Area
This area displays information on the tasks for the instance.
User interface elements are described below:

Ul Element Description

Number of The total number of applications associated with the instance, and the number of those
applications | whose status in EUM Administration is Active.

Number of The total number of scripts associated with the instance, and the number of those whose
scripts status in EUM Administration is Active.
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Ul Element Description

Number of The total number of WebTraces associated with the instance, and the number of those
WebTraces whose status in EUM Administration is Active.

Number of The total number of transactions associated with the instance, and the number of those

transactions

whose status in EUM Administration is Active.

The number of task reports (for completed runs of script transactions, WebTraces, and so
forth) waiting to be relayed to the APM Gateway Server.

Pending
samples

Note: There are no limitations to the size of the queue except for the amount of free disk
space available.

Run Units Area

This area displays details of the run units included in the instance. Run units are applications, or business
transaction flows with their own schedule. For details on run units, see "Run Units" on page 116.

Note: Aninactive business transaction flow that is part of an active application is considered to have its
own schedule and is therefore considered as a separate run unit.

User interface elements are described below:

Ul Element Description
Type The run unit type—application or business transaction flow.
Run Unit The run unit name (that is, the application or business transaction flow name).
Name Tooltip: The run unit’s schedule.
Note:
« Click the name to select the application or business transaction flow in the BPM tree and
display the relevant page for it. For details on the Application page, see "BPM
Applications" on page 64 and for details on the business transaction flow page, see
"Business Transaction Flows" on page 72.
« This columnis not visible when working in BPM versions earlier than 9.00.
Last Run The start time of the last run of the run unit on this instance, according to the local time on
Start Time  the BPM machine.
Last Run The time, in seconds, it took to execute the last run of the run unit.
Duration
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Ul Element Description

Status The current status of the run unit. Valid options are:
« Currently running. The run unit is currently running tasks.
« ldle. The run unit is running, but has no tasks running at this time.
« Stopped. The run unit is stopped.
« Not initialized. The run unit has not yet started its initial run.

Note: If the status is Not initialized, the run unit is in the process of getting ready to run—
creating the schedules, downloading the required scripts. If there is a problem (for example,
if the script does not download or if there is an incorrect schedule definition) the run unit
remains at this status and an error "failed to initialize profile X ..."is writtenin
the bpm_bsm_comm.log file.

Application The application name. If the run unit is an application, the run unit name and application are
the same. If the run unit is a business transaction flow, this is the name of the application
that includes the business transaction flow.

Configuration Tab

The Configuration tab enables you to view and change the instance settings.
The Configuration tab includes the following areas:

« "Application Performance Management Registration Properties Area" below
« "Runas a Specific User Area" on page 59

« "Proxy Settings Area" on page 63

« "Security Settings Area" on page 61

Application Performance Management Registration Properties Area

This area displays, and enables you to edit, the connection settings to the APM Gateway server.

Important The display, host, and location names must be entered in English. If you use non-English
information = strings in any of the names, BPM must be installed on an operating system that supports
these characters.
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User interface elements are described below:

Ul Element Description

Display The display name defined for the instance in BPM Admin. This name is only used within
name BPM Admin to identify the instance in the BPM tree displayed in the left pane of the BPM
Admin console.

Syntax rules:

o Canbe up to 50 characters.
o Caninclude the following characters: 0-9, a-z, A-Z, hyphen (-), underscore ().
o Cannot start or end with a hyphen (-) or an underscore (_).
Gateway The full URL of the APM Default Virtual Gateway Server for Data Collectors as defined

Server in APM Platform settings, to which this instance sends collected data. The URL must be in
URL the following format:

http (or https)://<Gateway Server name or IP address>:<port number>/topaz/
If you do not specify a port number, the default port is used (80 for http and 443 for https).
Note:

« The URL is case sensitive.

« The URL cannot contain non-English characters. BPM does not support International
Domain Names for the Gateway Server URL.

Host name The host name defined for the instance. The host name is used to identify the instance in
EUM Administration and reports in APM.

The host name must be unique within the APM environment.

If you change the host name for an instance, APM assigns a new HostID value to the BPM
instance. As a result, the BPM instance does not run applications or business transaction
flows (or profiles for systems earlier than BSM version 9.00) that use the original host name.
To enable applications and business transaction flows (or profiles) to run correctly after
changing the host name, you must update your applications and business transaction flows
(or profiles) in EUM Administration to use the new instance host name.

Syntax rules:

« Do not use special characters if these characters are not supported in APM. Unsupported
characters are blocked by BPM Admin.
o Canbe up to 50 characters.

o Caninclude the following characters: 0-9, a-z, A-Z, " ~ ' @#$% * & *()_-+=[]1{}
|1?2.,"" ;<> (space).
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Ul Element Description

Location
name

Job poll
interval
(minutes)

Time poll
interval
(minutes)

The location defined for the instance.
Note:
« This field is displayed only for instances that include profiles. That is, instances that are
configured for Business Availability Center (installations earlier than BSM 9.00).

« Do not change the location for a BPM instance that is designated as the host for a profile,
when the database for the profile is down. Doing so removes the mapping from the profile
to the instance, with no recovery.

Syntax rules:

o Canbe up to 50 characters.

o Caninclude the following characters: 0-9, a-z, A-Z, " ~ ' @#$% * & *()_-+=[]1{}
|1?.,:; (space).

The defined frequency (in minutes) with which BPM polls for assigned tasks (for example,
running scripts or WebTrace) and changes to application configurations. This is a positive
integer of up to 4 digits.

Default value: 2

The defined frequency (in minutes) with which BPM polls APM for time synchronization. This
is a positive integer positive of up to 4 digits.

Default value: 60

Note: If a time change is made on the APM Gateway Server, for example, for daylight saving
time, then the time poll interval value should be changed to a value smaller than the default of
60 minutes, for each BPM instance.

If this is not done, it may take up to an hour for BPM to be synchronized with the time change
in APM, and during this period the BPM samples are reported with the wrong time stamp.

Run as a Specific User Area

By default, each BPM instance runs on the host machine as the system user, unless you configured the
whole BPM to run as a specific user (as described in "How to Set Credentials to Run BPM as a Specific
User" on page 39).

This area enables you to configure an individual instance (and not the whole BPM) to run as a specific user.

Running an instance as a specific user limits access to resources, settings, and applications located on the
local machine. (This may not be true for resources located on remote machines, where a specific user may

have different privileges than the local system user.)

Note: If you want to run QuickTest Professional/Unified Functional Testing scripts as a specific user, we
recommend that you set each relevant BPM instance to run as a specific user before assigning the
QuickTest Professional/Unified Functional Testing scripts.

After running QuickTest Professional/Unified Functional Testing scripts as the system user, if you then
set the BPM instance to run as a specific user, the script may fail. In this case, restart the BPM machine.
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User interface elements are described below:

Ul Element Description

User name The specific user name.
Syntax rules:

o Canbe up to 24 characters.

« Cannot include spaces, non-Latin letters (such as Greek or
Cyrillic), or any of the following characters: (; : " <>*+=\]?,).

Group The user group.

Note: This field is for BPM on Linux only.

Password The password for the user.

Note: This field is for BPM on Windows only.

Domain The domain of the user.
Note: This field is for BPM on Windows only.
Syntax rules:
« Can be up to 67 characters long.

o Caninclude the following characters: 0-9, a-z, A-Z, hyphen (-).
« Cannot start or end with a hyphen (-), nor can it include spaces.

If you are running a BPM instance as a specific user without administrator permissions on the local machine,
you need to set additional permissions for the user.
Windows
Set additional permissions for a specific user without administrator permissions:
1. Assign Read & Execute permissions to the <BPM installation directory>.

2. Assign Full Control permissions to the relevant directory for the instance. For example, the first instance
must have access rights to the ..\Workspace\agent1\site1 directory.

3. Assign Write permissions to the ..\Workspace\agent1\data\snapshots directory.

4. Assign Write permissions to the default user temp directory. All MDRYV based programs in the system
use this directory for certain processes, for example when using a script with parameters. The directory
is usually located under:

« Windows Server 2003
C:\Documents and Settings\Default User\Local Settings\Temp

o Windows Server 2008 and Windows 7
C:\Users\<User name>\AppData\Local\Temp

Linux
Enable the instance Run as User feature for Linux:

1. Open the letc/sudoers file with a dedicated editor (for example, sudoedit)

2. Replace the line Defaults requiretty with Defaults !requiretty
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3. Replacetheline root ALL=(ALL) ALL with root ALL=(ALL:ALL) ALL
4. Atthe end of the Defaults env_keep definition section add:
Defaults env_keep += "PATH M_LROOT QTLIB QTINC PRODUCT_DIR"
Note: If there is no line beginning with Defaults env_keep= already in the file, then add the line:

Defaults env_keep = "PATH M_LROOT QTLIB QTINC PRODUCT _DIR" (there is no plus sign before
the equals sign)

5. Save

Retry on Failure Properties Area
This area enables you to control how BPM responds when a script fails.
For further information about this feature, see "Retry on Failure" on page 44.

User interface elements are described below:

Ul Element Description

Retry on Failure Select this option to activate the Retry on Failure option.

Retry on failure The number of seconds to wait before retrying. Note that a long failure delay may
delay cause the application to skip a scheduled run.

Retry on failure The maximum number of attempts to retry the script before the script is defined as
count "Failed".

Send additional Select this option to include the number of attempts in the failure error message.

error message

Security Settings Area

This area enables you to configure authentication parameters for the BPM instance to support the
authentication scheme in use by the APM Virtual Gateway Server for Data Collectors (basic or NTLM
authentication). It also enables you to define SSL settings if the BPM instance is communicating with APM
using SSL.

For more information on using basic authentication in APM, see the APM Hardening Guide, part of the
Application Performance Management Documentation Library.

For more information on supporting SSL communication, see "Configuring BPM to Run Over a Secure
Connection" on page 174.
Note:

« Todefine basic authentication requirements for accessing BPM Admin, see "How to Configure
Authentication for BPM Admin" on page 179.

« Forrequired parameter settings when configuring NTLM authentication, see "Parameters in
sconn.cfg" on page 170.
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User interface elements are described below:

Ul Element
Authentication Settings

Authentication user
name

Authentication
password

Authentication domain

Authentication type

SSL Settings

Description

The name of the user (recognized by the APM Gateway Server) for
authentication.

The password for the configured user.

The domain for the configured user.

The type of authentication—Basic or NTLM.

Default value: Basic

For details on obtaining a CA root certificate, see "How to Configure TLS Support for BPM with an
APM Connection" on page 174 below.

Truststore path

Truststore type

Truststore password

Keystore path

Keystore type
Keystore password
Private key password

Validate that the server
certificates are trusted

Validate host names on
server certificates
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The full path and file name of the truststore file containing the trusted root
certificates.

Note: Configure this field only if you do not want to use the default JRE
truststore (/fopt/HP/BPM/JRE/lib/security/cacerts).

The type of truststore file. BPM supports PKCS#12 and JKS truststore types.
We recommend using JKS.
The password for the truststore file.

The full path and file name of the keystore file containing the client certificate
and its private key. The keystore file must be either a java keystore file (JKS)
or PKCS#12 type file.

Note:

« Configure this field only if APM connection requires a client certificate.
« Request aclient certificate from your CA with keys marked as exportable.

The type of keystore file—JKS or PKCS#12.
The password for the keystore file.
The password for the private key located in the keystore file.

Select this check box to validate that the authority that issued the BSM server
certificate is trusted by BPM (that is, the certificate of the issuing authority has
been imported to the BPM truststore).

Select this check box to validate that the configured APM server host name
matches the name in the server certificate.
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Ul Element

Validate that the server

certificates are not
expired

Proxy Settings Area

Description

Select this check box to validate that the certificate is current.

This area enables you to configure forward proxy settings, if the BPM machine requires a proxy server for
access to external servers (for example, a APM virtual server such as the APM Gateway Server or a load
balancer/reverse proxy in front of a APM Gateway Server).

Important « To configure access to APM through a reverse proxy, do not use these proxy settings,
information but configure the reverse proxy server URL instead of the Gateway Server URL in
"Application Performance Management Registration Properties Area" on page 57 above.

« If you create an instance with proxy settings and the instance gives errors and does not
function properly, delete the instance, recreate it without proxy settings, and then add the
required proxy settings to the recreated instance.

« You cannot connect a forward proxy configured for NTLM authentication to a APM server
configured for SSL.

User interface elements are described below:

Ul Element

Proxy user name

Proxy password
Proxy domain

Proxy URL

Proxy authentication

type

Description

The user name for the proxy server.

Note: To configure a user name, you must also configure the proxy server
URL.

The password for the user.
The domain of the user.

The URL for the proxy server.

Note: The proxy URL must be in the following format:
http (or https)://<host name or IP address>:<port number>/URL path.

The type of authentication—Basic or NTLM.

Default value: Basic
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You can view the details of applications configured in EUM Administration on the BPM Application page. The
Application page appears in the right pane of the BPM Admin console.

To access
To access the Application page:
1. Open BPM Admin. For details, see "How to Access BPM Admin" on page 28.

2. Select an application in the BPM Tree that appears in the left pane of the BPM Admin console. For
details about the BPM Tree, see "Browse Tab" on page 35.

Learn About

Setting a Log Level

Many scripts (for example, LoadRunner scripts and VuGen scripts for web-based protocols) include runtime
settings that determine the extent of the information logged to the output when the script is run. There are
three settings for logging: Disabled, Brief, and Extended. By default, BPM runs the scripts using the
Disabled log level. This means that only minimum information is logged to the mdrv log for each run of the
script.

You can change the log level for a specific script run when you invoke a single run of the script in the
Business Transaction Flow page. Changing the log level to Brief or Extended introduces extra overhead in the
mdrv log files, and may slow down the run of the script (so affecting the measured run times). An Extended
log is helpful for debugging a script, but is otherwise not recommended.

For task details, see "How to Run a Task (Script or WebTrace)" on the next page below.

Tasks

How to Configure Applications in EUM Admin
You configure applications in EUM Admin.

When you configure applications, application names (as well as the names of the included transactions and
scripts):

« Must be entered in the same language that is set for the operating system on which BPM is installed
« Must contain only characters that are supported by the operating system on which BPM is installed

For more details on configuring applications in EUM Administration, see "Business Process Monitor
Application Configuration Wizard" in the APM Application Administration Guide.

How to View Application Status Information

See "Monitoring Status Area" on page 67.
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How to Run a Task (Script or WebTrace)

In the Monitoring Status area:

1.

5.

Select a task and click the Run Task > button. The Run Script dialog box opens showing details of the
run.

In the Log level field, select a log level (Disabled, Brief, or Extended) to determine the extent of the
information logged to the output for the script run. For details about log levels, see "Setting a Log Level"
on the previous page above.

Enter additional command line parameters.

Enter a timeout value, in minutes. This value determines how long BPM attempts to retrieve the web
page component data before timing out. The default timeout value is 15 minutes.

Click Run.

Note: These settings are applicable only to this run of the script. The task run data is not sent to APM.
The task run does not affect the run unit’s regular scheduling in BPM, or the run of any other run unit in
BPM.

How to Browse Scripts

In the Monitoring Status area, select a task and click the Browse Script = button. The Browse Script dialog

box opens. If an MDRYV log file exists, it is selected automatically. For details on log files, see "Log Files" on
page 110.

Note: This button is disabled for all WebTraces and for scripts for which there is no Last Run Status
data.

Ul Description

HPE Business Process Monitor (9.40)

"General Information Area" on the next page

"Schedule List Area" on the next page

"Monitoring Status Area" on page 67

"Business Transaction Flows Overriding Application Schedule Area" on page 69
"Script Properties Window" on page 78

"WebTrace Properties Window" on page 80
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General Information Area

This area enables you to view general information about the application.
User interface elements are described below:
Ul Element Description

Display The name of the application as configured in EUM Administration in APM.
name

Status The current status of the application in APM—Active, Inactive, or Downtime.

Location The location defined for the instance.
name
Note:

« Thelocation name represents the name set by the Location Manager. For details, see
Location Manager in the APM Platform Administration Guide.

« The location name may be overridden by the Location Manager in APM.

Schedule List Area

This area enables you to view the schedules configured for the application.
User interface elements are described below:
Ul Element Description

Schedule The schedule for running the application on this BPM instance, as configured in EUM
Description Administration. If the application has multiple schedules, all schedules are shown. (For more
information, see "Run Units" on page 116.)

Time Zone | Thetime zone to use for the BPM instance, as configured in EUM Administration.

Start Offset The start offset, which specifies the delay between the application schedule time and the
actual run time. (For information on how the start offset is calculated, see "Start Offset" on
page 118.)
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Monitoring Status Area

This area enables you to view general information about the application, as well as the running order and
dependencies of the selected application’s tasks.

User interface elements are described below:

Ul Element Description

<General Information>

Number of
tasks

Status

Last start
time

Last run
duration

Run mode

<Tasks>

B
Run Order

Name

Type
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The number of tasks included in the application run unit.

The application run unit status. Valid options are:

« Not initialized — The run unit has not yet been initialized.
« Running —The run unit is currently running on this BPM instance.

« Idle —The run unit is not currently running on this instance and is waiting for the next
scheduled run.

« Downtime — The run unit is not currently running on this instance.

The time that the run unit was last run.

The duration of the run unit’s last run.

The run mode configured for the application. For details on run modes, see "Run Modes" on
page 119.

Task Properties. Opens a new window showing the script or WebTrace properties. For
details, see "Script Properties Window" on page 78 and "WebTrace Properties Window" on
page 80.

Browse Script. Displays the script log file (in case of error during last, run the mdrv log file)
for the last run of the task. For details on log files, see "Log Files" on page 110.

Note: This element is disabled for all WebTraces and for scripts for which there is no Last
Run Status data.

Run Task. Runs a selected task. Details of the run are reported in a new window. For details
on task reports, see BPM Task Reports.

The order in which the tasks are run. This is determined by the run mode configured for the
BPM in EUM Administration. For details on run modes, see "Run Modes" on page 119.

The script or WebTrace name.

The type of task—script, WebTrace, or single URL.

Page 67 of 196



Business Process Monitor Administration Guide
Chapter 7: BPM Applications

Ul Element Description

BTF The business transaction flow in which the task is included, as configured in EUM
Administration.

Note:

« WebTraces configured directly for the application are not included in a business
transaction flow and in such cases, this cell displays n/a.

« Click abusiness transaction flow link to select the business transaction flow in the BPM
Tree and display the relevant page.

Status The current status of the task. Valid options are:

« Not initialized — The task has not yet been initialized.
« Running —The task is currently running on this BPM instance.

« Idle —The task is not currently running on this instance.
Version The script version.

Last Run The status of the last run. Valid options are:

Status » Finished properly — The task finished running with no errors.

« Finished (errors occurred) — The task finished running; however, there may be some
errors in the task reports (for example, the traceroute server may report "progress
aborted" for a WebTrace request). Check the network.txt and webtrace.txt files in the
workspace\webtrace folder. For details of browsing the workspace folder, see "How to
Browse the Workspace Directory" on page 107.

« Failed to start — The task failed to start running.

« Terminated unexpectedly — The task failed during the run.

« Error: Aborted — The task was aborted.

o Aborted (timeout) — The task timed-out and stopped running.

o End status is not set — The task has not run yet, therefore no end status is available.

« n/a—Run status is not applicable for the task, for example, if the application is inactive.

Last Run The duration of the last run.
Time

HPE Business Process Monitor (9.40) Page 68 of 196



Business Process Monitor Administration Guide
Chapter 7: BPM Applications

Business Transaction Flows Overriding
Application Schedule Area

This area enables you to view general information about business transaction flows that are part of the
application, but which have their own schedules, so are considered as separate run units.

User interface elements are described below:
Ul Element Description
BTF Name The business transaction flow name.
Last Run Start Time The time that the run unit was last run.
Last Run Duration = The duration of the last run of the run unit.

Status The current status of the business transaction flow. Valid options are:

« Not initialized — The run unit has not yet been initialized.
« Running —The run unit is currently running on this BPM instance.

« ldle — The run unit is not currently running on this instance.

Script Properties Window

This window displays general details about a script and its included transactions.

To access the Script Properties window for a selected script, click the Task Properties button in the
Tasks area or Tasks Included in the Business Transaction Flow and its Parent Application’s Run Unit Area.

Note: You can edit the following string-value script parameters in APM:

» File Parameter
« Custom Parameter
All other script parameters are marked as Read Only can only be edited in VuGen or TruClient.

User interface elements are described below:

Ul Element Description

General Information

Name The script name, as configured in EUM Administration.
Script The version of the script used.

Repository

Version
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Ul Element Description

Last Run The status of the last run. Valid options are:

Status « Finished properly — The task finished running with no errors.

« Finished (errors occurred) — The task finished running; however, there may be some
errors in the task reports. Check the mdrv.log file for further information on the errors
encountered.

« Failed to start — The task failed to start running.

« Terminated unexpectedly — The task failed during the run.

« Error: Aborted — The task was aborted.

« Aborted (timeout) — The task timed-out and stopped running.

« End status is not set — The task has not run yet, therefore no end status is available.
« Not supported by OS — The task’s protocol is not supported by the operating system.
« n/a—Run status is not applicable for the task, for example, if the application is

inactive.
Last Run The time of the last run.
Time
Last Run The duration of the last run.
Duration

Transactions—lists the transactions included in the script and displays the following data for

them:

Name The transaction name as used in the script.

Original The original transaction name.

Name Note: If you change the name of a Business Transaction Cl in EUM Administration, the
transaction name in existing scripts is not changed. Elsewhere, however, (for example, in
Service Health, reports, and EUM Administration) the transaction name is changed and
persistent data for the Cl is preserved.

OK The response time threshold below which the transaction’s status is OK, as configured in
EUM Administration.

Minor The response time thresholds between which the transaction’s status is Minor, as
configured in EUM Administration.

Critical The response time threshold above which the transaction’s status is Critical, as
configured in EUM Administration.

Outlier The response time threshold above which the transaction is considered to be an Ouitlier, as

configured in EUM Administration. Outliers are transactions whose response time
exceeds a defined time range.

Availability The availability threshold configured for the transaction in EUM Administration.

Parameters—lists the parameters used in the script and displays the following data for them:
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Ul Element Description
Name The parameter name.

Value The parameter value.

WebTrace Properties Window

This window displays general details about a WebTrace.

To access the WebTrace Properties window for a selected WebTrace, click the Task Properties button
in the Tasks area or Tasks Included in the Business Transaction Flow and its Parent Application’s Run Unit
Area.

User interface elements are described below:

Ul Element Description
URL The URL accessed by the WebTrace.
Port The port for the URL accessed by the WebTrace.

Last Run The status of the last run. Valid options are:

Status « Finished properly — The task finished running with no errors.

« Finished (errors occurred) — The task finished running; however, there may be some
errors in the task reports (for example, the traceroute server may report "progress
aborted" for a WebTrace request). Check the relevant WebTrace log files for further
information on the errors encountered. For details on log files, see "Log Files" on page
110.

« Failed to start — The task failed to start running.

« Terminated unexpectedly — The task failed during the run.

« Error: Aborted — The task was aborted.

« Aborted (timeout) — The task timed-out and stopped running.

« End status is not set — The task has not run yet, therefore no end status is available.

« n/a—Run status is not applicable for the task, for example, if the application is inactive.

Last Run The time of the last run.
Time

Last Run The duration of the last run.
Duration

Note: On Linux, BPM WebTrace requires CAP_NET_RAW capability or an Effective UID of 0.
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A business transaction flow is a logical user flow in an application.

The BPM Admin Business Transaction Flow page enables you to view details of a business transaction flow
configured in EUM Administration to which an instance is assigned. There are slight differences in the
Business Transaction Flow page depending on whether the business transaction flow uses its parent
application’s schedule or has its own overriding schedule.

To access
To access the Business Transaction Flow page:

1. Open BPM Admin. For details, see "How to Access BPM Admin" on page 28.

2. Select abusiness transaction flow in the BPM Tree that appears in the left pane of the BPM Admin
console.

The Business Transaction Flow page appears in the right pane of the BPM Admin console.

Learn About

Example

In a human resources application you may have a business transaction flow for registering a new employee.
You assign a script to the business transaction flow (you can assign more than one script, although we
recommend to assign only one) that contains individual transactions. The script for the business transaction
flow for registering a new employee may include transactions for logging in to the application, entering the
new employee’s personal details, marking a check list to ensure that all necessary documents have been
received from the new employee, and logging out of the system.

Business Transaction Flow Schedules and Run Modes

By default, a business transaction flow uses the same schedules and run modes as its parent application, but
you can configure different schedules and run modes specifically for a business transaction flow. If a
business transaction flow has its own schedule, it is not included in the application run on the BPM instance,
but is run as an independent unit. For details on run units, see "Run Units" on page 116.

Connecting to an BAC System Earlier Than Version 9.00

When a BPM instance connects to an Business Availability Center system earlier than version 9.00, profiles
are included in the BPM Tree displayed in the left pane of the BPM Admin console, instead of applications and
business transaction flows. To access the BPM Profile page, select a profile in the BPM tree. The Profile
page user interface is similar to the Business Transaction Flow page user interface for business transaction
flows that have their own schedule (that is, business transaction flows that are independent run units). For
details, see "Ul Description " on page 74 below.

Setting a Log Level

Many scripts (for example, LoadRunner scripts and VuGen scripts for web-based protocols) include runtime
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settings that determine the extent of the information logged to the output when the script is run. There are
three settings for logging: Disabled, Brief, and Extended. By default, BPM runs the scripts using the
Disabled log level. This means that only minimum information is logged to the mdrv log for each run of the
script.

You can change the log level for a specific script run when you invoke a single run of the script in the Business
Transaction Flow page. Changing the log level to Brief or Extended introduces extra overhead in the mdrv log
files, and may slow down the run of the script (so affecting the measured run times). An Extended log is
helpful for debugging a script, but is otherwise not recommended.

For task details, see "How to Run a Task (Script or WebTrace)" below below.

Tasks

How to Configure Business Transaction Flow Schedules

You configure business transaction flows in EUM Administration.

When you configure business transaction flows, business transaction flow names (as well as the names of
the included transactions and scripts):

« Must be entered in the same language that is set for the operating system on which BPM is installed
« Must contain only characters that are supported by the operating system on which BPM is installed

For more details on configuring business transaction flows in EUM Administration, see "Business
Transaction Flow Configuration Wizard" in the APM Application Administration Guide.

How to Browse Scripts

Inthe Tasks area, select a task and click the Browse Script = button. The Browse Script dialog box opens.
If an mdrv log file exists, it is selected automatically. For details on log files, see "Log Files" on page 110.

Note: This button is disabled for all WebTraces and for scripts for which there is no Last Run Status
data.

How to Run a Task (Script or WebTrace)

In the Tasks area:

1. Select atask and click the Run Task & button. The Run Script dialog box opens showing details of the
run.

2. Inthe Log level field, select a log level (Disabled, Brief, or Extended) to determine the extent of the
information logged to the output for the script run. For details about log levels, see "Setting a Log Level"
on the previous page above.

3. Enter additional command line parameters.

Enter a timeout value, in minutes. This value determines how long BPM attempts to retrieve the page
component data before timing out. The default timeout value is 15 minutes.

5. Click Run.

Note: These settings are applicable only to this run of the script. The task run data is not sent to APM.
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The task run does not affect the run unit’s regular scheduling in BPM, or the run of any other run unit in
BPM.

Ul Description

« "General Information Monitor" below

« "Schedule List Area" below

« "Monitoring Status Area" on the next page

« "Tasks Area" on the next page

« "Tasks Included in the Business Transaction Flow and its Parent Application’s Run Unit Area" on page 77
« "Script Properties Window" on page 78

« "WebTrace Properties Window" on page 80

« "Run Script Dialog Box" on page 81

« "Browse Script Dialog Box" on page 81

General Information Monitor

This area enables you to view general information about the business transaction flow.

User interface elements are described below:

Ul Element Description

Display The name of the business transaction flow as configured in EUM Administration in APM.
name
Status The current status of the business transaction flow in APM—active or inactive.

Note: A message is displayed if the business transaction flow is active, but its parent
application is inactive.

Schedule List Area

This area enables you to view the schedules configured for the business transaction flow.
User interface elements are described below:
Ul Element Description

Schedule The schedule for running the business transaction flow on this BPM instance, as configured
Description in EUM Administration. If the business transaction flow has multiple schedules, all
schedules are shown. (For more information, see "Run Unit Schedules" on page 118.)

Time Zone The time zone to use for the BPM instance, as configured in EUM Administration.

HPE Business Process Monitor (9.40) Page 74 of 196



Business Process Monitor Administration Guide
Chapter 8: Business Transaction Flows

Ul Element Description

Start Offset The start offset, which specifies the delay between the business transaction flow schedule
time and the actual run time. (For information on how the start offset is calculated, see "Start
Offset" on page 118.)

Source The schedule source. Valid options are:

« Own Schedule. The business transaction flow has its own schedule and is therefore an
independent run unit (that is, it is not included in its parent application’s run unit).

« Application Schedule. The business transaction flow is included in its parent
application’s run unit and uses its parent application’s schedule.

Monitoring Status Area

This area enables you to view the general status and configuration of the business transaction flow.

Note: This area appears only for business transaction flows that have their own schedule and therefore,
their own run unit.

User interface elements are described below:

Ul Element Description

Number of The number of tasks included in the business transaction flow run unit.

tasks

Status The current status of the business transaction flow run unit. Valid options are:
« Not initialized — The run unit has not yet been initialized.
o Currently running — The run unit is currently running on this BPM instance.
« lIdle —The run unit is not currently running on this BPM instance.

Last start The start time of the last run.

time

Last run The duration of the last run.

duration

Run mode The run mode configured for the business transaction flow. For details on run modes, see
"Run Modes" on page 119.

Tasks Area

This area enables you to view the tasks configured for the business transaction flow and to run them.
Note: This areais displayed only for business transaction flows that have their own schedule and

therefore, their own run unit. For details on business transaction flows that use their parent application’s
schedule, see "Tasks Included in the Business Transaction Flow and its Parent Application’s Run Unit
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Area" on page 77.
User interface elements are described below:

Ul Element Description

Task Properties. Opens a new window showing the script or WebTrace properties. For
details, see "Script Properties Window" on page 78 and "WebTrace Properties Window" on
page 80.

Browse Script. Displays the BPM script folder in a new window. (If an mdrv log file exists,

it is selected automatically.) For details on log files, see "Log Files" on page 110.

Note: This element is disabled for all WebTraces and for scripts for which there is no Last
Run Status data.

=3 Run Task. Runs a selected task. Details of the run are reported in a new window. For details
on the reports, see Business Process Monitor Task Reports.

When you run a script, the Run Script dialog box opens, where you can set the log level
(Disabled, Brief, or Extended) to determine the extent of the information logged to the output
for the script run, and add additional command line parameters. Note that these changes are
applicable only to this run of the script.

The task run data is not sent to APM.

The task run does not affect the run unit’s regular scheduling in BPM, or the run of any other
run unit in BPM.

Run Order The orderin which the tasks are run. This is determined by the run mode configured for the
business transaction flow in EUM Administration. For details on run modes, see "Run
Modes" on page 119.

Name The task name, as configured in EUM Administration.
Type The type of task—Script, WebTrace, or Single URL.

Last Run The status of the last run. Valid options are:

Status « Finished properly — The task finished running with no errors.

« Finished (errors occurred) — The task finished running; however, there may be some
errors in the task reports (for example, the traceroute server may report "progress
aborted" for a WebTrace request). Check the relevant log files for further information on
the errors encountered. For details on the log files, see "Log Files" on page 110.

« Failed to start — The task failed to start running.

« Terminated unexpectedly — The task failed during the run.

« Error: Aborted — The task was aborted.

« Aborted (timeout) — The task timed-out and stopped running.

« End status is not set — The task has not run yet, therefore no end status is available.

« Not supported by OS — The task’s protocol is not supported by the operating system.
« n/a—Run status is not applicable for the task, for example, if the application is inactive.
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Ul Element Description

Last Run
Time

Status

The time of the last run.

The current status of the task. Valid options are:
« Not initialized — The task has not yet been initialized.
« Running —The task is currently running on this BPM instance.

« ldle —The task is not currently running on this instance.

Tasks Included in the Business Transaction
Flow and its Parent Application’s Run Unit

Area

This area enables you to view the scripts and WebTraces configured for the business transaction flow, as
well as the scripts and WebTraces configured for the business transaction flow’s parent application. You can
also run a script or WebTrace.

Note: This area is displayed only for business transaction flows that are included in their parent
application’s run unit (that is, business transaction flows that do not have their own schedule).

User interface elements are described below:

Ul Element Description

Task Properties. Opens a new window showing the script or WebTrace properties. For
details, see "Script Properties Window" on the next page and "WebTrace Properties
Window" on page 80.

Browse Script. Displays the BPM script folder in a new window. (If an mdrv log file exists,
it is selected automatically.) For details on log files, see "Log Files" on page 110.

Note: This element is disabled for all WebTraces and for scripts for which there is no Last
Run Status data.

Run Task. Runs a selected task. Details of the run are reported in a new window. For details
on task reports, see Business Process Monitor Task Reports.

When you run a script, the Invoke Script dialog box opens, where you can set the log level
for the script run and add additional command line parameters. For details on setting log
levels, see "Setting a Log Level" on page 72. Note that these changes are only applicable to
this run of the script.

Note:

o Thetask run datais not sent to APM.

« Thetask run does not affect the run unit’s regular scheduling in BPM, or the run of any
other run unit in BPM.
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Ul Element Description

Included
in Selected
BTF

Run Order

Name
Type
BTF

Status

Last Run
Status

Last Run
Time

A check mark denotes that the script or WebTrace is included in the selected business
transaction flow and not in its parent application.

The order in which the tasks are run. This is determined by the run mode configured for the
business transaction flow’s parent application in End User Management Administration. For
details on run modes,see "Run Modes" on page 119.

The task name, as configured in EUM Administration.
The type of task—Script, WebTrace, or Single URL.
The name of the BTF in which the script or WebTrace is included.

The current status of the task. Valid options are:
« Not initialized — The task has not yet been initialized.
« Running - The task is currently running on this BPM instance.
« lIdle—Thetask is not currently running on this BPM instance.

The status of the last run. Valid options are:

» Finished properly — The task finished running with no errors.

« Finished (errors occurred) — The task finished running; however, there may be some
errors in the task reports (for example, the traceroute server may report "progress
aborted" for a WebTrace request). Check the relevant log files for further information on
the errors encountered. For details on the log files, see "Log Files" on page 110.

« Failed to start— The task failed to start running.

« Terminated unexpectedly — The task failed during the run.

« Error: Aborted — The task was aborted.

o Aborted (timeout) — The task timed-out and stopped running.

« End status is not set — The task has not run yet, therefore no end status is available.
« Not supported by OS — The task’s protocol is not supported by the operating system.

« n/a—Run status is not applicable for the task, for example, if the application is inactive.

The time of the last run.

Script Properties Window

This window displays general details about a script and its included transactions.

To access the Script Properties window for a selected script, click the Task Properties button in the
Tasks area or Tasks Included in the Business Transaction Flow and its Parent Application’s Run Unit Area.

Note: You can edit the following string-value script parameters in APM:
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o File Parameter
o Custom Parameter

All other script parameters are marked as Read Only can only be edited in VuGen or TruClient.
User interface elements are described below:

Ul Element Description

General Information

Name The script name, as configured in EUM Administration.
Script The version of the script used.

Repository

Version

Last Run The status of the last run. Valid options are:

Status

« Finished properly — The task finished running with no errors.

« Finished (errors occurred) — The task finished running; however, there may be some
errors in the task reports. Check the mdrv.log file for further information on the errors
encountered.

« Failed to start — The task failed to start running.

« Terminated unexpectedly — The task failed during the run.

« Error: Aborted — The task was aborted.

« Aborted (timeout) — The task timed-out and stopped running.

« End status is not set — The task has not run yet, therefore no end status is available.
« Not supported by OS — The task’s protocol is not supported by the operating system.
« n/a—Run status is not applicable for the task, for example, if the application is

inactive.
Last Run The time of the last run.
Time
Last Run The duration of the last run.
Duration

Transactions—lists the transactions included in the script and displays the following data for

them:

Name The transaction name as used in the script.

Original The original transaction name.

Name Note: If you change the name of a Business Transaction Cl in EUM Administration, the
transaction name in existing scripts is not changed. Elsewhere, however, (for example, in
Service Health, reports, and EUM Administration) the transaction name is changed and
persistent data for the Cl is preserved.

OK The response time threshold below which the transaction’s status is OK, as configured in

EUM Administration.
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Ul Element Description

Minor The response time thresholds between which the transaction’s status is Minor, as
configured in EUM Administration.

Critical The response time threshold above which the transaction’s status is Critical, as
configured in EUM Administration.

Outlier The response time threshold above which the transaction is considered to be an Outlier, as
configured in EUM Administration. Outliers are transactions whose response time
exceeds a defined time range.

Availability The availability threshold configured for the transaction in EUM Administration.
Parameters—lists the parameters used in the script and displays the following data for them:
Name The parameter name.

Value The parameter value.

WebTrace Properties Window

This window displays general details about a WebTrace.

To access the WebTrace Properties window for a selected WebTrace, click the Task Properties button
in the Tasks area or Tasks Included in the Business Transaction Flow and its Parent Application’s Run Unit
Area.

User interface elements are described below:

Ul Element Description
URL The URL accessed by the WebTrace.
Port The port for the URL accessed by the WebTrace.

Last Run The status of the last run. Valid options are:

Status « Finished properly — The task finished running with no errors.

« Finished (errors occurred) — The task finished running; however, there may be some
errors in the task reports (for example, the traceroute server may report "progress
aborted" for a WebTrace request). Check the relevant WebTrace log files for further
information on the errors encountered. For details on log files, see "Log Files" on page
110.

« Failed to start — The task failed to start running.

« Terminated unexpectedly — The task failed during the run.

o Error: Aborted — The task was aborted.

« Aborted (timeout) — The task timed-out and stopped running.

« End status is not set— The task has not run yet, therefore no end status is available.

« n/a—Run status is not applicable for the task, for example, if the application is inactive.
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Ul Element Description

Last Run The time of the last run.
Time

Last Run The duration of the last run.
Duration

Note: On Linux, BPM WebTrace requires CAP_NET_RAW capability or an Effective UID of 0.

Run Script Dialog Box

When you run a script, the Run Script dialog box opens, where you can set the log level for the script run and
add additional command line parameters.

For details on setting log levels, see "How to Configure Log Files Logging Level" on page 109.

Note: The task run datais not sent to APM. The task run does not affect the run unit’s regular scheduling
in BPM, or the run of any other run unit in BPM.

Browse Script Dialog Box

The Browse Script dialog box displays the script log file (in case of error during last run then mdrv log file) for
the last run of the task. For details on log files, see "Log Files" on page 110.

Note: This element is disabled for all WebTraces and for scripts for which there is no Last Run Status
data.
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The BPM Admin Business Transaction page enables you to view details of a transaction included in business
transaction flow’s script, as configured in EUM Administration, to which an instance is assigned.

To access
To access the Business Transaction page:

1. Open BPM Admin. For details, see "How to Access BPM Admin" on page 28.

2. Select a business transaction in the BPM Tree that appears in the left pane of the BPM Admin console.
For details about the BPM Tree, see "BPM Entities" on page 34.

Task

How to Configure Business Transactions in EUM Admin

For details on configuring applications in EUM Administration, see "Business Process Monitor Application
Configuration Wizard" in the APM Application Administration Guide.

When you configure transactions in a script or in EUM Administration, the names of transactions:

« Must be entered in the same language that is set for the operating system on which BPM is installed.
« Must contain only characters that are supported by the operating system on which BPM is installed.

Ul Description

General Information Area
This area enables you to view general information about the transaction.

User interface elements are described below:

Ul Element Description

Display name The name of the transaction as configured in EUM Administration in APM.
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Thresholds Area

This area enables you to view the thresholds configured for the transaction. For details on configuring
transaction thresholds in EUM Administration, see "Business Transaction Business Process Monitor
Configuration Page" in the APM Application Administration Guide.

User interface elements are described below:

Ul Element Description

OK

Minor

Critical

Outlier

The response time threshold below which the transaction’s status is OK, as configured in
EUM Administration.

The response time thresholds between which the transaction’s status is Minor, as
configured in EUM Administration.

The response time threshold above which the transaction’s status is Critical, as configured
in EUM Administration.

The response time threshold above which the transaction is considered to be an Outlier, as
configured in EUM Administration. Outliers are transactions whose response time exceeds a
defined time range.

Availability The availability threshold configured for the transaction in EUM Administration.

Script Area

This area enables you to view the transaction name used in the script, as well as the scripts in which the
transaction is included.

User interface elements are described below:

Ul Element Description

Name in
script

Included
in scripts

The name of the transaction as used in the script.

Note: If you change the name of a Business Transaction Cl in EUM Administration, the
transaction name in existing scripts is not changed. Elsewhere, however, (for example, in
Service Health, reports, and EUM Administration) the transaction name is changed and
persistent data for the Cl is preserved.

The scripts in which the transaction is included, within the same business transaction flow.

HPE Business Process Monitor (9.40) Page 83 of 196



Chapter 10: Page Component
Breakdown Reports

The Page Component Breakdown (PCBD) report displays a breakdown of transaction response times (in
milliseconds) for each component of a web page. You use the report to analyze network, server, and client
health in real time. It can help you identify:

« Problematic elements of a web page for web based transactions (for example, images that download
slowly, or broken links) .

« Problematic TCP activity for non-web based (TCP) transactions (for example, failed connections to the
server).

« Where along the network problems are occurring (for example, during DNS Resolution, or during Time to
First Buffer).

Web based transactions consist of web components; TCP based transactions consist of TCP requests.

For scripts set to collect component breakdown data, BPM measures response time for each specific
transaction in the script, and collects breakdown data—information about client, network, and server activity
during the transaction—for each component of every web page accessed in web based transactions, and for
each component (request) in non-web based (TCP) transactions. This information enables you to assess
whether transaction response times were affected. For example, in web based transactions, a page content
may affect response times; in non-web based transactions, request size or the number of requests may affect
response times.

Note:

« Component breakdown is supported only for certain HPE Virtual User Generator protocols.
« Fornon-web (TCP) based protocols, the page name has no relevance in breakdown reports.

« The PCBD on-demand report is currently not supported in IPv6 environments. This is due to the fact
that LoadRunner cannot currently provide the PCDB breakdown in IPv6 networks. For details of
suggested protocols that are supported for IPv6, refer to the |Pv6 Support page in the LoadRunner
Help Center (https://admhelp.microfocus.com/Ir/en/12.53/help/WebHelp/Content/VuGen/c_IPv6_
Support.htm).

Learn About

« "Understanding Web Based Transaction Breakdown Reports" on the next page
« "Understanding Non-Web Based TCP Transaction Breakdown Reports" on page 89

« "Calculating Transaction Breakdown from Component Breakdown" on page 94
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Tasks

How to Run a Page Component Breakdown Report
You can run a Page Component Breakdown report by performing one of the following tasks:

« Invoking scripts from the Tasks area of the Business Transaction Flow page. For details, see "Tasks
Included in the Business Transaction Flow and its Parent Application’s Run Unit Area" on page 77.

Note: When invoking scripts, page component breakdown data is shown only if the script was
recorded using one of the configured protocols.

« Performing an on-demand page component breakdown of any web page using the Run Page Component
Breakdown action on the Host page. For details, see "How to Run the Run Page Component Breakdown
Option" below below.

How to Run the Run Page Component Breakdown Option

The Run Page Component Breakdown option enables you to run an on-demand page component breakdown
(PCBD) request for any web page. BPM measures response time while running the request, and collects
breakdown data for each component of the accessed web page. This information enables you to assess
whether the response time was affected by page content. The data collected is reported only to BPM Admin
(not to APM).

When you select this option, the Run Page Component Breakdown dialog box opens. User interface
elements are described "Run Page Component Breakdown Dialog Box" on page 97.

Ul Description

« "Transaction Report" on page 94

« "Run Page Component Breakdown Dialog Box" on page 97
« "Invoke Script Dialog Box" on page 98

« "Summary Report" on page 98

Understanding Web Based Transaction
Breakdown Reports

The web based protocols for which BPM can perform transaction breakdown are configured in the
BdSupportedProtocols setting in the agent1.cfg file on the BPM machine. For details on the agent1.cfg
file, see "Agent1 Directory"” on page 109. If a script for which BPM is configured to collect transaction
breakdown data contains multiple protocols, and one of the protocols is a web based protocol configured in
the BdSupportedProtocols configuration setting, web based breakdown is used.

Note:
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« Transaction breakdown is not supported by BPMs running scripts recorded in WinINet mode in HPE
Virtual User Generator.

« Page component breakdown does not function for streaming objects, such as Java Applets, sounds,
and movies. This is because the engine that runs the page component breakdown uses technology
that handles only components that can be parsed directly from the HTML code (for example, images).

This section includes the following topics:

« "Understanding Transaction Breakdown Categories" below

« "Understanding Download Time" on page 88

Understanding Transaction Breakdown Categories

The transaction breakdown component in PCBD reports displays a breakdown of average transaction
response times (in milliseconds) over time, for the selected time frame. Response times are broken down by
retry time, DNS resolution time, connection time, network time to first buffer, server time to first buffer,
download time, and client time. If your site uses SSL authentication, SSL handshaking time is also displayed.

The main transaction breakdown components are as follows:

Timetofirst buffer

SSL . .
. Net timeto Server time
“ hant(ij:qheake first buffer tofirst buffer

Time to first buffer

SSL . .
DNS Connection handshake N.Et fime to Se.rver time Retry time Du“."nluad
time first buffer to first buffer time

Download
time

Retry time
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The diagram below illustrates in more detail the relationship between the component’s main breakdown
categories (shown along the bottom of the diagram) and client/server activity during transaction execution.
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Note: Retry time, SSL handshaking time, and client time are not shown in this diagram. They are
described in the breakdown category table. For details, see "DNS Resolution" in the table below.

The following table describes the component’s breakdown categories. Times are calculated by taking the
average of all transaction runs within the specified time period.

Name Description

Retry Time Displays the overall amount of time that passes from the moment an http request is started
until the moment an http or TCP error message is returned. Retry time only relates to http or
TCP errors that execute a retry after the error.

DNS Displays the average amount of time needed to resolve the DNS name to an IP address,
Resolution ' using the closest DNS server. The DNS Lookup measurement is a good indicator of slow
DNS resolution or other problems with the DNS server.
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Name Description

Connect Displays the average amount of time needed to establish an initial connection with the web
Time server performing the transaction. The connection measurement is a good indicator of
problems along the network or whether the server is responsive to requests.

SSL Displays the average amount of time taken to establish an SSL connection (includes the
Handshake ' client hello, server hello, client public key transfer, server certificate transfer, and other—
Time partially optional—stages). After this point, all the communication between the client and

serveris encrypted.

Note: The SSL handshaking measurement is applicable only for https communications.

Network Displays the average amount of time that passes from the moment the first http request is
Time to sent until receipt of ACK. The network measurement is a good indicator of network quality
First (look at the time/size ratio to calculate download rate).

Buffer

Server Displays the average amount of time that passes from the receipt of ACK of the initial http
Time to request (usually GET) until the first buffer is successfully received back from the web server.
First Server Time to First Buffer is a good indicator of web server delay.

Buffer

Note: Because server time to first buffer is being measured from the client, network time
may influence this measurement if there is a change in network performance from the time
the initial http request is sent until the time the first buffer is sent.

Download ' Displays the time from the receipt of the first buffer until the last byte arrives.

Time Download time is a combination of server and network time, since the server typically sends

data over multiple connections, and therefore is usually working while data is being
transmitted over the network. For more details, see "Understanding Download Time" below
below.

Client Displays the average amount of time that passes while a request is delayed on the client

Time machine. Client-related delays can include browser think time, CPU think time, HTML page
processing time, time needed to open sockets, application delays caused by heavy applets,
and soon.

Note: Client time is calculated by subtracting all other measured times from the total
transaction time.

Note: In certain circumstances, for example, when the BPM is using a proxy server, the transaction
breakdown mechanism cannot differentiate between server time to first buffer and network time to first
buffer. In these cases, the report displays the time between initial http request and receipt of first buffer
as Time to First Buffer.

Understanding Download Time

When a BPM running a script communicates with a web server (specified by the URLSs in the script),
communication is carried out, by default, over four connections simultaneously.

As the web page is retrieved, its various components (images, applets, and so on) travel in data packets from
server to client across these multiple connections.
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As aresult, at any point along the time line after the server sends the first buffer until the client receives the
last byte for the page, data packets may be traveling over the network through some of the connections while
others are being processed by the server through the remaining connections. The download time in the report
represents the sum total of the time when network resources and server resources are in use at the same
time, between the time the client receives the first buffer and the last byte.

Understanding Non-Web Based TCP
Transaction Breakdown Reports

The non-web based (TCP) protocols for which BPM can perform transaction breakdown are configured in the
AdvancedTcpBdSupportedProtocols setting in the agent1.cfg file on the BPM machine. For details on the
agent1.cfg file, see "Parameters in agent1.cfg" on page 162. If a script for which BPM is configured to collect
transaction breakdown data contains multiple protocols, and none of the web protocols is configured in the
BdSupportedProtocols configuration setting, and at least one of the TCP protocols is defined in the
AdvancedTcpBdSupportedProtocols configuration setting, TCP breakdown is used.

Note:

« Non-web based (TCP) transaction breakdown is supported on Windows only.
« Supported protocols must be TCP request/response based protocols.
« Non-web based (TCP) transaction breakdown cannot be used with VuGen Speed Simulation.

This section includes the following topics:

« "Understanding How APM Breaks Down Transaction Response Times" below

« "Understanding Transaction Breakdown Categories for Non-Web Based (TCP) Transactions" below

« "Understanding Time to First Buffer and Download Time for Non-Web Based (TCP) Transactions" on
page 92

« "Understanding Breakdown Report Data for Non-Web Based (TCP) Transactions" on page 92

« "Notes and Limitations for Non-Web Based (TCP) Protocols" on page 92

Understanding How APM Breaks Down Transaction Response Times

When APM runs a BPM script and measures response time for a specific transaction, APM collects
breakdown data—information about TCP activities during the transaction—for each request (component) of
the transaction. A TCP request (component) represents a sequence of measurements starting with a DNS
resolution, TCP Connect operation, or a Send operation on an open connection and ending with the last
Receive operation for the relevant starting operation.

Because some TCP based protocols can use multiple connections, at any given moment in time there can be
an overlap in the various breakdown categories.

Understanding Transaction Breakdown Categories for Non-Web Based (TCP)
Transactions

The transaction breakdown reports display a breakdown of average transaction response times (in
milliseconds) over time, for the selected time frame. Response times are broken down by DNS resolution
time, connection time, time to first buffer, download time, and client time.
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The diagram below illustrates the relationship between the report’s main breakdown categories (shown along
the bottom of the diagram) and TCP client/server activity during transaction execution. In the diagram, there

are two sequential TCP requests included in the same connection.

Note that client time is not shown in this diagram and is described in the breakdown category table. For

details, see "Client Time" in the table below.
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The following table describes the report’s breakdown categories, which comprise a TCP request. Times are
calculated by taking the average of all transaction runs within the specified time period.

Name

DNS
Resolution

HPE Business Process Monitor (9.40)

Description

Displays the average amount of time needed to resolve the DNS name to an IP address,
using the closest DNS server. The DNS Lookup measurement is a good indicator of slow
DNS resolution or other problems with the DNS server.

Note: If the DNS resolution is adjacent to a Connect for the same IP address, it is
considered part of the request (component) and its time is displayed in the breakdown
reports. Otherwise, the DNS resolutions of one or more hosts without an adjacent Connect
are considered as a separate request (component). In such cases, only the DNS Resolution
time is displayed for that request and for all other measurements, a minus sign (-) is
displayed.
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Name

Connect
Time

Time to
First
Buffer

Network
Time to
First
Buffer

Server
Time to
First
Buffer

Download
Time

Client
Time

Description

Displays the average amount of time needed to establish an initial connection with the TCP
server performing the transaction. The connection measurement is a good indicator of
problems along the network or whether the server is responsive to requests.

Note: If a connection did not occur within a request’s (component’s) context, a minus sign (-)
is displayed for the connection time in the breakdown reports.

Displays the average amount of time that passes from the first TCP Send up to and including
the first Receive of a component. This measurement includes both network time and server
time that are required for handling the first TCP buffer. It is a good indicator of both network
quality and server delay.

Note: This measurement is shown only if both Sends and Receives are included in the
request (component). If there are no Sends or Receives within a request (component), a
minus sign (-) appears in the breakdown reports.

Displays the time from the first Send up to and including the last Send. This measurement is
a good indicator of network quality.

Note: This measurement is shown only if there are Sends included in the request
(component), but no Receives. If there are no Sends or Receives within a request
(component), a minus sign (-) is displayed in the breakdown reports.

Displays the average amount of time that passes from the receipt of ACK of the initial http
request (usually GET) until the first buffer is successfully received back from the web server.
The server time to first buffer measurement is a good indicator of web server delay.

Note: Because server time to first buffer is being measured from the client, network time
may influence this measurement if there is a change in network performance from the time
the initial http request is sent until the time the first buffer is sent.

This measurement is shown only if there are Sends included in the request (component), but
no Receives. A minus sign (-) is displayed in the breakdown reports.

Displays the time from the receipt of the second TCP buffer up to and including receipt of the
last byte.

Download time usually only includes network time and is influenced by both network quality
and component size.

For more details, see "Understanding Time to First Buffer and Download Time for Non-Web
Based (TCP) Transactions" on the next page below.

Note: If a download did not occur within a request’s (component’s) context, a minus sign (=)
is displayed for the download time in the breakdown reports.

Displays the average amount of time that passes while a request is delayed on the client
machine. Client-related delays can include CPU think time, processing time, time needed to
open sockets, time between the last Receive of a request and the first Send of the next
request in the same connection, and so on.

Note: Client time is calculated by subtracting all other measured times from the total
transaction time.
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Note: Either Time to First Buffer or Network Time to First Buffer and Server Time to First Buffer are
displayed.

Understanding Time to First Buffer and Download Time for Non-Web Based (TCP)
Transactions

Time to First Buffer includes both network time (for sending the packet) and server time (for processing the
packet), whereas Download time usually includes only network time (for downloading the rest of the reply
packets). This means that if both Time to First Buffer and Download times increase, it is a good indicator of
network quality problems and if only Time to First Buffer increases, it is usually a good indicator of server
delay problems.

Understanding Breakdown Report Data for Non-Web Based (TCP) Transactions

The same breakdown reports are used to display web based breakdown data and non-web based (TCP)
breakdown data, but the following differences apply when viewing non-web based (TCP) breakdown data:

« The Page column (which displays page names for web based transactions) is not applicable for non-web
based transactions and a minus sign (-) is displayed in this column for all non-web based components.

« The Retry Time and SSL Handshake Time columns are not applicable for non-web based transactions
and a minus sign (-) is displayed in these columns for all non-web based components.

« Inthe Component/Request column (which displays URLs for web based breakdown data), the name of
the TCP request (component) is displayed. The name can be one of the following:

« TCP_BdwnDns<nnn>. For DNS only components (for example, a DNS component that does not
have an adjacent Connect component correlated to the same IP address). The number in the display is
sequentially incremented for each component entry. For such entries, only the DNS Resolution time is
displayed and for all other measurements, a minus sign (-) is displayed.

« TCP_BdwnReg<nnn>. For TCP request components. The number in the display is sequentially
incremented for each component entry.

« Fornon-web based (TCP) components, there is no tooltip available for the Page column.
« You cannot click a non-web based (TCP) component to drill down to further information about it.

Notes and Limitations for Non-Web Based (TCP) Protocols

The following table lists the TCP protocols for which breakdown data can be displayed, together with special
notes and limitations where applicable:

Protocol Notes and Limitations

SAP GUI Multi-threaded protocol.

The BPM Agent must run in Process mode. Service mode is not supported.

SMTP N/A
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Protocol

POP3

IMAP

Oracle 2-Tier

ODBC
FTP
LDAP

EJB

RMI Java

Java
Record/Replay

Notes and Limitations

The communication in a POP3 script usually starts with a server’s greeting message.
Consequently, the first TCP breakdown component (request) in the script is usually
reported with valid DNS and Connect times, whereas the Download time is reported as 0
and all other time measurements are not applicable and are shown with a minus (-) sign
in the reports.

The communication in an IMAP script usually starts with a server’s greeting message.
Consequently, the first TCP breakdown component (request) in the script is usually
reported with valid DNS and Connect times, whereas the Download time is reported as 0
and all other measurements are not applicable and are shown with a minus (-) sign in the
reports.

Some of the steps in an Oracle 2-Tier script end with data being sent by the client,
without receiving any response. Consequently, there are TCP breakdown components
reported with a Network Time to First Buffer value >= 0 and with all other measurements
not applicable and shown with a minus (-) sign in the reports.

N/A
Both FTP passive and FTP active modes are supported.

The last step in an LDAP script (which terminates the connection to the server) usually
ends with data being sent by the client, without receiving any response. Consequently,
there is a corresponding TCP breakdown component reported with a Network Time to
First Buffer value >= 0 and with all other measurements not applicable and shown with a
minus (=) sign in the reports.

Multi-threaded protocol.

« Multi-threaded protocol.
« Both RMI over IIOP and RMI over JRMP are supported.

« Some Java applications which use the RMI protocol send many ping requests
between application-driven RMI calls. Consequently, the TCP breakdown reports
many components with a small Time to First Buffer value and with a Download size
of approximately 1 byte.

« The last step in an RMI script (which terminates the connection to the server)
sometimes ends with data being sent by the client, without receiving any response.
Consequently, there is a corresponding TCP breakdown component reported with a
Network Time to First Buffer value >= 0 and with all other measurements not
applicable and shown with a minus (=) sign in the reports.

« A protocol which supports and combines the following Java protocols—RMI, CORBA,
JMS, JACADA, and Custom Hooks. TCP breakdown is supported only when the
script is recorded using RMI protocol calls. If the script includes other protocol calls,
TCP breakdown results are not defined.

« Multi-threaded protocol.
« Both RMI over I[IOP and RMI over JRMP are supported.

« Some Java applications which use the RMI protocol send many ping requests
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Protocol Notes and Limitations

between application-driven RMI calls. Consequently, the TCP breakdown reports
many components with a small Time to First Buffer value and with a Download size
of approximately 1 byte.

« Thelast step in a Java Record/Replay script (which terminates the connection to the
server) sometimes ends with data being sent by the client, without receiving any
response. Consequently, there is a corresponding TCP breakdown component
reported with a Network Time to First Buffer value >= 0 and with all other
measurements not applicable and shown with a minus (-) sign in the reports.

Java Vuser Supports RMI Java
Oracle NCA If the script works over http communications, you can run it using web breakdown (which
is the default).

If the protocol is run using TCP socket communications instead of http, web breakdown
is not applicable and you can run it using TCP breakdown instead, providing that:

« The script is recorded in such a way so that the Active Types with which the script is
recorded are Oracle NCA only (that is, the script does not include WEB (http/html)).

« You move the Oracle NCA protocol from the BdSupportedProtocols list to the
AdvancedTcpBdSupportedProtocols list in the agent1.cfg file on the BPM
machine.

Calculating Transaction Breakdown from
Component Breakdown

APM uses a weighted algorithm to display the breakdown data that it collects. Every breakdown category for
every element of the connection requests is taken into consideration, and weight is given to the element
according to its value relative to the other elements in the concurrent time period. For example, the Connect
time for each request in the connection is collected, weighted, and then displayed under the Connect time
category.

Transaction Report

Note: This section is applicable for web based transactions. For the differences in breakdown reports for
non-web based (TCP) transactions, see "Understanding Breakdown Report Data for Non-\Web Based
(TCP) Transactions" on page 92.

The Transaction reports included in the Page Component Breakdown report enable you to assess whether
transaction response times and service availability are being affected by page content. There is a separate
report for each transaction included in the script and you display the report for a specific transaction by
selecting the transaction in the Context pane.

The report displays general data about the transaction run, summary response time breakdown data for all of
the components in the transaction, transaction response time breakdown data for each component in the
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transaction, and error data. For details of the breakdown categories, see "Understanding Transaction
Breakdown Categories" on page 86.
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The Transaction reports included in the Page Component Breakdown report include the following areas:

"General Information Area" below

"Transaction Breakdown Data Area" on the next page
"Transaction Response Time Breakdown Area" on the next page
"Errors Area" on page 97

General Information Area

User interface elements are described below:

Ul Element Description

Name The transaction name.

Note: For on-demand component breakdown, there is one default transaction called PCBD
transaction.
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Ul Element Description

Status The status of the transaction run. Valid statuses are:

« Pending. The transaction is waiting to run.
« Passed. The transaction ran successfully.
« Failed. The transaction did not run successfully.

« No data arrived. The transaction ran successfully, but no data was received or the script
containing the transaction did not run.

« Timeout. BPM was unable to retrieve page component data within the configured
timeout period.

Transaction Breakdown Data Area

User interface elements are described below:

Ul Element Description

Breakdown ' The transaction breakdown category name. For details of the breakdown categories, see
Parameter | "Understanding Transaction Breakdown Categories" on page 86.

Summary | The weighted time, in milliseconds, of all the components included in the transaction, for the
breakdown category. For details on weighting, see "Understanding How APM Breaks Down
Transaction Response Times" on page 89.

Transaction Response Time Breakdown Area

User interface elements are described below:

Ul Element Description
<Legend> Describes the color coding used in the report.

Page The URLs of the web pages accessed in the transaction.
Tooltip: Hold the cursor over the name of a page to show the full name.

Note: Click the plus (+) sign to expand a page and display its components.

Component The URLs of the components included in an accessed web page.
Tooltip: Hold the cursor over the name of a component to show the full name.

Note: If the parent web page is not expanded to display its components, this column
displays the total number of components included in the page.

Size (KB) The total size, in kilobytes, of the page or component.

Total Time @ The total time of the component, in milliseconds.
(ms)

Error If applicable, an error message related to the specific component.
Message
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Ul Element Description

Breakdown = A bar that shows the total component time in milliseconds. The color-coded segments
enable you to differentiate between the various breakdown categories for the component,
with each colored segment representing the total time for its corresponding measurement.
For example, you can view the overall DNS time for the component. (For explanations of the
breakdown categories, see "Understanding Transaction Breakdown Categories" on page
86.)

Tooltip:

« Hold the cursor over a colored segment to view the breakdown category name and the
total time for that category.

« Hold the cursor over the white space to the left of a component's colored bar to show a
tooltip with the offset time for that component. The offset time for a specific component
is the time that passes from the start time of the first component on the page until the
start time of the specific component.

Note: Gaps in time between components (time between one component finishing and the
next one starting) represent processing time—client-side delays caused by browser think
time, CPU think time, HTML page processing time, time needed to open sockets or threads,
and so forth.

Errors Area

User interface elements are described below:

Ul Element Description

Error ID The error ID number

File Name The name of the file in which the error occurred.

Error Line The line number in the file on which the error occurred.

Error Message The error message.

Run Page Component Breakdown Dialog Box

Ul Element Description

Address The address for the target web page. This may be:

o The name of a server on the local network
« A web address
« The full URL for the page, for example: http://www.hpe.com/

Authentication If the destination requires authentication, type the name of a recognized user.
user name
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Ul Element Description

Authentication The password for the authentication user name (or leave empty if the URL requires a
password blank password).

Timeout A timeout value, in minutes. This value determines how long BPM attempts to retrieve
the page component data before timing out.

Default value: 15 minutes

Run Click to run the page component breakdown. The Invoke PCBD window opens,
displaying the page component breakdown report.

Invoke Script Dialog Box

The Page Component Breakdown report is displayed in the Invoke Script dialog box, which is divided into the
following two panes:

« The Context (left) pane. Displays the different reports that comprise the Page Component Breakdown
report. These include a summary report for the entire script and individual reports for each transaction
included in the script.

Note: When you run an on-demand page component breakdown for a web page, a default transaction
called PCBD transaction is created for the report.

« The main (right) pane. Displays the content for the report selected in the Context pane—the summary,
or a specific transaction.

Summary Report

Note: This section is applicable for web based transactions. For the differences in breakdown reports for
non-web based (TCP) transactions, see "Understanding Breakdown Report Data for Non-\Web Based
(TCP) Transactions" on page 92.

The summary of the Page Component Breakdown report includes general information about the script run, the
run status of the transactions included in the script, and aggregated component data for each of the
transactions included in the script.

Click thumbnail to view full size image:

HPE Business Process Monitor (9.40) Page 98 of 196



Business Process Monitor Administration Guide
Chapter 10: Page Component Breakdown Reports

Run Page Component Breakdown on VM 145

Cardert Summairy
Summary o
PCED tranzaction General information |
HName:  hitp-ifeeew b com
WVergion: nia
Statuz:  Fineshed
Puin Statis {=]
Stage P Status
PCED franss=tian [¥]
H Download Time B Teeto First Buffer Server Time 1o Firgt Buffer
Metwaork Time to First Bufer 351 Handzhaking Time Connection Time
MW DN Time M Retry Time
' Name: [ope—
| PCBO transaction [ ] S
Mota- Completed fransactions wil not be reportad 1o Buainess Service Management
The summary of the Page Component Breakdown report includes the following areas:
o "General Information Area" below
« "Run Status Area" on the next page
« "Transaction Breakdown Data Area" on the next page
General Information Area
User interface elements are described below:
Ul Element Description
Name The name of the invoked script, or for on-demand page component breakdown, the name of

the accessed web page.

Version The script version number.

Note: This is not relevant for on-demand page component breakdown.

Status The status of the script run. Valid statuses are:

« Running
» Finished
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Run Status Area

This area contains a line for each transaction included in the script, or for on-demand component breakdown,
one line for the default transaction.

User interface elements are described below:

Ul Element Description
Stage The transaction name.
Run Status = The run status of the transaction. Valid options are:

. O Pending. The transaction is waiting to run.
« U passed. The transaction ran successfully.
« @ Failed. The transaction did not run successfully.

« © No data arrived. The transaction ran successfully, but no data was received or the
script containing the transaction did not run.

« £\ Timeout. BPM was unable to retrieve page component data within the configured
timeout period.

Note: The default timeout is 15 minutes. When you run an on-demand page component
breakdown you can configure the timeout value.

Transaction Breakdown Data Area

This area contains a line for each transaction included in the script, showing aggregated transaction
breakdown data for all the components in the transaction.

User interface elements are described below:

Ul Element Description
<Legend> A legend describing the color coding used in the report.
Name The transaction name.

Breakdown | A bar that shows the total transaction time in milliseconds. The color-coded segments
enable you to differentiate between the various breakdown categories for the transaction,
with each colored segment representing the total time for its corresponding measurement.
For example, you can view the overall DNS time for the transaction. (For explanations of the
breakdown categories, see "Understanding Transaction Breakdown Categories" on page
86.)

Tooltip: Hold the cursor over a colored segment to view the breakdown category name and
the total time for that category.

Tip: You can correlate the breakdown summary data with transaction response time
information to assess whether poor transaction response times are being caused by DNS
resolution or connection problems, network latency or server delay, or client delay.
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Chapter 11: WebTrace Reports

WebTrace is a network diagnostics tool that provides traceroute information to a specified destination.
WebTrace records the route through the Internet from your host machine to the destination web server.

The WebTrace report provides information on network performance, which helps you analyze application
performance issues. For each destination, the WebTrace report breaks down route time from the host
machine to the destination machine.

Note:

« If you receive error webtrace_send_probe failed, confirm that Windows update KB3033929 has
been installed on your machine. You need to restart the machine after installing this update.

« There are known issues using WebTrace Reports with LoadRunner 12.50 on Linux based platforms.
Toresolve these issues, set the DefaultProtocol to icmp. For details, see "How to Change the
Communication Protocol Used by WebTrace" on the next page.

Click thumbnail to view full size image:

Run WebTrace

End time: 28M0/200917:19:43
Reachable: Yes

Destination name:  www.hp.com
Destination 1P: T4.747.7474
Source [P: 29.28.2929

Round trip time: 218

Retries: 2

Mumber of hops: 25

Hop Name Hop IP Hop Reachable Hop Retries Found Trip Time
- 144144 44 44 Yes 0 0 =
212199249 77 static.... | 214 19927777 Yes 0 0 _
core-1 ptsusita-wl22.... | 2141993939 Yes 0 0 =
- - Mo 2 0
EDGE.LONO2-RE1-=... | 80.809.805.80 Yes 0 78
- 562.629.6258.62 Yes 0 78 -

Learn About

Communication Protocols That Support WebTrace
BPM supports WebTrace over TCP, UDP, and ICMP. By default, it is set to use TCP. For details on
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changing the protocol, see "How to Run a WebTrace to a Destination Website" below below.

Maximum Number of Hops When Using WebTrace

BPM is set to access a maximum of 30 hops when using WebTrace to reach a site. If 30 hops are not enough
to reach the site, it is reported as unreachable. For details on changing the maximum number of hops, see
"How to Change the Maximum Number of Hops for WebTrace" on the next page below.

Run WebTrace Option

The Run WebTrace option enables you to run a WebTrace to a destination website and view the resulting
report. The WebTrace report provides information on network performance, which helps you analyze
application performance issues.

The data collected is reported only to BPM Admin (not to APM).
To run this option, see "How to Run a WebTrace to a Destination Website" below below.
Note: BPM cannot run WebTrace concurrently for more than 40 addresses, including both configured and

on demand WebTraces. For details, see "How to Change the Communication Protocol Used by
WebTrace" below.

Tasks

How to Run a WebTrace to a Destination Website
1. Inthe BPM Tree, select a host entity.

2. Click the Run 2 button and select Run WebTrace. The Run WebTrace dialog box opens. For details,
see "Run WebTrace Dialog Box (to a Destination Website)" on the next page below.

How to Run WebTrace Reports
Use one of the following:

« Select Application page > Monitoring Status area. Select a WebTrace and click the Run Task P
button.

« Select Business Transaction Flow page > Tasks area (or Tasks Included... area). Select a WebTrace
and click the Run Task 3 button.

« Select a host in the Business Process Monitor tree, click the Run 2 button, and then click the Run
WebTrace =2 button.

In the Run WebTrace dialog box, enter the destination address, port number, and timeout and then click Run.
For details, see "Run WebTrace Dialog Box (to Run WebTrace Reports)" on page 104 below.

How to Change the Communication Protocol Used by WebTrace
1. Onthe BPM machine, open the <BPM application directory>/config/agent1.cfg file in a text editor.

Note: For Windows Server 2008 R2, Windows Server 2012 R2, and Windows 7, copy the file to the
user temp directory (%temp%), edit it there, and then copy it back to the original directory.
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2. Look for:

[WEBTrace]

;5 Options are: tcp (default), icmp, udp
DefaultProtocol=tcp

55 Only IPv4 is supported
ProtocolVersion=IPv4

3. Change the value for DefaultProtocol to the required protocol.

4. Save your changes.
5. Restart BPM for the change to take effect.

How to Change the Maximum Number of Hops for WebTrace

1.

On the BPM machine, in a text editor, open the webtrace.ini file located in:
Windows: C:\HP\LoadGenerator\dat

Note: For Windows Server 2008 and Windows 7, you must copy the file to the user temp directory
(%temp%), edit it there, and then copy it back to the original directory.

Linux: /opt/HP/HP_LoadGenerator/dat
Look for:

[Request]
DefaultMaxTTL=30

Change the value for DefaultMaxTTL to the required number of hops.
Save your changes.
Restart BPM for the change to take effect.

Ul Description

Run WebTrace Dialog Box (to a Destination Website)

User interface elements are described below:

Ul Element Description

WebTrace The destination web address. Do not include the string http:// or https:// when
address typing the server address. For example: www.hpe.com

Port The port to access the web address. If BPM is accessing the Internet through a

proxy server, or if the destination address requires access via https, specify
port 443.

Default value: 80
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Ul Element Description

Timeout A timeout value, in minutes. This value determines how long Business Process
Monitor attempts to access the web address before timing out.
Default value: 15 minutes

Run Click to run the WebTrace. The Run WebTrace window opens, displaying the

WebTrace report.

Run WebTrace Dialog Box (to Run WebTrace Reports)

. General WebTrace Information Area

User interface elements are described below:

Ul Element Description

End time The time that the WebTrace finished.

Reachable Whether it was possible to reach the destination address.

Destination = The destination web address.

name

Destination = The IP address of the destination machine.

IP

Source IP The IP address of the BPM host machine.

Round trip  The time it takes, in milliseconds, for a packet of data to be sent from the host machine

time to the destination website.

Retries The number of times a data packet tries, but fails, to reach its destination due to
timeout, network difficulty, and so forth.

Number of = The number of intermediate servers the data packet encounters before it reaches its

hops destination.

. Hop Information Table

User interface elements are described below:

Ul Element Description

Hop Name The name of the intermediate server.

Hop IP The IP address of the intermediate server.

Hop Whether it was possible to reach the specific hop.

Reachable

Hop The number of times a data packet tries, but fails, to reach an intermediate server due to
Retries timeout, network difficulty, and so forth.
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Ul Element Description

Round The time, in milliseconds, from the source to the specific hop and back.
Trip Time
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The workspace directory consists of log files and other files that relate to BPM operations. The log files
document event information and errors for BPM and its instances. For information on the contents of the log
files, see "Log Files" on page 110.

The BPM workspace directory includes the following three sub-directories:

« agent1. Includes all the BPM instance data (applications, scripts, and so forth). For details, see "Agent1
Directory" on page 109.

« archive. Includes all the archive directories. For details, see "File Archiving" on page 111.
« logs. Includes all the BPM log files. For details, see "Log Files" on page 110.

By default, the workspace directory is located in the <BPM application directory>. To change the workspace
directory location, see "How to Change the Workspace Directory Location" below below.

Learn About

« "Agent1 Directory" on page 109
+ "Log Files" on page 110

« "Log Entry Format" on page 111
« "File Archiving" on page 111

« "File System Management" on page 114

Tasks

How to Change the Workspace Directory Location

Note: If you relocate the workspace to a network drive, you must carry out additional steps as described
in "How to Enable Access to Windows Mapped Network Resources Within a Script" on page 186.

1. Stop BPM.

2. Inthe <BPM installation directory>/BPM/yajsw/conf/wrapper.conffile, configure the parameter -
Dbpm.workspace to point to the new workspace location.

3. Open the following file under <BPM installation directory>/BPM/ServiletContainer/bin:
« Windows: catalina.bat

« Linux: catalina.sh

Configure the parameter -Dbpm.workspace to point to the new workspace location.

5. Inthe file <BPM application directory>/BPM/config/topaz_agent_ctrl.cfg, configure the Workspace
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property (under the General section) to point to the new workspace location.
6. Start BPM.

How to Move Workspace Logs

To move the workspace logs to another location, change the workspace directory location. For details, see
"How to Change the Workspace Directory Location" on the previous page above.

How to Browse the Workspace Directory
The Browse Workspace option enables you to view the files stored in the workspace directory.

To browse the workspace directory, in the BPM Admin console select a host, click the Browse button and
select Browse Workspace. The Browse Workspace dialog box opens in a new window, comprising the
following areas:

« Left pane. Displays a hierarchical tree of the folders, subfolder, and files included in the Workspace
directory (the root entry in the tree).

« Right pane. Displays the contents of the file you select in the tree in the left pane. If the selected file is
empty, the right pane also remains empty.

Note:
« You cannot edit the files from BPM Admin, only view the file contents.
« Use CTRL+F to find a specific string in afile.

« Ifyourlog files contains non-English data, you must open them in a viewer that supports UTF-8
format parsing, for example, Notepad.

How to Configure Log Files Replacement Frequency

By default, the replacement frequency for log files is set to daily (except for the bpm_all.log file, which is set
to hourly).

To change the log file replacement frequency:
1. Openthe <BPM installation directory>/ServietContainer/lib/log4j2.xml file.

2. Locate the section for the specific log (search for the log name).

3. To configure the frequency unit (day, hour, or minute), change the frequency date pattern in the
filePattern parameter inside the RollingFile tag, as follows:

Frequency unit filePattern parameter
Day %d{yyyy-MM-dd}

Hour %d{yyyy-MM-dd_HH}
Minute %d{yyyy-MM-dd_HH:mm}

4. To configure the number of units, change the interval parameter inside the
TimeBasedTriggeringPolicy tag, where interval="1" means that the log files are replaced once
every frequency unit, interval="2" means that log files are replaced once every two frequency units,
and so on.

In the following example, the bpm_communication.log file is set to a daily frequency:
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<V - - HHHHEHEHEHE BpmCommunicationAppender #it#tH A -->
<RollingFile name="BpmCommunicationAppender" fileName="${sys:bpm.workspace}/logs/bpm_
communication.log" filePattern="${sys:bpm.workspace}/archive/shortTerm/logs/communication/bpm_
communication_%d{yyyy-MM-dd} %i.log">
<PatternLayout>
<pattern>%d{dd/MM/yyyy HH:mm:ss} %-5p [%t] [%c{1}] %m%n</pattern>
</PatternLayout>
<Policies>
<OnStartupTriggeringPolicy />
<TimeBasedTriggeringPolicy interval="1" modulate="true"/>
<SizeBasedTriggeringPolicy size="5 MB"/>
</Policies>
<DefaultRolloverStrategy max="50"/>
</RollingFile>

In the following example, the bpm_communication.log file is set to a frequency of once every three hours:

<U-- st BpmCommunicationAppender ##HH#H##H#H#######HHHHHHHHHHHHHHHHEE - ->
<RollingFile name="BpmCommunicationAppender"” fileName="${sys:bpm.workspace}/logs/bpm_
communication.log" filePattern="${sys:bpm.workspace}/archive/shortTerm/logs/communication/bpm_
communication_%d{yyyy-MM-dd_HH} %i.log">
<PatternLayout>
<pattern>%d{dd/MM/yyyy HH:mm:ss} %-5p [%t] [%c{1}] %m%n</pattern>
</PatternLayout>
<Policies>
<OnStartupTriggeringPolicy />
<TimeBasedTriggeringPolicy interval="3" modulate="true"/>
<SizeBasedTriggeringPolicy size="5 MB"/>
</Policies>
<DefaultRolloverStrategy max="50"/>
</RollingFile>

In the following example, the bpm_communication.log file is set to a frequency of once every two minutes:

< V- - HHHHE t## BpmCommunicationAppender #it#t###H#HH#H to-->
<RollingFile name="BpmCommunicationAppender" fileName="${sys:bpm.workspace}/logs/bpm_
communication.log" filePattern="${sys:bpm.workspace}/archive/shortTerm/logs/communication/bpm_
communication_%d{yyyy-MM-dd_HH:mm} %i.log">
<PatternLayout>
<pattern>%d{dd/MM/yyyy HH:mm:ss} %-5p [%t] [%c{1}] %m%n</pattern>
</PatternLayout>
<Policies>
<OnStartupTriggeringPolicy />
<TimeBasedTriggeringPolicy interval="2" modulate="true"/>
<SizeBasedTriggeringPolicy size="5 MB"/>
</Policies>
<DefaultRolloverStrategy max="50"/>
</RollingFile>

How to Configure the Log Files Replacement Pattern Based on Size

Change the size parameter inside SizeBasedTriggeringPolicy tag. The size can be specified in bytes (KB,
MB or GB).

1. Openthe <BPM installation directory>/ServietContainer/lib/log4j2.xml file.
2. Locate the section for the specific log.
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3. Change the size parameter inside the SizeBasedTriggeringPolicy tag.
In the following example, log files are rotated upon reaching 100 bytes:

<Policies>
<OnStartupTriggeringPolicy />
<TimeBasedTriggeringPolicy interval="2" modulate="true"/>
<SizeBasedTriggeringPolicy size="100"/>
</Policies>

In the following example, log files are rotated upon reaching 5 MB:

<Policies>
<OnStartupTriggeringPolicy />
<TimeBasedTriggeringPolicy interval="2" modulate="true"/>
<SizeBasedTriggeringPolicy size="5 MB"/>
</Policies>

How to Configure Log Files Logging Level
By default, the logging level for log files is set to Info.
To change the log files logging level:
1. Openthe <BPM installation directory>/ServletContainer/lib/log4j2.xml file.

2. Locate the section for the specific log and find the appender name for the log.

In the following example, the appender name for the bpm_communication.log is
BpmCommuncationAppender.

< - - it BpmCommunicationAppender ###t# i HHHHHHHEHH S - ->
<appender name="BpmCommunicationAppender"
class="org.apache.log4j.rolling.RollingFileAppender">
<param name="File" value="${bpm.workspace}/logs/bpm_communication.log"/>

3. Inthe Loggers definitions section, change the level value to the required log level in all the logger
sections for the selected appender name (there can be multiple logger sections for the same appender
name). In the following example, the level value for one of the BpomCommunicationAppender logger
sections is set to info:

<logger name="com.hp.bsm.bpm.communication" additivity="true">
<level value="info" />
<appender-ref ref="BpmCommunicationAppender" />
</logger>

Note: If you change the log level to debug, you must also change the replacement frequency to
hourly to avoid the log files growing too big.

Agent1 Directory

The Agent1 directory contains a sub directory for each APM instance. The name of the sub directory is SiteX,
with X representing an internal instance number automatically assigned by BPM.
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Each SiteX directory contains an application directory for each application in the instance. The application
directory name comprises the first 12 characters of the application name (if the application name is shorter
than 12 characters, it is padded with underscores), an underscore, the APM internal application ID, an
underscore, and a counter. For example: MyApplicatio AB567687697890C 2.

Each application directory contains a script directory for each script configured for the application. The script
directory name comprises the first 12 characters of the script name (or less if the name is shorter than 12
characters). For example: MyScript.

Each script directory contains a sub directory that contains the script content. The directory name comprises
the internal script ID, an underscore, and a counter. For example: 25_1.

Log Files

By default, log files are stored in the <BPM application directory>/workspace/logs directory. The following
are the log files used by BPM:

« bpm_all.log. Holds all log entries from all the other logs, except for entries from the bpm_
communication_layer.log.

« bpm_archive.log. Holds all log entries relevant to the archive mechanism.

« bpm_audit.log. Hold the log entries relevant to instance creation, updates, deletion, and for sample
purging.
o bpm_bsm_comm.log. Holds all the log entries of the communication between BPM and APM.

o bpm_communication.log. Currently always empty (future use is for BPM WebServices communication
log entries).

« bpm_communication_layer.log. Holds all the log entries of the communication between BPM and APM
produced by the lower level communication layer.

« bpm_configuration.log. Holds all log entries relevant to the BPM configuration mechanism.
« bpm_model.log. Holds all the log entries produced by the BPM instances and jobs model.
« bpm_sample_sender.log. Holds all the log entries produced by the BPM samples mechanism.
« bpm_scheduling.log. Holds all the log entries produced by the BPM scheduling mechanism.
« bpm_servlets.log. Currently always empty (future use is for BPM servlets activities),
« bpm_tasks_execution.log. Holds all the log entries produced by the Run-Unit execution mechanism,
« cluster. Currently not supported:
o bpm_cluster.log

o bpm_cluster_communication.log
o bpm_cluster_scheduling.log
o bpm_cluster_serviets.log

- <BPM installation directory>/installation/logs/bpm_install.log. Holds post-installation logs.

« <BPM application directory>/BPM/Tomcat/logs/catalina.<current date>.log. Holds the BPM’s web
server log entries.

« <BPM installation directory>BPM/yajsw/log/bpm_nanny.log. Holds all the BPM service log entries.
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By default, the bpm_all.log file is replaced automatically once an hour, or upon reaching 10 MB capacity. All
the other log files are replaced automatically once a day, or upon reaching 5 MB capacity. The default values

for each log can be edited in the <BPM installation directory>/ServletContainer/lib/log4j2.xml file. When
alogfileis replaced, it is sent to the short term archive. For details, see "File Archiving" below below.

Note: By default, log files include data from automatic transactions. If VuGen is set to create automatic
transactions (Run-Time Settings > General > Replay > Automatic Transactions), and you do not want
these automatic transactions included in the mdrv.log file, in the mdrv.dat file, in the [bpm] section, in
the ExtCmdLine parameter, set MsgClassReportAllTrans to 0.

Log Entry Format

The following are examples of log entries:

29/04/2013 11:01:53 INFO [BpmTaskRunner-46] [GeneralTaskExecutor] Running script: myscript

29/04/2013 11:03:00 ERROR [SampleSenderThread-1] [WtCreateSample9] WebTrace arrived with © hops.
Ignoring.

Each line starts with the date and time, then the level of the message. BPM uses the following log levels for
events:

« Fatal

o Error

« Warning

« Info

« Debug

« Trace

By default, BPM is set to log only entries of level Info and higher (meaning that Debug events are not
included). You can change the default setting (to show a different level and higher) in the <BPM installation
directory>/ServletContainer/lib/log4j2.xml file. For details, see "How to Configure Log Files Logging
Level" on page 109.

File Archiving

The archive manager, which is launched when BPM is started, controls all the archiving activities—adding,
zipping, and deleting archive files. Archiving parameters are configured in the <BPM application
directory>/config/archive.cfg file.

BPM data files are automatically saved in archives when BPM needs to replace them or has finished using
them. There are seven different categories of archives:

« logs. All log files
« input_job. The last application configurations and jobs received from APM.
« model_persistency. Complete application configurations and jobs received from APM.

« samples. Sample data.
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- samples_quarantine. Bad sample data.

« scripts_results. Executed scripts results including transaction data, runtime logs (such as bpm_

mdrv.log and output.log), and snapshot on error files.
« webtraces. Executed WebTraces results.
Each archive category is further subdivided into:

« A short term archive, that stores the files in their original format.

« Alongterm archive, that stores the files in a zipped format.

The BPM data files are automatically copied to the short term archive even if the archive process does not

run. These files will only be processed or deleted when the archive process runs.

For each archive category, you configure a shortTerm, longTerm, and longTermCritical policy. Each policy
determines how long an archive file is kept in the relevant folder. You can select the following time periods:

Format

(n=positive
Parameter Description integer)
HOUR The number of hours to keep the files in the archive. nHOUR
DAY The number of days to keep the files in the archive. n DAY
WEEK The number of weeks to keep the files in the archive. n WEEK
MONTH The number of months to keep the files in the archive. n MONTH
YEAR The number of years to keep the files in the archive. nYEAR
ALWAYS | Files are kept forever. They are not moved or deleted by the archive ALWAYS

process.

SAME_ Files are kept only for the duration of the date they were created and are SAME_DAY
DAY deleted or moved at midnight.
MINIMUM  Files are moved or deleted each time the archive process runs. MINIMUM
NEVER Files are not saved in the relevant archive at all. NEVER

You can also configure the MinimumFreeDiskSpaceThresholdinMB parameter, which determines the
minimum free disk space threshold. If this threshold is breached, all the short term archives are zipped and
moved to the long term archive and the long term archive is managed according to the longTermCritical

policy.

The archive process policy (configured in the [ArchiveProcess] section) determines how often the archive
process runs for each folder. You configure the process policy for each archive folder and can use the time

periods listed below. The default value is 1 HOUR for all archive folders.

Parameter Description
HOUR The number of hours between process runs.

DAY The number of days between process runs.
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(n=positive integer)

n HOUR

n DAY
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Format
Parameter Description (n=positive integer)
WEEK The number of weeks between process runs. n WEEK
MONTH The number of months between process runs. n MONTH
YEAR The number of years between process runs. nYEAR
ALWAYS Run the process each hour. ALWAYS
SAME_DAY  Runthe process each hour. SAME_DAY
MINIMUM Run the process each hour. MINIMUM
NEVER Never run the process (that is, files are never moved or deleted). NEVER

Each time the process runs, it moves or deletes files that are older than the configured policy.

Data files are automatically copied to the Short Term folders as soon as BPM finishes using them, and will
remain there until the archive process runs. If the archive process is configured to run once an hour
(shortTerm=1 HOUR), files less than an hour old will not be deleted or moved; they will be processed the
following time that the archive process runs. This means that the Short Term folders will include files that are
more than an hour old.

To set a policy for the archive process for a specific archive, enter the policy in the following format:
<archive category>_process_<archive type>=<policy>
For example, under the [ArchiveProcess] section, add logs_process.shortTerm=1 HOUR.

The ALWAYS, SAME_DAY ,and MINIMUM values are translated into "run every hour". The NEVER value
means the archive process will never run for the specified category and type.

The archive manager moves log files to the short term archive and replaces them with new log files in the
following cases:

o BPMis restarted.
» The minimum disk space threshold configured in the archive.cfg file has been breached.

« ltis time for the log files to be replaced, as configured in the <BPM installation
directory>/ServietContainer/lib/log4j2.xml file.

When multiple log files are moved to the short term archive, they are renamed with numbered extensions
(log.1, log.2,...) in the order in which they were archived.

Example: If three log files were moved to the short term archive on August 22, 2015, they appear as:
o bpm_all_2015-08-22_1.log
« bpm_all_2015-08-22_2.log
- bpm_all_2015-08-22_3.log.

In the <BPM installation directory>/ServletContainer/lib/log4j2.xml file, you can configure the number of
log files which the short term archive can hold, up to a maximum of 50 log files. When this maximum is
exceeded, the oldest log files are deleted to make room for the new archived log files. You can configure the
maximum for each category of log file separately in the line: <DefaultRolloverStrategy max="50"/>.
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Short term archives are zipped and moved to the long term archive, and the long term archive is managed
according to the longTermCritical policy, in the following cases:

« The BPM machine's free disk space breaches the minimum disk space threshold configured in the
archive.cfq file.

« The archive file's minimum disk space threshold is lower than the BPM machine's minimum disk space
threshold, and the BPM machine's minimum disk space threshold is breached.

Note:

o We recommend that the value of the BPM machine's minimum disk space threshold be less than the
value of the archive file's minimum disk space threshold.

o IfAPMis down and BPM continues to run accumulating samples, BPM can by default accumulate a
maximum of 1000 samples per folder, up to 1000 folders, on the BPM side. All the remaining samples
(grater than 1000 per folder) are accumulated in the Quarantine folders. To process these samples,
you need to manually move them back to the encoded samples folder once APM has been restored.

File System Management

For each APM instance to which a BPM is connected, BPM maintains a data folder that holds all the script run
results before they are processed and turned into samples, as well as all the samples byte array data before it
has been sent to APM.

BPM maintains a specific data folder for each APM instance. This data folder is located in the BPM
workspace directory (for example <BPM workspace directory>\agent1\Site2\data). Within the data folder,
sub-folders are automatically created for each sample type (trans_t, SOA, and WebTrace), as well as a sub-
folder for the samples byte array data that is about to be sent to APM (encoded_samples). In each of these
sub-folders, the results data for each script run is stored either as a further sub-folder or as afile.

When a BPM has a heavy work load and is running many scripts per minute, or when one of the APM
machines to which the BPM is reporting is not available, files will accumulate in the data folder. File system
management enables you to control the maximum number of sub-folders and files, as well as the maximum
sub-folder size under the data folder. This mechanism automatically creates sub-folders and saves files as
they are accumulated, until a configured maximum number of sub-folders/files or a maximum sub-folder size
is reached. When the maximum file number or folder size has been reached, the system cannot copy or
create new script results under the data folder and a warning message is written to the <BPM application
directory>\workspace\logs\bpm_tasks_execution.log file. The system retries the unsuccessful action
after afew seconds, which may eventually cause the BPM to stop running scripts for that instance until space
in the folder is freed up.

You can configure the maximum number of sub-folders or files and the maximum sub-folder size using the
following parameters in the General section of the topaz_data_server.cfg file (for details, see "Parameters in
topaz_data_server.cfg" on page 166):

« MaxFilesNumberUnderDataSubFolder — The maximum number of sub-folders or files that can be
created under a data sub-folder.

Default: 1000
« ApproximateMaxSizeOfDataSubFolderInMB — The maximum permitted sub-folder size.
Default: No limit
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Example
If the maximum number of sub-folders or files is configured as two, the following directory structure can exist:
data

« encoded samples
« temporary sub-folder1 (created automatically)
o file1forascript's run data
o file2 forascript's run data

« temporary sub-folder2 (created automatically)
o file1forascript's run data
o file2fora script's run data

o trans_t
« temporary sub-folder1 (created automatically)
o sub_folder1 for a script's run data
o sub_folder2 for a script's run data

« temporary sub-folder2 (created automatically)
o sub_folder1 for a script's run data

o sub_folder2 for a script's run data

e soOa
« temporary sub-folder1 (created automatically)

o sub_folder1 for a script's run data

o sub_folder2 for a script's run data

« temporary sub-folder2 (created automatically)
o sub_folder1 for a script's run data
o sub_folder2 for a script's run data

« webtrace
« temporary sub-folder1 (created automatically)
o file1foraWebTrace's run data
o file2 fora WebTrace's run data

« temporary sub-folder2 (created automatically)
o file1foraWebTrace's run data
o file2 fora WebTrace's run data
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A run unit is an application, or a business transaction flow, with its own schedule, and all the entities
contained within it. By default, business transaction flows are included in their parent application’s run unit
(using the same schedule and run mode), but you can configure different schedules and run modes for
individual business transaction flows. If a business transaction flow has its own schedule, it is not included in
the application run on the BPM instance, but is run as an independent unit.

Learn About

« "Example - Run Units" below

« "Run Unit Schedules" on page 118
« "Multiple Schedules" on page 118
« "Start Offset" on page 118

« "Run Modes" on page 119

Tasks

« "How to Apply a Start Offset" on page 123
« "How to Create a Schedule" on page 124

« "Optimizing Run Unit Scheduling" on page 1

Ul Description

Instance page status tab
See "Status Tab" on page 55.

Schedule List area
See "Schedule List Area" on page 74.

Example - Run Units

The following diagram shows the run units for a BPM instance that includes two applications. The first
application (Application 1) includes one application level WebTrace and three business transaction flows
(BTF1, BTF2, BTF3). BTF1 includes one script and one WebTrace, BTF2 includes one script and has its own
schedule, and BTF3 contains one script and one WebTrace. Since BTF2 has its own schedule, it is
considered as a separate run unit from the application.
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The second application (Application 2) includes two business transaction flows (BTF4 and BTF5). BTF4 and
BTF5 each include one script, and BTF5 has its own schedule. Since BTF5 has its own schedule, it is
considered as a separate run unit from the application.

Since each application is a separate run unit, there are a total of four run units in the Business Process
Monitor instance—Application 1, BTF2, BTF5, and Application 2.

BPM Data
Collector
Instance

! Schedule | |
I | Application 2 i :
|
I |
I |
| |
I |
| BTF 4 I
| |
| l |
| | Script 4 |
| |
r — === a
: BTF 5 [— Schgdule :
I 1
:" “““““““ == : Script 5 |
|
| |Schedule2— BTF2| | e
| |
| |
: Script 2 : Legend
e ] Run unit 1 — Application 1

Run unit 2 - BTF2

Rununit3-BTF 5

OO0 @

Run unit 4 — Application 2
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Run Unit Schedules

Each run unit (an application or business transaction flow) running on a BPM instance runs according to a
schedule defined in End User Management Administration (for details, see "Business Process Monitor
Administration User Interface" in the APM Application Administration Guide). Each application or business
transaction flow can also have multiple schedules defined for it, as described in "Multiple Schedules" below.

The schedule defines the frequency of iterations of the run unit after its first run. The actual run time of the run
unit is determined by the start offset value configured for it, which specifies the delay between the run unit
schedule time and the run time, as described in "Start Offset" below.

Note that if a run unit run overruns the scheduled time for the next run iteration, then BPM skips the missed
iteration and continues with the next scheduled iteration. For example, if an application schedule is set to run
every 5 minutes, and the application run actually takes 6 minutes, then BPM runs iteration 1, skips iteration 2,
and continues with iteration 3 (10 minutes after the first iteration).

Information on skipped runs is logged in the agent.txt log for the BPM instance.

Note: After changing the clock for daylight saving time, we recommend that you restart the BPM server
to avoid a one hour offset for applications that do not run 24 hours a day.

Multiple Schedules

In EUM Administration, you can define multiple schedules for an application or business transaction flow
running on a specific BPM instance. This enables you to have the application or business transaction flow run
on BPM using different schedules at different times. For example, you can have an application run every 15
minutes during the working week and every hour during weekends.

When a run unit has multiple schedules defined for it, each schedule (and its start offset value) is shown in the
Schedule List area on the corresponding Application or Business Transaction Flow page.

Note: If the multiple schedules for a run unit overlap, then BPM runs the run unit according to both
schedules. If a run unit run (initiated according to one of the schedules) overruns the scheduled time of a
run iteration according to the second schedule, then BPM skips the second iteration, and continues with
the next scheduled iteration. Information on skipped runs is logged in the bpm_tasks_execution.log log
for the BPM instance.

Start Offset

APM enables you to apply an offset to the start time of each run of a run unit (application or business
transaction flow). This enables the optimal distribution of script runs over time, and minimizes the parallel
running of many scripts (when there are different BPM hosts running the same run unit). Staggering the runs
provides a more even distribution of the workload, avoiding overload on the monitored server and excessive
bandwidth demand, and enabling better utilization of machine CPU and memory.

Note: We recommend not to change the default start offset as this may reduce BPM performance and
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adversely affect the optimal distribution of tasks.

The start offset value, displayed in the Schedule List area on the Application or Business Transaction Flow
page, specifies the delay between the run unit schedule time and the actual run time, for each run of the run
unit. The start offset for each application can be calculated automatically by BPM, or can be user-defined; you
determine the method and value when defining the application or business transaction flow schedule. When
the start offset is configured manually, you can avoid the possibility that run units running on more than one
BPM run at the same time.

After the initial run, BPM continues to run the run unit according to the original schedule defined for the
application or business transaction flow (in EUM Administration), and reapplies the start offset for every run of
the run unit.

For example, an application has a start offset value of 120 seconds, and a schedule of every 15 minutes,
every day from 10:00 to 16:00. Each day, the first run of the application begins after the start offset, at 10:02
AM. The next run is 15 minutes later, at 10:17 AM, and repeats every 15 minutes after that till the end of the
day’s schedule.

Note:

« Forschedules that run all day, all week, the start offset is applied from 00:00 AM, so that for a
schedule of 15 minutes and start offset of 120 seconds, the run unit (application or business
transaction flow) runs at 15 minute intervals from 00:02 AM.

« If you define multiple schedules to run an application or business transaction flow on a single BPM, a
different start offset value may be used for each schedule. For more information, see "Multiple
Schedules" on the previous page.

« When you configure offsets for running applications or business transaction flow on BPMs in different
locations, you must take into consideration the time zone setting for each location.

Run Modes

The Monitoring Status area of the Application or business transaction flow page shows the running
dependencies for the scripts and WebTraces in the application or business transaction flow. This identifies
the order that BPM uses when executing each script and WebTrace in the run unit, during each run on the
BPM instance.

The order and timing for running the tasks (scripts and WebTraces) within the run unit are determined by the
application or business transaction flow run mode. The application or business transaction flow run mode
determines how BPM runs the tasks in a run unit when it begins an iteration. Some of the run modes run the
tasks in a specific order according to predefined criteria; in this case, the scripts run in the order defined in the
application or business transaction flow.

Both the run mode and the script order are defined for the application or business transaction flow in EUM
Administration (see "Business Process Monitor Administration User Interface" in the APM Application
Administration Guide).

Note: We recommend to change the default run modes only when specifically needed. Some non-default
run mode configurations can adversely affect BPM performance.

The following run modes are supported and the examples shown are based on the following run unit
configuration:
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Application 1

Application Level WebTraces Business Transaction Flows

WT1 BTF1 BTF2 BTF3

WT2 WT3 WT5 WT6
WT4 Script4 | Script5
Script 1 Script 6
Script 2

Script 3

Classic

All scripts in the run unit run sequentially, according to the order defined in EUM Administration. All WebTrace
schemes in a business transaction flow start running concurrently with the first script of the business
transaction flow. Application level WebTraces start running concurrently with the first script of the first
business transaction flow.

Run Order Example

Each column (from left to right) represents the next stage in the running order.

1 2 3 4 5 6

BTF1 and Application Level WebTraces BTF2 BTF3

Script 1 Script 2 Script 3 Script4 Script5 Script 6
WT1 WT5 WT6

WT2

WT3

WT4

The tasks included in a business transaction flow start running, regardless of whether previously run
WebTraces have finished running. For example, BTF2 (Script 4 and WT5) starts running after Script 3 finishes
running, regardless of whether the WebTraces (WT1-WT4) have finished running.

Dialup

If a run unit has two or more scripts, the first script begins running when the run unit begins an iteration. When
the first script completes its run, all WebTrace schemes and scripts, excluding the first and last scripts, runin
Classic mode. When all tasks stop running, the last script runs. If a run unit has fewer than two scripts, it runs
in Classic mode.

Note:

« If the first script in the run unit (the connect script) does not complete its run successfully, the rest of
the scripts in the unit will not run.
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« If the first script completes its run, the last script always runs.

« An application running in dialup mode must contain a business transaction flow that includes only a
hang up script (that is, it must not include any other scripts or WebTraces). This business transaction
flow must be the last one in the application.

Run Order Example

Each column (from left to right) represents the next stage in the running order.

1 2 3 4 5 6
BTF1 BTF2 BTF3
First Application Script Last Application Script
Script 1 Script2 Script 3 Script4 Script5 @ Script 6
WT1 WT5 WT6
WT2
WT3
WT4
Sequential

All run unit tasks run sequentially (with only one task running at a time). The script tasks run according to the
order defined in EUM Administration. WebTrace tasks run after the last script is completed, with an undefined
(though consistent) order.

Run Order Example

Each column (from left to right) represents the next stage in the running order.

1 2 3 4 5 6 7 8 9 10 11 12

BTF1 BTF2 BTF3 All WebTraces (application and business
transaction flow levels)

Script  Script | Script = Script | Script = Script  WT 1 WT2 WT3 WT4 WT5 WT6
1 2 3 4 5 6

Concurrent

All tasks begin running simultaneously when the run unit begins an iteration. (This is the same as selecting
Stepped run mode and setting the Step value as 0.)

Run Order Example

Each column (from left to right) represents the next stage in the running order.
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1

BTF1
BTF2
BTF3

All WebTraces (application and business transaction flows)
Script 1
Script 2
Script 3
Script 4
Script 5
Script 6
WT1
WT2
WT3
WT4
WT5
WT6

Stepped

Each task begins running after a defined time period (step) has passed from the time the previous task
started. In this case, the Running Dependencies column in the BPM Admin Application or Business
Transaction Flow page displays, forexample: 5 seconds after the beginning of the following
task: X_transaction, meaning that the task runs only after a step of 5 seconds has elapsed since X _
transaction task started running. The scripts run according to the order defined in EUM Administration. All
WebTrace tasks (on both application and business transaction flow levels) also run in stepped mode after the
last script has started, in an undefined (though consistent) order.
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Run Order Example

BTF1

BTF2

BTF2

All WebTraces

Script 1

[step] Script 2

[step] Script 3

[step] Script 4

[step] Script 5

[step] Script &6

[step] WT1

[step] WT2

[step] WT3

[step] WT4

[step] WTS

[step] WT6

How to Apply a Start Offset

There are two methods for staggering the run start time:

User-Defined Start Offset

When defining an application or business transaction flow schedule (in EUM Administration), you have the
option to select User defined for the start offset, and enter a start offset value.

The start offset value is saved as part of the application or business transaction flow schedule data, and
applied by each BPM that handles the run unit. If a BPM is restarted, the same offset value is applied again for
the run unit.

If you define the start offset value as 0, then no offset is applied for the run unit in BPM; the run unit run starts
at the time specified in the application or business transaction flow schedule.
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Note: We recommend not to override the default setting in general, and specifically not to set an offset of
9, as this can impact BPM performance and adversely affect the distribution of script runs.

Start Offset Determined by Business Process Monitor

BPM is able to generate start offset values for run units, so enabling staggered run times for the run units.
Start offset values are allocated to all applications and business transaction flows that have BPM default
defined for their schedule start offset in EUM Administration.

BPM uses a uniform distribution algorithm to calculate the dispersal rate, and to allocate start offset values to
the run units in a balanced manner. The random factor means that when there are two or more BPM instances
running the same application or business transaction flow with the same schedule, each instance runs the run
unit at a different time. (If there was no random factor, each BPM instance would run the run unit at exactly the
same time.) The random factor does not change the order that the applications or business transaction flows
run, and the interval between each run of the run unit on each BPM instance remains constant. For example,
on BPM A an application may run at 10:05, 10:20, 10:35, and on BPM B it may run at 10:10, 10:25, 10:40.

How to Create a Schedule

See "Schedule Dialog Box" in the APM Application Administration Guide.
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This chaptersection describes BPM Real Device Monitoring.

Learn About

« "What is BPM Real Device Monitoring?" below

+ "BPM Real Device Monitoring System Architecture" below
« "Requirements" on page 128

« "Installation" on page 128

« "Configure Mobile Devices" on page 128

« "Recording Scripts" on page 128

« "Deploying Scripts" on page 129

« "Working with Amazon Web Services (AWS)" on page 130
« "Working with a Genymotion Emulator" on page 136

« "BPM Real Device Monitoring Best Practices" on page 136

« "Connecting to Mobile Center over a Secure Connection" on page 136

What is BPM Real Device Monitoring?

BPM Real Device Monitoring displays the availability and performance of mobile applications, installed on
devices in multiple locations.

BPM Real Device Monitoring enables you to record applications on real mobile devices, play the recording
from BPMAppPulse Active, and report the measurements to BPMAppPulse Active.

BPM Real Device Monitoring measures mobile application performance to identify trends over time. This
enables you to identify spikes or sudden changes in performance. Changes in mobile application performance
can be isolated to a specific time, location, carrier, device type, or mobile operating system.

For an evaluation version of BPM Real Device Monitoring, contact mobilehelp@hpe.com.

BPM Real Device Monitoring System Architecture

BPM Real Device Monitoring requires each mobile device to be connected to an Mobile Center connector in
each location from which you want to monitor.
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Note: Mobile Center is also supported on the cloud and Amazon Device Farm. This enables you to run
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automated test scripts against a variety of mobile devices and operating systems on the Amazon Device
Farm to fully test and monitor your mobile and backend application.

Requirements

BPM Real Device Monitoring has the following requirements at each location:

« Windows server with BPM 9.40 and VuGen 12.55

« Dedicated physical server or virtual machine, running Mobile Center (latest supported version is Mobile
Center 2.5).

For Mobile Center requirements, search for "Server requirements" in
https://admhelp.microfocus.com/mobilecenter/en/latest/Content/Resources/ TopNav/_TopNav__
Home.htm.

Note: The server must be connected to the network by a cable and not Wi-Fi.

« Android or iOS mobile devices

For a complete list of supported devices, search for "Supported devices" in
https://admhelp.microfocus.com/mobilecenter/en/latest/Content/Resources/ TopNav/_TopNav__
Home.htm.

Limitation

Mobile Center 2.51 supports BPM 9.40 only.

Installation

Installing BPM Real Device Monitoring involves the following steps:

« Install BPM 9.40, including any relevant patches and hotfixes. For details see the BPM Deployment
Guide.

« Install VuGen 12.55, including any relevant patches and hotfixes. For details see the VuGen
documentation.

« Install and configure Mobile Center server, for details, see
https://admhelp.microfocus.com/mobilecenter/en/latest/Content/Resources/ TopNav/_TopNav_
Home.htm.

Configure Mobile Devices

You need to configure each mobile device connected to the Mobile Center server. For details search for
"Connect devices to Mobile Center" in
https://admhelp.microfocus.com/mobilecenter/en/latest/Content/Resources/_TopNav/_TopNav_Home.htm.

Recording Scripts

Recording a script is done using VuGen TruClient Native Mobile protocol or UFT GUI Test.
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In TruClient, you can create customized parameters when creating a new TruClient Native Mobile script.
In UFT, you need to enable support for Mobile Center:
1. InUFT, open the Test Settings dialog box > Run pane.
2. Under Business Process Monitor, select the following:
« Save image of desktop when error occurs

« Allow test to run on Mobile Center

Note: If you have BSM 9.24 or earlier, use the script template to create new True Client Native protocol
or UFT Mobile scripts. This allows the BSM machine to read the default parameters and record True
Client scripts in 12.52 or earlier.

1. Open the following file:

TruClient: <BPM installation directory>/resources/TruClientNativeMobile_
TemplateForBPM.zip

UFT (12.51 or lower): <BPM installation directory>/resources/UFT_Mobile_TemplateForBPM_
MC_1_5.zip

UFT (12.52 or higher): <BPM installation directory>/resources/UFT_Mobile_
TemplateForBPM.zip

Extract the contents of this file to the Scripts folder on the VuGen or UFT machine.
3. InVuGen or UFT IDE, click Open and select the template.

4. Click Save script as... and give the script a new name.
For details of how to record a TruClient script, search for "Connect TruClient to Mobile Center" in
https://admhelp.microfocus.com/mobilecenter/en/latest/Content/Resources/ TopNav/_TopNav_Home.htm.

For details of how to record a UFT script, search for "Create and run tests in UFT" in
https://admhelp.microfocus.com/mobilecenter/en/latest/Content/Resources/ TopNav/_TopNav_Home.htm.

After Recording the Script
After you have recorded the script do the following:

Delete, edit, and add transactions to the script as required.
Click the play button to test the script.

Once you have made the necessary changes to the script, save the script. If you are using TruClient,
manually close the interface.

4. Export the script to a zip file:

« TruClient: Select File > Manage Zip Files > Export to zip File... > runtime files only.

o UFT: Select File > Export Test.

Deploying Scripts

To deploy a script, you need to upload the script to APM or AppPulse Active, and for each location assign the
BPM Mobile locations and the script parameters.

1. Upload the recorded scripts to APM or AppPulse Active, create an application that will run the scripts,
update the application thresholds, and assign the application to the required BPM Mobile locations.

HPE Business Process Monitor (9.40) Page 129 of 196


https://admhelp.microfocus.com/mobilecenter/en/latest/Content/Resources/_TopNav/_TopNav_Home.htm/
https://admhelp.microfocus.com/mobilecenter/en/latest/Content/Resources/_TopNav/_TopNav_Home.htm/

Business Process Monitor Administration Guide
Chapter 14: BPM Real Device Monitoring

Note: Mobile scripts take longer to run than regular scripts, so you should increase the thresholds.

2. Click to update the script parameters for each location.

Without this step, scripts will run only on the Mobile Center server and on the mobile devices on which
they were recorded.

Working with Amazon Web Services (AWS)

You can use BPM with a Mobile Center installation that is integrated with Amazon Web Services (AWS). This
allows you to run TruClient/UFT scripts on mobile devices sitting on the AWS Device Farm.

Working with Amazon Web Services (AWS)

View availability
and performance (Optional) View
results in the Amazon Job

Record a script
with VuGen on a
local device

In VuGen, update

the script Upload the script

on APM and

configuration fo
test on the AWS
server

schedule to run
on BPM

connected to a
local MC 2.0
Server

Application on the AWS
Health reports in Device Farm
APM

Pre Requisites

« Mobile Center installed on AWS
To run scripts on AWS, you need an Amazon account and need to integrate Mobile Center with the AWS
Device farm. For details, see the Mobile Center documentation
(https://admhelp.microfocus.com/mobilecenter/en/latest/Content/Resources/_TopNav/_TopNav_
Home.htm/Content/AWS%20installation.htm).

« VuGen 12.55 to record a TruClient Native Mobile Script
« BPM9.40

Note: To confirm that VuGen and BPM have access to the MC server, navigate to the MC server URL
directly from the BPM browser machine.

Record Script in TruClient

Record the script with TruClient Native Mobile protocol on a local device connected to a local MC server.

Update Script Parameters

Once you have recorded the script locally, you need to modify the following parameters so that the script can
be replayed in AWS:

1. InVuGen, select File > New Script and Solution > TruClient Native Mobile Protocol.

[yl
2. Click L= lto open the TruClient General Settings dialog box and set the following parameters:

o Server URL Port — Enter the URL of the Mobile Center on the ASW machine, for example:
port - myserver.amazonaws.com:8080
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« User name — The administrator user name to access Mobile Center.

« Password — The password to access Mobile Center.

r N
TruClient General Settings u

Browser Settings Interactive Options Run-Time Settings Mobile Center Settings Server Exceptions

Property

— Server Connection (New script only)
7] Use secured connection

Server URL Port erc2-52-40-124-130. us-west-2_compute. amazonaws.
User name admin@default.com
Password sssssnes

- [0
CPU on device
Free memory on device
Consumed memory on device
- Application
Restart application
- ¥l Install application before execution

[7] Delete application after execution
+ Metwork Virtualization

+ Transactions

Check Connection Export to current script Use Defaults Done

3. Click Develop Script to open the script in TruClient.
4. Inthe TruClient Native Mobile tab, expand the Prepare mobile device section.
5. Under Step, choose Select by > Capabilities.
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(/) TruClient - Native Mobile - AWS

Home

File = T

7
& 5k

Fi & Connectto MC Server hifp:iimyserver. amazonaws .com $080

z = Prepare mobile device

&«

110

i NP at=l Mr' Py
———"oloctDadoc e cohensilitine

B

e

¥ Step
Select by | Capabilities

R

b Arguments

3 = Finalize and launch application

1 = Launch application [Fackage Mame]

&«

Save succeeded

Mobile Center Run Logic Actions Function Libraries

6. Under Arguments, select an OS Type and OS Version, and a Source Lab of Amazon WS.

« OS Type —Android
« OS Version —Enter "Any" or a version greater than 5

« Source Lab—-Amazon WS
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(/) TruClient - Native Mobile - AWS

Home
File = @& @ v Sk
F: = Connectto MC Server hitp:/imyserver amazonaws com:$080 -
X = Prepare mobile device
1 [0 A
= Select Device by capabilities (05: l.l. Wer: Any)
» Step
‘e ™~
* Arguments
(1) OF Type: Android > [~
0S5 Version:  Any =~
Manufacturer: =~
Maodel: Eike
Source Lab:  Amazon WS -
. -
Save succeeded
Mobile Center Run Logic Actions Function Libraries

m

-

Upload the Script to APM and Attach to BPM

Upload the enhanced TC Native Mobile script to APM. The script is added to the application, linked to BPM
as a data collector, and scheduled to run periodically.

You can modify the script in Application Health interface (Application Health > App Settings > Business
Process Monitor).
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ﬁ APPLICATION HEALTH User:admin | [5> ) ?
& Default Client_BAT_App v + Create New App
)  Dashboard General BTFs Scheduling Transactions Web Traces Save
Bl App Overview APPLICATIONACTIVE @D
@ swm
Name Default Client_BAT_App
Ed  Business Process Monitor Description
[Bd  Real User Monitor Time Zone Asia, Calcutta (GMT +05:30) v
License Transaction Unlimited Location v
28 App Settings
ﬁ] DEFAULT PERFORMANCE STATIC THRESHOLDS  (1casured in Seconcs «©
Business Process Monitor
Il oxifbelow 8 Minor if between & - 12 [l cricalitabove | 12
Real User Monitor The default performance threshold to be used f ew fransactions. If the a cation has a static threshol ou can set a different thresh fi
s ﬁ] PERFORMANCE DYNAMIC THRESHOLDS  (Messured using Standard Deviation - the spread from the average) ()
Downtime
@ General Settings
AVAILABILITY THRESHOLDS
Availahilitv transaction fails if it takes lonaer than (secs) VA Availahilitv statis is eritical if less than (%) o0
< >

Once the replay starts on AWS, it connects to the available matching device on the AWS Device Farm, the
application launches and the script is executed successfully.

Play Scriptin AWS

To run the script, use the Generator replay option. <triangle button>

Note: You cannot run the script using Run Logic in TruClient.

View the Application Health Reports in APM
You can view the Application Overview report to view Availability and Performance results of the mobile
application.

View the Amazon Job on the AWS Device Farm

AWS displays the test results against each run.

The test results displays the actual device used to run the application. The device selection on AWS is based
on the capabilities (OS Type /OS version/Manufacturer) entered in the TC script.
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[T AWS -~ Services

= AWS Device Farm Prnﬁ:r AW v Runt & sessions ~
= Automated tests D Remote access
Autorrated runs allow you fo execute bult-in tests or your own scripfs on one or more dewices in parafiel, generating a comprehensive report that includes high-level results, logs,
sereenshols, and performance dala.
°  EEEE o o
Run Test results Test Type Created Total minutes
O O 0 o
f:) & MC-saira firdo... uiautomator 2016-00-09T14:43+0530 ~
c) & MC-saia fndo... usautomator 2016-02-09714 .40+0530
O O (@]
@ #Mcsaiado m uiautomator 2016-00-09T14:34+0530 00-03:38
© sicaaie. h — 2ot ceceTIezn0R 000321
@ #vccainafo Liautomator 2016.00.08T14-22+0530 00-03:21
Q & MC-saira firdo. . uiautomator 2016-09-09T14.16+0530 00.03.32
@ #vcsaimfo Lisutomator 2016.00.08T14-10+0530 00r03-20
o & MC-saira firda... uiautomator 2016-00-09T14:04+0530 00:03:13
Q sncsarafeo ([ EC oo 2016-00.08T13-68+0530 000325

The Test results capture complete information of the Script Run. Click on the results to view the following:

« Details tab — General information about the problem
« Logs section — Any information Device Farm logged during the test

« Screenshots tab — A list of any screenshots Device Farm captured during the run the device, grouped by
suite.

« Performance tab — Information about any performance data Device Farm generated for the device during
the run, for example. CPU utilization of the device or memory utilization of the device.

The details of the device picked up is listed as AWS.
Alternatively you can get the device name and server URL from the BPM Log:

1. Open the latest "Site" folder in the following directory:
<BPM application directory>\workspace\agent1\

2. Open the latest TruClient script folder under the relevant “Site™:
C:\ProgramData\HP\BPM\workspace\agent1\Site<X>\<App Name>\

3. Open the file McRuntime.properties
The device name is listed in the last line of the properties folder, normally starting with AWS.

[= McRuntime.properties E1

1 [Generall

2 MobileServerURL=e02-52-48-1124-130.us-west-2.compute.amazonaws.com: 8080
3 MobileServerUserName=admin@default.com

4 MobileServerUseS5L=false
6

=pHd=3wWulil
DeviceId=AWS-dzbb558b-15ad4-a7fc-801ab071500

[ & I
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Working with a Genymotion Emulator

You can use BPM and Mobile Center with Genymotion to emulate activity on Android operating systems. For
details, see Working with emulators in the Mobile Center help.

BPM Real Device Monitoring Best Practices

Recommended naming conventions in BPM

The location name should contain all the parameters that you want to differentiate in each location. For
example, if you are monitoring different devices and multiple carriers in the same city, you should include the
carrier and device name in the location name. For example LosAngeles_Verizon_GalaxyS4.

Connecting to Mobile Center over a Secure
Connection

Mobile Center allows you to work in secure environments using SSL and to apply certificates when
necessary. If Mobile Center is working in a secure environment, import the SSL certificate to the BPM
machine:

1. Install SSL certificates on the BPM machine. For details, search for “Install SSL certificates” in
https://admhelp.microfocus.com/mobilecenter/en/latest/Content/Resources/_TopNav/_TopNav_
Home.htm.

2. Export the certificate from the browser:

a. Inabrowser, open the Mobile Center site.

b. Inthe address bar, click on the Lock icon and save the certificate to a local drive.
3. Open a Command Prompt and run the following import commands:

cd C:\HP\BPM\JRE\bin

keytool -import -trustcacerts -keystore "C:\HP\BPM\JRE\lib\security\cacerts" -
storepass <passoword> -noprompt -alias mc -file <certificate location>

Example:
keytool -import -trustcacerts -keystore "C:\HP\BPM\JRE\lib\security\cacerts" -
storepass changeit -noprompt -alias mc -file C:\Temp\mcCertificate.cer

Notes:

* The store password should be changed from the default “changeit”

* The location of the java/bin folder is <BPM installation>\JRE\bin

» The location of the MC server certificate is where the customer selected to save it
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Chapter 15: Using Selenium Scripts

Selenium is a tool that automates browser activity. BPM is able to execute Selenium scripts to recreate
common browser activity.

For BPM to run Selenium scripts, the scripts must be created using JUnit4, saved as JAR files, and uploaded
to APM. APM identifies relevant JUnit classes in the uploaded file and converts them to BPM transactions
which can then be used for analysis.

The following diagram summarizes the process of uploading Selenium scripts to APM:

If dependencies
are not wrapped in
the JAR file, copy
them to the
designated library

Optional: Wrap
Wrap the script in other JAR file Upload the JAR
a JAR file dependencies in file to BSM

the JAR file

Create scripts in
Selenium using
JUnit4

If dependencies
are not wrapped in
the JAR file, copy
them to the
designated library

Optional: Wrap
Wrap the script in other JAR file Upload the JAR
a JAR file dependencies in file to BSM

the JAR file

Create scripts in
Selenium using
JUnit4

APM scans the JAR file to identify classes to use to create transactions. If the uploaded JAR file includes a
bpm_script.properties file, BPM identifies JUnit classes to process from this JAR file. If this properties file
does not exist, or does not indicate which suites, classes, or methods to run, APM scans the JAR file to
identify @Suite classes which are used to create transactions. If there are no @Suite classes, APM creates
transactions from all @Test classes (classes with at least one method with annotation @ Test).

@Before and @After methods are not converted to transactions and are not used for analysis.

BPM runs the classes listed in the bpm_script.properties file in the order that they are listed. To run the test
methods in alphabetical order, add the following annotation to the JUnit class:
@FixMethodOrder(MethodSorters. NAME_ASCENDING)

The following diagram summarizes how APM identifies classes to use to create transactions.
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HPE Business Process Monitor (9.40) Page 138 of 196



Business Process Monitor Administration Guide
Chapter 15: Using Selenium Scripts

( Identifying Classes to Process )
Is there a
Dpm_script.properties
file with suites, c - =
P —— properties file
Process classes
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[@Suite classes
= Process 5
Are there @Test identified in the
|asses? i i i
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Best Practices when Working with Selenium

bpm_script.properties File

The bpm_script.properties file is optional, but we recommend that you create this file to control how BPM
processes the JAR file. Place the properties file in the JAR file under the META-INF folder.

If the file does not include all the relevant information, APM will add the required properties.
The bpm_script.properties file defines the following.

« Which suites, classes, or methods will be executed

Note: All suites, classes, and methods that are listed in the bpm_script.properties file will be
executed, included duplications. This means that if you list a class and also a method which is
included in the class, the method will run twice.

« The Selenium driver parameter name to be used in the code injection (used for Snapshot on Error)

« Whether to collect Snapshot on Errorimages
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« System properties that need to be set before the script execution

« Whether to continue processing transactions after a transaction failure

If you do not supply a bpm_script.properties file, APM creates the file as follows:

« Transactions are created from all Test @Suite classes. If there are no @Suite classes, APM creates
transactions from all @Test classes. If the JAR file does not contain any Test classes (a class with at
least one method that has the JUnit4 @ Test annotation), APM will not accept the script.

« Other parameters in the bpm_script.properties file will be set to their default values or left empty if they do

not have a default value.

bpm_script.properties Keys

Default
Key Value
selenium.drivername driver

runinExtractedMode false
testSuiteClasses none
testClasses none
testMethods none

addClassNameToTransactions = true

collectSnapshotOnError true
ContinueOnError false
systemProperties none

HPE Business Process Monitor (9.40)

Represents

The name of the Java parameter used in the code to hold the
Selenium driver object. This parameter is used for Snapshot
On Error.

Boolean parameter that defines whether the JAR file should be
run in extracted mode.

List of JUnit4 test suite class names. When executing the
script, BPM will run all the classes in this list. Multiple items
must be separated by a semi-colon (;).

List of JUnit4 test classes (classes with methods that have the
annotation @ Test) names. BPM will run all the classes in this
list. Multiple items must be separated by a semi-colon (;).

List of JUnit4 test methods (methods that have the annotation
@Test) full names, including the class name. BPM will run all
the methods in this list. Multiple items must be separated by a
semi-colon (;).

Boolean parameter that indicates whether to concatenate the
class name to the transaction name in order to distinguish
between two transactions with the same name but from
different classes.

Boolean parameter that indicates whether to collect and send a
shapshot on errorimage.

Boolean parameter that indicates whether to continue
executing transactions after a transaction failure.

List of system properties that need to be set before the script
runs. Each string includes a key value pair separated by the an
equal sign (=).

For example: tempDir=c:\temp;seleniumExtraJar=sel.jar;
Multiple items must be separated by a semi-colon (;).
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Snapshot on Error

The snapshot on error function requires a driver object. APM looks for the driver name in the
selenium.drivername key in the bpm_script.properties file.

If there is no the bpm_script.properties, or the selenium.drivername key is missing, BSM searches the JAR
file for a Selenium driver object with the name "driver". If there is no object with the name "driver", the
Snapshot on Error function will not work.

Deploying Selenium

When you deploy Selenium you need to install the required browsers on all BPM locations, copy the JAR
dependencies, and configure Windows and the relevant browsers to run Selenium scripts.

Copying JAR Dependencies

1. If the JAR dependencies (including the Selenium JAR dependencies) are inside the JAR file, upload the
JAR file to APM without any further action.

2. Ifthe JAR file does not include the JAR dependencies, copy the dependencies to the following directory
in all BPM locations:

<BPM installation directory>\external\lib

3. Ifthe bpm_script.properties file contains test suites, test classes, is empty, oris not included in the JAR
file, in addition to copying the dependencies to BPM, copy the dependencies to the following directory in
APM:

<APM Installation>\BPM\external\lib
Note: If you use APM in a SaaS environment, you cannot copy the dependencies to the APM

server. The bpm_script.properties file must have only test methods, with no test suites or test
classes as described in step 2 above.

Note: We recommend that you restrict access to the BPM and APM folders above as follows:

« Administrators require read-write-execute access.

« Specific users under which the BPM or APM processes run need read-only access to the JAR
files.

Configuring Windows to run Selenium scripts
1. InWindows, start the “Interactive Services Detection” service:
a. Click the Windows Start button, click Run, enter services.msc, and press ENTER.
b. Inthe list of services, right-click on Interactive Services Detection and select Start.

2. Download the utility PsExec.exe from Microsoft Windows Sysinternals
(https://technet.microsoft.com/en-us/sysinternals/) and save the utility in a local directory.

3. Open a command prompt in the location in which you saved PsExec.exe and run the following
command:

PsExec.exe -s -i @ "<full path to iexplore>\iexplore.exe"
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for example: PsExec.exe -s -i 0 "C:\Program Files (x86)\Internet Explorer\iexplore.exe"

|
On the taskbar, click il
In the Interactive Services Detection window, click View Message.

Interactive Services Detection.

A new desktop opens with a new instance of Internet Explorer.
foa
In Internet Explorer, click ===/ > Internet Options.
In the Internet Options window, on the Connections tab, click LAN settings.
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+

N

.
Internet Opticns | 2 28 |
tzeneral | Security | Privacy | Content | Connections | Programs | Advanced
To set up an Internet connection, didk Setup
Setup.
Dial-up and Virtual Private Network settings
g7& Broadband Connection Add. ..
¢k Remote Access to HP 6.2
Add VPM...
Femove...
Choose Settings if you need to configure a proxy Settings

server for a connection,

Local Area Metwork (LAN) settings

LAM Settings do not apply to dial-up connections.
Choose Settings above for dial-up settings.

I| LAM settings

Ok

|| Cancel

Apply

8. Select Use a proxy server for your LAN, enter the address of the proxy server, and click OK.
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Local Area Network (LAN]) Settings - 25 =

Automatic configuration

Automatic configuration may override manual settings. To ensure the
use of manual settings, disable automatic configuration.

[ Automatically detect settings
|:| Use automatic configuration script

Proxy server

IUse a proxy server for your LAM (These settings will not apply to
dial-up or VPN connections).

Address:  MyProxy.com Port: 30

|| Bypass proxy server for local addresses

QK ] | Cancel |

b -

9. Click Return Now to return to your regular desktop.

Preparing Browsers to Run Selenium Scripts
Install the required browsers on all BPM locations.
2. Tumn off automatic updates on all browsers.

3. If you use Internet Explorer or Chrome, copy the Selenium plug-in and make it available in the PATH
environment variable. For details see www.seleniumhg.org/download

4. Download the utility PsExec.exe from Microsoft Windows Sysinternals
(https://technet.microsoft.com/en-us/sysinternals/) and save the utility in a local directory.

5. Inthe location in which you saved PsExec.exe, open a command prompt and use the following
commands to open the relevant browser:

« Internet Explorer: PsExec.exe -s -i @ "<full path to iexplore>\iexplore.exe"
for example: PsExec.exe -s -i 0 "C:\Program Files (x86)\Internet Exploren\iexplore.exe"

o Firefox:PsExec.exe -s -i @ "<full path to Firefox>\firefox.exe"
for example: PsExec.exe -s -i 0 "C:\Program Files (x86)\Mozilla Firefox\firefox.exe"

o Chrome:PsExec.exe -s -i @ "<full path to Chrome>\chrome.exe"
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for example: PsExec.exe -s -i 0 "C:\Program Files (x86)
\Google\Chrome\Application\chrome.exe"

6. Confirm that the browser is able to access the Internet.
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You can use the BPM REST API to run scripts and web trace in BPM and receive results in JSON format.

Tasks

How to turn on REST API functionality
1. Stop the BPM service.

2. Open the following file in a text editor:
...\BPM\ServletContainer\webapps\ROOT\WEB-INF\web.xml

3. Inthe web-app tag, add the following:

<servlet>
<servlet-name>spring</servlet-name>
<servlet-class>org.springframework.web.servlet.DispatcherServlet</servlet-class>
<load-on-startup>1</load-on-startup>

</servlet>

<servlet-mapping>
<servlet-name>spring</servlet-name>
<url-pattern>/rest/*</url-pattern>

</servlet-mapping>

4. Start the BPM service.

How to Configure the Time Limit for the Requests to the REST API (default is 5
seconds)

1. Stop the BPM service.

2. Open the following file in a text editor:
...\BPM\ServiletContainer\webapps\ROOT\WEB-INF\spring-serviet.xml

3. Modify the value of the requests delay in seconds.
4. Startthe BPM service.

How to Run Requests in the BPM REST API
You can make BPM REST API requests using one of the following methods:
« Run script using the following format:
http://<bpmhost>:2696/rest/invokeScript

For a list of parameters, see "Invoke Script Parameters" on the next page.

« Run a webtrace using the following format:
http://<bpmhost>:2696/rest/invokelWebtrace

For a list of parameters, see "Invoke Webtrace Parametrs" on the next page.
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API| Tables

Invoke Script Parameters

Request name: invokeScript

Parameter

name Type
hostName string
location string
instanceUrl string

applicationName = string
btfName string

scriptName string

timeoutSeconds | string

Invoke Webtrace Parametrs

Use

required
required
required
required
optional

optional

optional

Request name: invokeWebtrace

Parameter name Type Use

address string

timeoutSeconds | string = optional

Examples

Notes

If empty, run all scripts from all BTFs from selected application
If empty, run all scripts under selected BTF/application.

To run several scripts from BTF, separate scripts names with

delimiter

Default value = 900 seconds

Notes

required Host name or IP address and port number (default port is 80)

Default value = 900 seconds

Invoke Script Examples

Invoke script TestScript from BTF TestBTF from application TestApp with timeout of 20 seconds

http://BPM_host:2696/rest/invokeScript?hostName=<host_name>&location=
New-York&instanceUrl=http://BSM_host/topaz&applicationName=TestApp&btfName=
TestBTF&scriptName=TestScript&timeoutSeconds=20
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Invoke scripts TestScript and TCScript from BTF TestBTF from application TestApp with default timeout

http://BPM_host:2696/rest/invokeScript?hostName=<host_name>&location=
New-York&instanceUrl=http://BSM_host/topaz&applicationName=TestApp&btfName=
TestBTF&scriptName=TestScript;TCScript

Invoke all scripts from BTF TestBTF from application TestApp with timeout of 20 seconds

http://BPM_host:2696/rest/invokeScript?hostName=<host name>&location=
New-York&instanceUrl=http://BSM_host/topaz&applicationName=TestApp&btfName=
TestBTF&timeoutSeconds=20

Invoke all scripts from all BTFs from application TestApp

http://BPM _host:2696/rest/invokeScript?hostName=<host name>&location=
New-York&instanceUrl=http://BSM_host/topaz&applicationName=TestApp

Invoke Webtrace Examples

Invoke webtrace with timeout of 20 seconds to port 80
http://BPM_host:2696/rest/invokeWebtrace?address=hpe.com&timeoutSeconds=20

Invoke webtrace with default timeout to port 8080
http://BPM_host:2696/rest/invokeWebtrace?address=hpe.com:8080

Webtrace run JSON output

{ // Field in UI :
"endTime" : 1423152994000,
"destinationName" : null, // Destination name
"destinationIp" : "16.60.159.67", // Destination IP
"sourcelp" : "126.169.60.16", // Source IP
"roundTripTime" : O, // Round trip time
"retriesNumber" : 2, // Retries
"hops" : [ { // hops list
"roundTripTime" : O, // Round Trip Time
"retriesNumber" : 0, // Hop Retries
"name" : "", // Hop Name
"ip" : "0.0.0.0", // Hop IP
"reachable” : false // Hop Reachable
b A
"roundTripTime" : O,
"retriesNumber" : 1,
"name" : "myd-vm@3303.hpswlabs.adapps.hpe.com",
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"ip" : "16.60.159.67",

"reachable"” : true
L
"endTimeStr" : "05/02/2015 18:16:34", // End time
"reachable"” : true, // Reachable
"finished" : true

Output Examples

Script run JSON output:

{
"RozetkaAjaxTruClientFirefox" : { // script name

"profileId" : null,

"taskId" : 0,

"resPath" : null,

"finished" : true,

"transactions" : [ { // transactions list
"endTimeStr" : "©5/02/2015 19:23:00", // tx end time
"duration" : 140, // tx duration in millisec.
"name" : "Logout_ TX", // tx name
"id" : o,

"status" : 9, // tx status
"transErrors" : null, // tx errors

"snapshot" : null,

"pages" : [ 1], // tx pages
"breakdownErrors" : null, // bd errors
"transBreakdownSize" : 90, // transaction bd size
"transBdDnsWeightedTime" : -1, // DNS time
"transBdDnsSummedTime" : 0,

"transBdConnnectionWeightedTime" : O, // Connection time
"transBdConnectionSummedTime" : 0,

"transBdSslWeightedTime" : -1, // SSL Handshaking time
"transBdSs1SummedTime" : O,

"transBdDownloadWeightedTime" : @, // Download time
"transBdDownloadSummedTime" : @,

"transBdRetryWeightedTime" : -1, // Retry time
"transBdRetrySummedTime" : -1,

"transBdNetworkWeightedTime" : -1, // Network Time to First Buffer
"transBdNetworkSummedTime" : -1,

"transBdServerWeightedTime" : -1, // Server Time to First Buffer
"transBdServerSummedTime" : -1,

"transBdFirstBufferWeightedTime" : -1, // Time to First Buffer
"transBdFirstBufferSummedTime" : -1,
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"breakdown" : false
s, A{ //"Login_TX" starts here
"endTimeStr" : "05/02/2015 19:22:36",
"duration" : 9220,
"name" : "Login_TX",
"id" : o,
"status" : 9,
"transErrors" : null,
"snapshot" : null,
"pages" : [ { // first page
"pageId" : 0,
"pageName"
"http://creativecdn.com/rmx/cm?pi=rmx&chain&xid=jjMchVtHWgmwg60gf.Gw8BzB",
"componentBreakdownInvDTOs" : [ { // component breakdowns list
"id" : o,
"name"
"http://creativecdn.com/rmx/cm?pi=rmx&chain&xid=jjMchVtHWgmwg60gf.Gw8BzB",
"ip" : null,
"status" : false,
"startTime" : -2563,
"size" : 195,
"dnsTime" : 0,
"connectionTime" : O,
"sslTime" : -1,
"retryTime" : -1,
"serverTime" : -1,
"networkTime" : -1,
"networkToFirstBufferTime" : -1,
"downloadTime" : -1,
"error" : null
3]
Fo & // second page
"pageIld" : 1,
pageName" : "http://us-
u.openx.net/w/1.0/sd?cc=1&1d=537072974&val=16484766087485651639",
"componentBreakdownInvDTOs" : [ {
"id" : o,
"name" : "http://us-
u.openx.net/w/1.0/sd?cc=1&1d=537072974&val=16484766087485651639",
"ip" : null,
"status" : false,
"startTime" : -2994,
"size" : 328,
"dnsTime" : 0,
"connectionTime" : O,
"sslTime" : -1,
"retryTime" : -1,
"serverTime" : -1,
"networkTime" : -1,
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"networkToFirstBufferTime"
"downloadTime" : -1,
"error" : null

]

—
—

Full application run output

_1,

// first BTF

// first script in btf "tx_fail not_continue"

// second BTF

// first script in btf "RestApiTest"

// second script in btf "RestApiTest"

"RozetkaAjaxTruClientFirefox" : { // third script in btf "RestApiTest"

{

"tx_fail not_continue"” : {

"tx_fail not_continue" : {
"profileId" : null,
"taskId" : 9,
"resPath" : null,
"finished" : true,
"transactions" : [...]

b

T

"RestApiTest" : {

"tx_ok" : {

"profileId" : null,
"taskId" : 9,
"resPath" : null,
"finished" : true,
"transactions" : [...]

})

"tx_fail" : {
"profileId" : null,
"taskId" : o,
"resPath" : null,
"finished" : true,
"transactions" : [...]

})

"profileId" : null,
"taskId" : 0,
"resPath" : null,
"finished" : true,
"transactions" : [...]

¥

¥

}
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Possible Transaction Status

The transaction status could be any of the following:

TRANS_STATUS_PASS = 0;

TRANS_STATUS_FAIL

1;
TRANS_STATUS_TIMEDOUT = 2;

Errors

Errors are displayed in a JSON format:

{
"error" : "error_message"
}
Examples:
{
"error" : "Instance with hostName=bpm_host location=NY siteUrl=http://bsm_
host/topaz was not found."
}
{
"error" : "Application=Appl was not found."
}
{
"error" : "BTF=BTF1 was not found."
}
{
"scriptl" : {
"error" : "Script scriptl was not found."
}
}
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The BPM configuration files define default parameter values that are used for BPM functioning. Some of
these values can be changed within the configuration files, while other parameter values should only be
changed using BPM Admin, or should not be changed at all. Not all of the parameters automatically appear in
the configuration files, but can be added manually if you want to override the default value used by BPM.

To access

The BPM configuration files are located in the <BPM application directory>/config directory.

For details on how to browse the configuration folder, see "How to Browse the Configuration Folder" below
below.

Learn About

« "Parameters intopaz_agent_ctrl.cfg" on page 155

« "Parameters in archive.cfg" on page 158

« "Parameters in agent1.cfg" on page 162

« "Parameters intopaz_data_server.cfg" on page 166
« "Parameters in sconn.cfg" on page 170

« "Parameters in encryption.properties" on page 172
« "Parameters in seed.properties" on page 173

Tasks

How to Browse the Configuration Folder

The Browse Configuration Folder option enables you to view the files stored in the config directory. The
config directory consists of configuration files that contain the options defined for BPM.

When you select the Browse Configuration Folder option, the Browse Configuration Folder dialog box opens
in a new window. For details, see "Browse Configuration Folder Dialog Box" on the next page below.

Note:

« You cannot edit the files from Business Process Monitor Admin, only view the file contents.
« Use CTRL+F to find a specific string in afile.

How to Change Parameter Values Within a Configuration File
1. Stop BPM.
2. Open the configuration file in a text editor.
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3. Modify the value of the parameter, as required.
4. Save the file and restart BPM.

Note: When working on a Windows platform in languages other than English, do not edit and save
configuration files in Notepad. Saving configuration files in UTF-8 format in Notepad may cause severe
functionality problems in BPM.

How to Add or Override HTTP Request Headers

To add or override headers to the http request sent by BPM to APM, you define the parameters HeaderName
and HeaderValue in the sconn.cfg file, as described in "Parameters in sconn.cfg" on page 170.

Note the following guidelines:

« Toadd/change more than one header, use HeaderName?2 for the second name, HeaderName3 for the
third, and so forth. Follow the same principle for the HeaderValue parameter.

« The number of header names must match the number of header values. Otherwise all header names and
values are ignored.

« Thefirst header should be configured with the original parameter names (no index). BPM only reads
additional headers if they are sequentially numbered. For example, if the following information is added to
the sconn.cfg file, only the first two headers are handled. HeaderName4 and HeaderValue4 are ignored:

[Sitel]
AuthDomain=
ProxyPasswd=
ProxyName=""
SSLClientCert=""
SSLHostNameValidate="1"
AuthDelay="0"
ProxyUrl=""
SSLServerCert=""
SSLPVK=""
ProxyDomain=
SSLServerValidate="1"
SSLPVKPasswd=""

nu

un

un

Ul Description

Browse Configuration Folder Dialog Box
The Browse Configuration Folder dialog box comprises the following areas:

« Left pane. Displays a tree of the files included in the config directory (the root entry in the tree).

« Right pane. Displays the contents of the file you select in the tree in the left pane. If the selected file is
empty, the right pane also remains empty.
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Parameters in topaz_agent_ctrl.cfg

The <BPM application directory>/config/topaz_agent_ctrl.cfg file, which controls communication
between the Gateway Server and BPM, contains the following parameters:

Section: HTTPSender

Parameter Description

HTTPSender

TimeoutSec Not supported.

Section: Site#

Parameter

HostName

HostLocation

SiteURL

UserName

JobPoll

Pause
Communication

TimeDelta

Hostld

HPE Business Process Monitor (9.40)

Default Value

The timeout, in seconds, for http requests to APM. | 300 seconds

Description

The name defined for the host
machine. Thisis a logical name
thatis used by BPM for registration
to APM. The default value is the
actual name of the BPM host
machine.

The location defined for the host
machine. This is a logical location
thatis used by BPM for registration
to APM. The default value is the
name of the BPM host machine.

The APM URL.

The name of the user thatisto run
the instance’s transactions, if these
are to be run by a specificuser.

The interval, in minutes, between
requests to APM for job updates.

Instructs BPM to stop
communication to APM. When the
value of this parameter is 0,
communication with APM is
enabled; when the valueis 1,
communication is stopped.

The difference, in milliseconds,
between Gateway Server site time
and BPM time.

The ID allocated by APM for this
specific BPM instance.

Validation Type Can be Changed?

Positive integer

Default Value

<BPM machine
name>

<Business
Process Monitor
machine
location>

<Application
Performance
Management
URL>

2 minutes

0 (no pause)

<time
difference>

<BPM machine
ID>

No

Can be
Changed?

The value can be
changed in BPM
Admin.

You can override
the location using
the Location
Manager in APM.
Once overridden,
this value is
redundant.

The value can be
changed in BPM
Admin.

The value can be
changed in BPM
Admin.

The value can be
changed in BPM
Admin.

Yes

Do not change this
value.

No
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Locationld

Pause

Measurements

SiteVersion

UserPasswd

UserDomain

DisplayName

TimePoll

HostIPFor
Registration

CommandLine
Additions

RetryOnFailure

RetryOnFailureDelay

RetryOnFailureCount

RetryOnFailureSendAdditionalErrorMessage
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Description

The ID allocation by the Location
Manager in APM for this specific
BPM instance.

Instructs BPM to stop running
transactions and WebTrace
schemes. The following two
options are available:

o 0-Nopause

« 1-—Pause

The APM version.

The encrypted password of the
user thatis to run the instance’s
transactions, if these are to be run
by a specific user.

The domain of the user thatis to
run the instance’s transactions, if
these are to be run by a specific
user.

The name of the default instance
displayed in the BPM Admin table
and tree.

The interval, in minutes, between
requests to the Gateway Server to
retrieve APM’s time.

Not supported.

Enables the Retry on Failure
option.

« 1-Retryon Failureis enabled
« 0-Retryon Failure is disabled

Retry on Failure can be applied
per script. For further information
about this feature, see "Retryon
Failure" on page 44 inthe
Business Process Monitor
Administration Guide.

Number of seconds to wait before
retrying after a script failure.

Maximum number of retry
attempts.

Determines whether the failure

Default Value

<BPM machine
location ID>

0 (no pause)

<Application
Performance
Management
version>

60 minutes

<BPM machine
default IP
address>

<BPM machine
default IP
address>

0

30

Can be
Changed?

No

No

No

The value can be
changed in BPM
Admin.

The value can be
changed in BPM
Admin.

The value can be
changed in BPM
Admin.

The value can be
changed in BPM
Admin.

Yes

Yes

Yes

Yes
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Can be
Parameter Description Default Value Changed?

error message should include the
number of attempts.

« 1-Error message includes
number of attempts

o 0-Error message does not
include number of attempts

Section: General

Default Validation Can be

Parameter Description Value Type Changed?
Workspace The directory in which the BPM work files are stored. Not String Yes, see "How
defined to Change the

If you change this value, only some of the log files under the

Workspace directory are moved to the new path (logsin Workspace
. . Directory
commcenter and agent1 directories), not all. o
Location" on
page 106.
SelfURL The BPM URL. Not String No
defined
HostVersion The version of BPM installed on the machine. <BPM String No
version>
BuildNum The BPM build number. Not Positive No
defined integer
BPMProduct The following value is available: Business Process Monitor. Business | String No
Process
Monitor
RegistrationHour The interval at which BPM communicates with APM to re-register = 12 hours = Positive No
Interval itself. integer
TopazAgentHome The file path to the BPM installation. Not String No
defined
ScriptZipRatioLimit Not supported. 30 Positive Yes
integer
ClusterMode Not supported. 0 Boolean Yes
SecureAccess Enable/disable secure access to BPM. For details, see 0 Boolean Yes
"Restricting Access to BPM Admin" on page 181.
The following two options are available:
» 0-—secure accessis disabled
« 1-—secureaccessis enabled
LoadGeneratorHome = The location of the load generator. Not String No
defined
UIMemoryThreshold = The memory threshold of the BPM machine. This parameter 80% Positive Yes
affects the threshold display only; it does not affect the operation integer
of BPM.
UICpuThreshold The CPU threshold of the BPM machine. This parameter affects = 70% Positive Yes
the threshold display only; it does not affect the operation of BPM. integer
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Default Validation Can be
Parameter Description Value Type Changed?
InvocationFolders Defines how long to keep manually invoked scripts before they 60 Positive Yes
Deletelntervalln are deleted. minutes | integer
Minutes
ServerMinimumFree = Defines the minimum free disk space threshold of the BPM 500 MB Positive Yes
DiskSpace server. When this threshold is breached, the BPM server stops integer Minimum
ThresholdinMB running scripts and WebTraces. For details, see "Requirements .
o . allowed value:
and Limitations for Running Tasks" on page 20. 0
We recommend that this value be less than the value of the
MinimumFreeDiskSpaceThresholdInMB parameter in
archive.cfg.
BSMinstances Defines the maximum number of BSM instances that you can 50 Positive Yes.
MaxValue create in BPM Admin. You can enter values between 1and 100.  instances = Integers
between 1
and 100
ServerStartWorking Defines the minimum buffer threshold above the value of the 100MB  Positive Yes
BufferAbove ServerMinimumFreeDiskSpaceThresholdInMB. When this integer Minimum
MinimumThreshold buffer threshold is reached, the BPM server resumes running allowed value:
InMB scripts and WebTraces. For details, see "Requirements and 0 ’
Limitations for Running Tasks" on page 20.
SOTimeout Sets the socket timeout for each socket connection in - Positive Yes
milliseconds. integer
By default, this parameter is not in the file and there is no timeout
for the socket connections.
Section: Agent1
Section Parameter Description Default Value Can be Changed?
For details on file archiving, see "File Archiving" on page 111.
The <BPM application directory>/config/archive.cfg file contains the following parameters:
[DiskSpace]
Parameter Description Value Type
MinimumFreeDiskSpaceThresholdInMB = Defines the minimum free disk space threshold. When this Default: = Positive
threshold is breached, the archive.cfg file starts to run according 750MB  integer
to the longTermCritical policy. Minimum
We recommend that this value be greater than the value of the allowed :
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ServerMinimumFreeDiskSpaceThresholdinMB parameter in the
topaz_agent_ctrl.cfg file.

0
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Archive Category Default Values

Category shortTerm longTerm longTermCritical
logs DAY MONTH 2DAY

input_job 1 HOUR 2WEEK 1HOUR
model_persistency 1HOUR 2WEEK 1HOUR

samples 1HOUR 1 DAY NEVER
samples_quarantine 1WEEK 1MONTH 1 DAY
scripts_results NEVER NEVER NEVER
webtraces_results NEVER NEVER NEVER

The archive categories are listed in the following format:

#lLog files archive policy
[logs]

shortTerm=1 DAY
longTerm=1 MONTH
longTermCritical=2 DAY

Section: logs

Default Can be
Parameter Description Value Validation Type Changed?
shortTerm The following values are available: Hour, Day, Week, Year, Minimum | String validation Yes
Same Day, Always, Minimum, Never. from specific list
longTerm The following values are available: Hour, Day, Week, Year, Minimum | String validation Yes
Same Day, Always, Minimum, Never. from specific list
longTermCritical = The following values are available: Hour, Day, Week, Year, Minimum | String validation Yes
Same Day, Always, Minimum, Never. from specific list
Section: input_job
Default Can be
Parameter Description Value Validation Type Changed?
shortTerm The following values are available: Hour, Day, Week, Year, Minimum | String validation Yes
Same Day, Always, Minimum, Never. from specific list
longTerm The following values are available: Hour, Day, Week, Year, Minimum | String validation Yes
Same Day, Always, Minimum, Never. from specific list
longTermCritical = The following values are available: Hour, Day, Week, Year, Minimum | String validation Yes
Same Day, Always, Minimum, Never. from specific list
Section: model_persistency
Default Can be
Parameter Description Value Validation Type Changed?
shortTerm The following values are available: Hour, Day, Week, Year, Minimum | String validation Yes
Same Day, Always, Minimum, Never. from specific list
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Default Can be
Parameter Description Value Validation Type Changed?
longTerm The following values are available: Hour, Day, Week, Year, Minimum | String validation Yes
Same Day, Always, Minimum, Never. from specific list
longTermCritical = The following values are available: Hour, Day, Week, Year, Minimum | String validation Yes
Same Day, Always, Minimum, Never. from specific list
Section: samples
Default Can be
Parameter Description Value Validation Type Changed?
shortTerm The following values are available: Hour, Day, Week, Year, Minimum | String validation Yes
Same Day, Always, Minimum, Never. from specific list
longTerm The following values are available: Hour, Day, Week, Year, Minimum | String validation Yes
Same Day, Always, Minimum, Never. from specific list
longTermCritical = The following values are available: Hour, Day, Week, Year, Minimum | String validation Yes
Same Day, Always, Minimum, Never. from specific list
Section: samples_quarantine
Default Can be
Parameter Description Value Validation Type Changed?
shortTerm The following values are available: Hour, Day, Week, Year, Minimum | String validation Yes
Same Day, Always, Minimum, Never. from specific list
longTerm The following values are available: Hour, Day, Week, Year, Minimum | String validation Yes
Same Day, Always, Minimum, Never. from specific list
longTermCritical = The following values are available: Hour, Day, Week, Year, Minimum | String validation Yes
Same Day, Always, Minimum, Never. from specific list
Section: scripts_results
Default Can be
Parameter Description Value Validation Type Changed?
shortTerm The following values are available: Hour, Day, Week, Year, Minimum | String validation Yes
Same Day, Always, Minimum, Never. from specific list
longTerm The following values are available: Hour, Day, Week, Year, Minimum | String validation Yes
Same Day, Always, Minimum, Never. from specific list
longTermCritical = The following values are available: Hour, Day, Week, Year, Minimum | String validation Yes
Same Day, Always, Minimum, Never. from specific list
Section: webtraces_results
Default Can be
Parameter Description Value Validation Type Changed?
shortTerm The following values are available: Hour, Day, Week, Year, Minimum | String validation Yes
Same Day, Always, Minimum, Never. from specific list
longTerm The following values are available: Hour, Day, Week, Year, Minimum | String validation Yes
Same Day, Always, Minimum, Never. from specific list
longTermCritical = The following values are available: Hour, Day, Week, Year, Minimum | String validation Yes
Same Day, Always, Minimum, Never. from specific list
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The section lists the archive process policy for each folder. The default value for all parameters in this section

is One Hour.

Parameter

logs_process_shortTerm

logs_process_longTerm

logs_process_longTerm
Critical

input_job_process_
shortTerm

input_job_process_
longTerm

input_job_process_
longTerm
Critical

model_persistency
process_
shortTerm

model_persistency_
process_
longTerm

model_persistency_
process_longTermCritical

samples_process_
shortTerm

samples_process_
longTerm

samples_process_
longTerm
Critical

samples_quarantine_
process_
shortTerm

samples_quarantine_
process_
longTerm

samples_quarantine_
process_longTermCritical

scripts_results_process_
short
Term

scripts_results_process_
long
Term

Description

The following values are available: Hour, Day, Week,
Year, Same Day, Always, Minimum, Never.

The following values are available: Hour, Day, Week,
Year, Same Day, Always, Minimum, Never.

The following values are available: Hour, Day, Week,
Year, Same Day, Always, Minimum, Never.

The following values are available: Hour, Day, Week,
Year, Same Day, Always, Minimum, Never.

The following values are available: Hour, Day, Week,
Year, Same Day, Always, Minimum, Never.

The following values are available: Hour, Day, Week,
Year, Same Day, Always, Minimum, Never.

The following values are available: Hour, Day, Week,
Year, Same Day, Always, Minimum, Never.

The following values are available: Hour, Day, Week,
Year, Same Day, Always, Minimum, Never.

The following values are available: Hour, Day, Week,
Year, Same Day, Always, Minimum, Never.

The following values are available: Hour, Day, Week,
Year, Same Day, Always, Minimum, Never.

The following values are available: Hour, Day, Week,
Year, Same Day, Always, Minimum, Never.

The following values are available: Hour, Day, Week,
Year, Same Day, Always, Minimum, Never.

The following values are available: Hour, Day, Week,
Year, Same Day, Always, Minimum, Never.

The following values are available: Hour, Day, Week,
Year, Same Day, Always, Minimum, Never.

The following values are available: Hour, Day, Week,
Year, Same Day, Always, Minimum, Never.

The following values are available: Hour, Day, Week,
Year, Same Day, Always, Minimum, Never.

The following values are available: Hour, Day, Week,
Year, Same Day, Always, Minimum, Never.
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Default

Value

Minimum

Minimum

Minimum

Minimum

Minimum

Minimum

Minimum

Minimum

Minimum

Minimum

Minimum

Minimum

Minimum

Minimum

Minimum

Minimum

Minimum

Validation Type

String validation
from specific list

String validation
from specific list

String validation
from specific list

String validation
from specific list

String validation
from specific list

String validation
from specific list

String validation
from specific list

String validation
from specific list

String validation
from specific list

String validation
from specific list

String validation
from specific list

String validation
from specific list

String validation
from specific list

String validation
from specific list

String validation
from specific list

String validation
from specific list

String validation
from specific list

Can be

Changed?

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes
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Default Can be
Parameter Description Value Validation Type Changed?
scripts_results_process_ The following values are available: Hour, Day, Week, Minimum  String validation Yes
long Year, Same Day, Always, Minimum, Never. from specific list
TermCritical
webtraces_results_ The following values are available: Hour, Day, Week, Minimum | String validation Yes
process_ Year, Same Day, Always, Minimum, Never. from specific list
shortTerm
webtraces_results_ The following values are available: Hour, Day, Week, Minimum  String validation Yes
process_ Year, Same Day, Always, Minimum, Never. from specific list
longTerm
webtraces_results_ The following values are available: Hour, Day, Week, Minimum | String validation Yes
process_longTermCritical | Year, Same Day, Always, Minimum, Never. from specific list

Parameters in agent1.cfg

The <BPM application directory>\config\agent1.cfg file, which controls BPM behavior, contains the
following parameters:

Section: General

Default Validation Can be
Parameter Description Value Type Changed?
TaskTimeoutMinutes Not supported. 15 minutes Positive
integer
Concurrent Profiles Determines the number of profiles that can be run 0 Positive Yes
concurrently. The following options are available: An unlimited integer
« 0-—Anunlimited number of profiles can run number of
concurrently. profiles can

« A value other than 0 —The number specifiedisthe | UN
maximum number of profiles that can run concurrently. = concurrently.

GlobalRunHandler The run mode BPM allocates when the run mode is not Classic String Yes
previously defined for the profile. The run mode
determines how BPM runs the tasks in a profile when the
profile begins an iteration.

The following options are available:
« Classic
« Concurrent
« Dialup
« Sequential
« Stepped
Not supported.

TopazAgentHome The path to the BPM installation directory. Notdefined | String
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Default Validation Can be
Parameter Description Value Type Changed?

SendSOEToBAC Determines whether to send Snapshot on Error data to 3 String Yes
APM, or to store it locally on the BPM machine. The
following options are available:

« 1-never send snapshots to APM.
« 2-always send snapshots to APM.

« 3 -—use the script configuration to determine whether
or not to send snapshots to APM.

SendRumBeacon Adds a special header to network requests created by False Boolean Yes
scripts with protocols from the
ColoringSupportedProtocols parameter. The header
enables the Real User Monitor probe to distinguish
between synthetic user data and real user data.

OrphanMdrvCleanUp Causes BPM to check for and killany orphan process 1 Boolean
created by LoadRunner.

createSnapshotWhile Determines how BPM processes Snapshot on Error for 0 Boolean
ContinueOnError scripts with multiple transactions:

« 0-—BPM behaves as follows:

« If Continue on Erroris enabled, BPM does not
generate any snapshotson error.

« If Continue on Erroris disabled, the first time that a
transaction fails, BPM stops running the script and
generates a snapshot on error, when possible.
Only one snapshot on error is generated, nota
separate snapshot for each error.

This is the default functionality in BPM 9.23 and later.

« 1-The Continue on Error and Snapshot on Error
options are independent of each other. If both
Continue on Error and Snapshot on Error are enabled,
BPM generates a snapshot on error for each
transaction failure, when possible. This was the
functionality in BPM version 9.22 and earlier.

AbnormalTransactionTime = Determines whether transactions with an inactive time 0 String
longer than the transaction time should be reported to
APM. The following options are available:

« O-donotreportthese transactions.
« 1-reporttransaction with a duration of 0.

« 2-—reporttransaction as failed (not recommended)

ReadScriptOutputAsUTF8 = Determinesthe charset 0 String Yes
o 0-default system charset.

« 1-UTF-8

Note: This parameter needs to be added manually; it
is not in the agent1.cfg file by default. If this parameter
is not present, BPM uses the default system charset.
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Section: Protocols

Can be
Parameter Description Default Value = Changed?

BdSupportedProtocols List of web based protocols that BPM can run with the breakdown Alist of No.
option. applicable

BPM runs a script with the breakdown option provided the script type is protocols

included in this setting.

If a script contains multiple protocols, it runs with the breakdown option
provided that one of the protocolsis included in this setting.

LFWSupportedProtocols | List of protocols supported by agent that run with the LogFileWrite Yes
option.

SnapshotSupported Determines for which protocols APM supports Snapshot on Error. Alistof the Yes
Protocols applicable
VuGen protocols

ColoringSupported Determines for which protocols BPM transactions are colored for Alist of all the Yes
Protocols requests sent to an application monitored by Diagnostics. web-based

VuGen protocols
(thatis, those

using http)

If the protocol replay run by the BPM is changed, and contains an http-
based protocol that is not included in this parameter, the protocol can
be added to the list, separated by a comma.

There should be no reason to remove protocols from the list.

AdvancedTcpBd List of non-web based protocols that BPM installed on Windows can run = Alist of Yes
SupportedProtocols with the TCP advanced breakdown option. applicable

BPM runs a script with the TCP advanced breakdown option provided protocols

the script type is included in this setting.

If a script contains multiple protocols, it runs with the TCP advanced
breakdown option provided that one of the protocolsis included in this
setting and none of the protocolsis included in the
BdSupportedProtocols setting (in which case, the regular
breakdown option is used).

Note: For notes and limitations about the non-web based protocols,
see "Notes and Limitation for Non-Web Based (TCP) Protocols" in
"Understanding Non-Web Based TCP Transaction Breakdown
Reports" on page 89.

AdvancedTcpBd List of non-web based protocols that BPM installed on Linux can run Alist of Yes
SupportedProtocols with the TCP advanced breakdown option. applicable

Linux BPM runs a script with the TCP advanced breakdown option provided protocols

the script type is included in this setting.

If a script contains multiple protocaols, it runs with the TCP advanced
breakdown option provided that one of the protocols is included in this
setting and none of the protocols is included in the
BdSupportedProtocols setting (in which case, the regular
breakdown option is used).

Note: For notes and limitations about the non-web based protocols,
see "Notes and Limitation for Non-Web Based (T CP) Protocols" in
"Understanding Non-Web Based TCP Transaction Breakdown
Reports" on page 89.

LinuxCompatible List of protocols supported by LoadRunner and BPM on Linux. No
Protocols

Section: WebTrace
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Parameter Description Default Value Validation Type
DefaultProtocol The following values are available: tcp String

. tcp

. icmp

« udp

Note: TCP is not supported on Linux.

ProtocolVersion The following value is available: IPv4 IPv4 String
Section: QTP
Default Validation
Parameter Description Value Type
QtpUserName The QTP/UFT user name. Not String
defined
QtpDomainName The QTP/UFT domain name. Not String
defined
QtpLogBackupPerRuns | Number of QTP/UFT executions that trigger a back up. 100 Positive
integer
QtpLogMaxSize Maximum QTP/UFT log size that triggers a back up (in MB). 5 Positive
integer
DisableEndProcesses Determines whether the -EndProcessesOnFail flag is used with a command False Boolean
OnFailKey line to execute QTP/UFT scripts. By default, when BPM runs a QTP/UFT script, it

calls mdrv.exe with a -EndProcessesOnFail flag. Running a QTP/UFT script with
this flag can cause csrss.exe system process critical termination (blue screen) in
some cases.

« True-The EndProcessesOnFail key is not called.

« False - The EndProcessesOnFail key is called.

Section: Sandbox

Default Can be

Parameter Description Value changed?
EnableSandbox Determines whether the sandbox is enabled or disabled. 0 Yes
« 0-Disabled
« 1-Enabled
SandboxEnableRecorderVersionCheck = Determines whether the script LoadRunner version verificationis = 0 Yes
active.

When enabled, BPM compares the script LoadRunner version
with the current LoadRunner version. Verification fails if the script
LoadRunner version is higher than the current LoadRunner
version.

« 0-Disabled
« 1-Enabled
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Parameters in topaz_data_server.cfg

The <BPM application directory>\config\topaz_data_server.cfg file, which controls the transmission of
data from BPM to the Gateway Server, contains the following parameters:

Section: data_depot

Default Validation Can be

Parameter Description Value Type Changed?
ReportAnd | Determines whether failed reports are resent to APM. The following two = False Boolean No
Forget options are available:

« True—Failed reports are ignored and notresent to APM.

« False —BPMtries to resend failed reports to APM.
Section: transdata

Default Validation Can be

Parameter Description Value Type Changed?
MaxSnapshot Determines the maximum size of the snapshot 60 Positive Yes
Size HTML file reported to Business Availability Center = kilobytes = integer

4.5.2 and earlier.
MaxSnapshot Maximum snapshot on error size in KB for 256 Positive Yes
SizeAM5 instances working with AM version 5.0 and above. = kilobytes integer
ScriptEnd Determines the behavior for transactions that default = String Yes
StatusTime were not run when a script ends with a status of validation
Out END_STATUS_TIMED_OUT. The following are from

the valid options: specific list

« default — For each transactions that was not
run, a sample with a status of 6 (NOT_RUN_
STATUS) s sent.

. force_no_transdata— For the first
transaction that was not run, a sample with a
status of 1 (LR_FAIL) is sent. For all the other
transactions that were not run, no data is sent.

« force_fail_status — A sample with a status of
1 (LR_FAIL), and with the relevant error, is
sent for each transaction that was not run.
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Default Validation Can be
Parameter Description Value Type Changed?
ScriptEnd Determines the behavior for transactions that default = String Yes
StatusError were not run when a script ends with a status of validation
END_STATUS_ERROR. The following are the from
valid options: specific list
« default
« Ifthe scriptis configured to continue
running after the failed transaction,
relevant samples are sent accordingly.
« Ifthe scriptis configured not to continue
running after the failed transaction, then
no data is sent for any of the subsequent
transactions.
. force_fail_status
« Ifthe scriptis configured to continue
running after the failed transaction,
relevant samples are sent accordingly.
« Ifthe scriptis configured not to continue
running after the failed transaction, then a
sample with a status of 1 (LR_FAIL), and
with the relevant error, is sent for each
subsequent transaction.
NumberofSaved Defines the number of days for which saved 5days Positive Yes
SnapshotDays snapshots are kept. integer
Not supported.
MaxTxError Limits maximum errors amount per transaction 100 Positive Yes
Amount integer
MaxBreakdownDiffFromResponseTime = The maximum sum of transaction breakdown (in 50 Positive
milliseconds) when transaction and component integer
breakdown will be reported to APM.
ScriptPcbdErrors Controls the behavior when a component default = String Yes
breakdown fails with an undefined error code. validation
The following are the valid options: from
« default—These type of breakdown errors specificlist
willnot be reported to EUM.
« report_pcbd_errors — These type of
breakdown errors will be reported to EUM.
Section: PCBD
Validation Can be
Parameter Description Default Value Type Changed?
Policy Determines the page component breakdown reporting policy. PCB_POLICY_ String Yes
The following two options are available: RUNNUM

« PCB_POLICY_RUNNUM - Data is automatically reported
after the specified number of runs.

Note: The default
policy value for HPE
Software-as-a-Service

« PCB_POLICY_THRESHOLD —Dataisonly reported if

during the transaction run, the threshold status changes to
the Poor (red) status (because the previous run was less
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Parameter Description Default Value

than the higher threshold, and the current run is over that
threshold) and not when it changes from red status.

The transaction thresholds are defined as part of the
business process profile properties within End User
Management Administration.

Runnum Determines the number of runs after which BPM reports page 4runs

component breakdown data (applicable when the value of the
Policy parameter is Runnum).

Section: txhttp

Parameter Description

WakeupMinutes | Determines the amount of time, in minutes, after which all the

Time transaction samples in the queue are reported. After this amount
of time has elapsed, the transaction samples in the queue are
reported, regardless of the number of samplesin queue.

WakeupCount | Determinesthe number of transaction samples that must be
collected before all the transaction samples in the queue are
reported. After this number of transaction samples are collected,
all the transaction samples in the queue are reported, regardless
of the amount of time that has elapsed since the last report.

MaxChunk Determines the maximum number of transaction samples that
can be sentin one http request.

Priority Not supported.

Section: wthttp

Parameter Description

Wakeup Determines the amount of time, in minutes, after which all the
Minutes WebTrace samplesin the queue are reported. After this amount of
Time time has elapsed, the WebTrace samples in the queue are reported,

regardless of the number of samplesin queue.

HPE Business Process Monitor (9.40)

Default
Value

1
minute

40

samples

100

samples

Default
Value

1
minute

Validation Can be

Type Changed?
Positive Yes
integer
Validation
Type Can be Changed?
Positive Do not change this
integer value without
consulting HPE
Software
Support.<!--
Reference to CSO:
Document 15.doc--
>
Positive Do not change this
integer value without
consulting HPE
Software
Support.<!--
Reference to CSO:
Document 15.doc--
>
Positive Do not change this
integer value without
consulting HPE
Software
Support.<!--
Reference to CSO:
Document 15.doc--
>
Positive
integer
Validation
Type Can be Changed?
Positive Do not change this
integer value without

consulting HPE
Software Support.<!--
Reference to CSO:
Document 15.doc-->
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Default Validation
Parameter Description Value Type Can be Changed?
Wakeup Determines the number of WebTrace samples that must be collected = 40 Positive Do not change this
Count before allthe WebTrace samples in the queue are reported. After this | samples  integer value without
number of WebTrace samples are collected, all the transaction consulting HPE
samples in the queue are reported, regardless of the amount of time Software Support.<!--
that has elapsed since the last report. Reference to CSO:
Document 15.doc-->
MaxChunk | Determines the maximum number of WebTrace samplesthatcanbe 1 Positive Do not change this
sentin one http request. sample  integer value without
consulting HPE
Software Support.<!--
Reference to CSO:
Document 15.doc-->
Priority Not supported. 5 Positive
integer
Section: soahttp
Default Validation Can be
Parameter Description Value Type Changed?
Wakeup Determines the amount of time, in minutes, after which allthe SOA 1 Positive Do notchange
MinutesTime = samplesin the queue are reported. After this amount of time has elapsed, ' minute | integer this value
the SOA samples in the queue are reported, regardless of the number of without
samplesin queue. consulting HPE
Software
Support.
Wakeup Determines the number of SOA samples that must be collected before all | 40 Positive Do notchange
Count the SOA samples in the queue are reported. After this number of SOA samples | integer this value
samples are collected, all the transaction samples in the queue are without
reported, regardless of the amount of time that has elapsed since the last consulting HPE
report. Software
Support.
MaxChunk Determines the maximum number of SOA samples that can be sentinone 100 Positive Do notchange
http request. samples | integer this value
without
consulting HPE
Software
Support.
Priority Not supported. 5 Positive
integer

Section: HTTPSender

Default Validation
Parameter Description Value Type Can be Changed?
HTTPSender = The timeout, in seconds, for 300 Positive Do not change this value without consulting HPE Software
TimeoutSec  sending BPM samplesto APM. | seconds ' integer Support.<!-- Reference to CSO: Document 15.doc-->
Not supported.

Section: General
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Default Validation Can be

Parameter Description Value Type Changed?

ApproximateMax The maximum permitted sub-folder size. Not Yes

SizeOfDataSub defined -

FolderinMB no limit

MaxFilesNumber The maximum number of files allowed under adatasub- 1000 Yes

UnderDataSubFolder folder.

TopazAgentHome The file path to the BPM installation. Not String No
defined

UpdateLoglLevelTo Instructs BPM to change the log level to LogDisabled in True Boolean Yes

DisabledOnScript the default.cfg file for a downloaded script. Valid options

DownloadComplete are:

True — Change the log level to LogDisabled.
False — Do not change the log level.
EnableSamplePerTxMechanism | Determines whether individual transactions within a True Boolean Yes

business transaction flow (BTF) should be grouped
together as a single item.

True — Transactions within a BTF are reported together
as asingle item. Each transaction gets a BTF identifier
per run occurrence.

False — Each transaction in a BTF is given a separate ID
and isreported separately.

Parameters in sconn.cfg

The <BPM application directory>\config\sconn.cfg file, which controls the configuration options pertaining
to the communication between BPM and the Gateway Server, contains the following parameters:

Section: Site#

Default
Parameter Description Value Can be Changed?
AuthUser Determines the user name to be used for basic authentication, if ""(not The value can be
required by APM. defined) changed in BPM Admin.
AuthDomain Determines the domain name to be used for basic authentication, if "" (not The value can be
required by APM. defined) changed in BPM Admin.
AuthPasswd Determines the encrypted password to be used for basic " (not The value can be
authentication, if required by APM. defined) changed in BPM Admin.
UseNTLMAuth Authorization type for the Gateway URL -1
o =-1-Notset
« 0-Basic
e 1-Ntim
HandleBinary Determines whether to change the content type in the http header 0 (donot | Do not change this value
ContentType of requests sent by the BPM, when the post buffer is binary. The change) without consulting HPE
content type in such a case is application/octet-stream (and not Software Support.<!--
application/x-www-form-urlencoded). The following two Reference to CSO:
options are available: Document 18.doc-->

« 0-donotchange content type
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Parameter

HeaderName

HeaderValue

Reset
Connection OnFailure

SSLTruststorePath

SSLTruststoreType
SSLTruststorePasswd
SSLKeystorePath
SSLKeystoreType
SSLKeystorePasswd

SSLClientCert

SSLServer
Cert

SSLPVK

SSLPVK
Passwd

SSLValidateTrusted

SSLValidateCertExp

HPE Business Process Monitor (9.40)
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Default
Description Value Can be Changed?
« 1-change contenttype
Determines the name of the header which should be added or " (not Yes
changed, in order to add or override headers to the http request defined)
sent by BPM to APM. For more information,see "How to Add or
Override HTTP Request Headers" on page 154.
If this parameter is empty (or does not exist), itis ignored and no
addition or change is made to the header.
Determines the value of the header (as defined by parameter ""(not Yes
HeaderName, above) which should be added or changed. defined)
Reset the caching data saved for the BPM connection to APM in 1 Yes
case of acommunication failure.
Determines whether to re-open a new communication session to
APM in case of an http, TCP or SSL connectivity failure. This
enables communication caching data (such as SSL or DNS cached
data) to be saved.
The following options are available:
« 0-Do notopenanew communication session when thereisa
connectivity failure.
« 1 (default behavior) — Open a new communication session
when there is a connectivity failure.
« No value —The default option is used and a new
communication session is opened when there is a connectivity
failure.
Path on the file system to the truststore (contains server certificates
that BPM mark as trusted).
Truststore type JKS
Truststore password
Path on the file system to the truststore
Path on the file system to the keystore JKS
Keystore password
Determines the SSL client certificate file to be used if SSL client " (not The value can be
authentication is required by APM. Note that this file must be in defined) changed in BPM Admin.
PEM format.
Determines the SSL authority certificate file to be used if the SSL " (not The value can be
protocol is required for BPM to communicate with APM. Note that = defined) changed in BPM Admin.
this file must be in PEM format.
Determines the SSL private key file used as the pair key of the " (not The value can be
public key in the SSL client certificate file. This file isrequired if SSL = defined) changed in BPM Admin.
client authentication is required by APM. Note that this file must be
in PEM format.
Password for encrypted client certificate ""(not The value can be
defined) changed in BPM Admin.
Validate that server certificates are trusted False
Validate that server certificates have not expired False
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SSLValidateHostName

SSLServer
Validate

SSLHostName
Validate

ProxyUrl

UseNTLMProxyAuth

ProxyName

ProxyPasswd

ProxyDomain
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Description
Validate hostname on server certificates

If you defined an SSL authority certificate file, this parameter
determines whether to validate the certificate received in the SSL
handshake. By default, the certificate is validated. If you do not
want the certificate to be validated, set this parameter to 2.

This parameter determines how the host name in the server
certificate is validated. The following options are available:

« 1-Fullvalidation.
« 2-Validates the existence of the host name only.

« 3 - Skips host name validation.

Determines the proxy server URL to be used if you are connecting
to APM using a proxy server.

Authorization type for the proxy server
« =-1-Notset
« 0-Basic
e 1-Ntim

Username for the proxy server

Password for the proxy server

Domain of the proxy server

Default
Value

False

1
(validate)

1 (full
validation)

(not
defined)

-1

(not
defined)

(not
defined)

(not
defined)

Parameters in encryption.properties

The <BPM application directory>/config/encryption.properties file, which controls the configuration
options pertaining to the encryption of all sensitive data in BPM, contains the following parameters:

Note: This file is read-only and you should not change any of the values.

Parameter

crypt.secret.key.
active.id

crypt.secret.key

Description

Determines the encrypted secret key (encrypted by the

Default Value

Determines the value of the active key id. 1

" (not defined)

seed key from the seed.properties file) to be used to
encrypt/decrypt all sensitive data in APM.

Note: The secret key is generated automatically.

crypt.conf.active
.id

Determines the value of the configuration id. 1

HPE Business Process Monitor (9.40)

Can be Changed?

Do not change this value
without consulting HPE
Software Support.<!--
Reference to CSO:
Document 18.doc-->

Do not change this value
without consulting HPE
Software Support.<!--
Reference to CSO:
Document 18.doc-->

The value can be
changed in BPM Admin.

The value can be
changed in BPM Admin

The value can be
changed in BPM Admin.

The value can be
changed in BPM Admin.

Can be Changed?

Do not change this
value without
consulting HPE
Software Support.

The value is
generated once for
each installation or
upgrade.

Do not change this
value without
consulting HPE
Software Support.
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Parameter Description Default Value Can be Changed?
crypt.conf.1 Determines the value of the encryption algorithmtobe = AES/ECB/NoPadding Do not change this
used to encrypt/decrypt all sensitive data in APM. value without
consulting HPE
Software Support.
crypt.conf.2 Determines the value of the encryption algorithmtobe | DESede/ECB/PKCS5Padding | Do not change this
used to encrypt/decrypt all sensitive data in APM. value without
consulting HPE
Software Support.
crypt.generated. Determines the value of the generated key size to be 256 Do not change this
key.size used to generate new secret key. value without
consulting HPE
Software Support.
mac.verification. = Determines the value of the macalgorithm to be usedto = HmacSHA256 Do not change this
algorithm verify allencrypted data. value without
consulting HPE
Software Support.

Parameters in seed.properties

The <BPM application directory>/config/seed.properties file, which controls the configuration options
pertaining to the encryption of all sensitive data in BPM, contains the following parameters:

Note: This file is read-only and you should not change any of the values.

Parameter Description Default Value Can be Changed?
crypt.seed.conf = Determines the value of the encryption algorithm to be AES/ECB/NoPadding | Do not change this value
used to generate a new seed secret key without consulting HPE
Software Support.
crypt.seed.key Determines the seed secret key to be used to "" (not defined) The value is generated once
encrypt/decrypt the crypt.secret.key in the for each installation or
encryption.properties file. upgrade.
crypt.generated. Determines the value of the generated seed key size to 256 Do not change this value
key.size be used to generate a new seed secret key. without consulting HPE
Software Support.
mac.verification. = Determines the value of the macalgorithmtobe usedto | HmacSHA256 Do not change this value
algorithm verify an encrypted secret key. without consulting HPE
Software Support.
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Over a Secure Connection

Transport Layer Security (TLS) technology secures communication by encrypting data and providing
authentication. Without TLS encryption, packets of information travel over networks in full view.

Learn About

"Restricting Access to BPM Admin" on page 181

Tasks

How to Communicate Using SSL

You can configure BPM to support https communication with the Gateway Server over the SSL channel and
can also configure SSL support for BPM Admin.

For details on configuring https communication with the Gateway Server, see the BSM Hardening Guide.

How to Configure TLS Support for BPM with an APM Connection

You can configure BPM to support secure communication with the APM Gateway Server over a TLS channel
by obtaining a certificate authority (CA) root certificate and establish trust:

1. Obtain the root CA certificate, and any intermediate authority certificates if applicable. If there are
multiple certificate authorities, combine the certificates in a single file.

If you do not have a CA root certificate, you can usually export it from the browser by loading the URL of
the APM Server to which you connect.

2. Run the following command to establish trust for each certificate:

Linux:

cd /opt/HP/BPM/JRE/bin
keytool -import -trustcacerts -alias <your server> -keystore <truststore path> -file <path to
certificate>

Windows:

cd C:\HP\BPM\JRE\bin
keytool -import -trustcacerts -alias <your server> -keystore <truststore path> -file <path to
certificate>

Note: The default truststore path is:
<BPM installation directory>\HP\BPM\JRE\lib\security\cacerts
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If required, you can enter a new truststore path in BPM. When BPM starts, it will automatically
identify certificates in the default truststore path, even if you have entered an additional truststore
path in BPM configuration.

3. Make sure that you have containers in one of the following formats:

« JKS —this format is usually used by Java applications

o PKCS12 - this format usually uses containers with a *.pfx extension

If you need to convert a *.pfx file to JKS format, run the following command:
Windows:

cd C:\HP\BPM\JRE\bin
keytool -importkeystore -srckeystore <location>certif.pfx -destkeystore <location>\file.jks -
srcstoretype pkcsi2

Linux:

cd /opt/HP/BPM/JRE/bin
keytool -importkeystore -srckeystore <location>certif.pfx -destkeystore location>/file.jks -
srcstoretype pkcsi2

4. InBPM, in the Security Settings window, enter the following information:
« Truststore path — the path to the truststore container

« Truststore type — the container type (JKS or PKCS12)
« Truststore password — the password for the truststore container

5. We recommend selecting the following check boxes in the Security Settings window:
« Validate host names on server certificate

« Validate that the server certificates are trusted
« Validate that the server certificates are not expired

6. If the APM connection requires a client certificate, in the Security Settings window, enter the following
information:

« Keystore path —the path to the keystore container
« Keystore type —the container type (JKS or PKCS12)
« Keystore password —the password to keystore container

o SSL private key password —the password for the encrypted private key

How to Configure SSL Support for BPM Admin

When you connect to BPM Admin from a remote machine using a browser, information is sent using http,
which is plain text and not secure. You can configure BPM Admin to work with TLS so that all communication
between the remote browser and BPM Admin is encrypted.
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1. Run the following command to establish trust for your corporate Certificate Authority that you will use to
sign the Server Certificate in the following steps.

Linux:

cd /opt/HP/BPM/JRE/bin
keytool -import -trustcacerts -alias <your server> -keystore <truststore path> -file <path to
certificate>

Windows:

cd C:\HP\BPM\JRE\bin
keytool -import -trustcacerts -alias <your server> -keystore <truststore path> -file <path to
certificate>

Note: The default truststore path is:

<BPM installation directory>\HP\BPM\JRE\lib\security\cacerts

If required, you can enter a new truststore path in BPM. When BPM starts, it will automatically
identify certificates in the default truststore path, even if you have entered an additional truststore
path in BPM configuration.

2. Make sure that you have containers in one of the following formats:

« JKS —this format is usually used by Java applications
o PKCS12 - this format usually uses containers with a *.pfx extension

If you need to convert a *.pfx file to JKS format. run the following command:

Windows:

cd C:\HP\BPM\JRE\bin
keytool -importkeystore -srckeystore <location>certif.pfx -destkeystore <location>\file.jks -
srcstoretype pkcsi2

Linux:

cd /opt/HP/BPM/JRE/bin
keytool -importkeystore -srckeystore <location>certif.pfx -destkeystore location>/file.jks -
srcstoretype pkcsi2

3. Use one of the following options to obtain a server certificate:

Note: The server certificate must include an Enhanced Key Usage field with the value Server
Authentication.

Option 1: Obtain the server certificate from your corporate Certificate Authority in .pfx (PKCS12) format
and skip to "Modify the server.xml:" on the next page below.

Option 2: Create a java keystore with the server certificate as follows (replace the string changeit
below with your password):

a. Generate a keystore with a private key:
Windows:

HPE Business Process Monitor (9.40) Page 176 of 196



Business Process Monitor Administration Guide
Chapter 18: Configuring BPM to Run Over a Secure Connection

cd C:\HP\BPM\JRE\bin
keytool -genkeypair -validity 1065 -keysize 2048 -keyalg rsa -keystore <BPM installation
directory>\JRE\lib\security\cacerts -storepass changeit -alias myserver.mydomain

Linux:

cd /opt/HP/BPM/JRE/bin
keytool -genkeypair -validity 1065 -keysize 2048 -keyalg rsa -keystore
/opt/HP/BPM/JRE/1lib/security/cacerts -storepass changeit -alias myserver.mydomain

where validity (in days) and keysize depend on your certificate authority requirements.

b. Generate a server certificate request to have it signed by your internal certificate authority

keytool -keystore mykeystore -storepass changeit -alias myserver.mydomain -certreq -file
CERTREQFILE.csr

Download the signed server certificate cert_signed.cer from your certificate authority.
Obtain the root authority certificate CA.crt (and any intermediate authority certificates if applicable).

e. Import the root certificate authority certificate (and any intermediate authority certificates if
applicable) into the keystore created earlier in this procedure.

keytool -import -trustcacerts -keystore mykeystore -storepass changeit -alias myRootCA -
file CA.crt

f. Import the signed certificate into the same keystore under the original alias using the following
command:

Windows:

keytool -import -v -alias myserver.mydomain -file cert_signed.cer -keystore <BPM
installation directory>\JRE\lib\security\cacerts -keypass changeit -storepass changeit

Linux:

keytool -import -v -alias myserver.mydomain -file cert_signed.cer -keystore
/opt/HP/BPM/JRE/1lib/security/cacerts -keypass changeit -storepass changeit

g. Verify that the keystore contains at least two entries: Trusted Cert Entry and Private Key Entry:
Windows:

keytool -list -keystore <BPM installation directory>\JRE\lib\security\cacerts
Linux:
keytool -list -keystore /opt/HP/BPM/JRE/lib/security/cacerts

4. Modify the server.xml:
a. Openthe <BPM installation directory>\ServietContainer\confiserver.xml file in a text editor.
b. Uncomment the section with Connector port="8443":
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<ll==
<Connector port="8443" protocol="HTTP/1.1" SSLEnabled="true" server="Powered by HPE"
maxThreads="150" scheme="https" secure="true"
clientAuth="false" sslEnabledProtocols="TLSv1l,TLSv1l.1,TLSv1.2"
ciphers="TLS_RSA_WITH_AES_128 CBC_SHA, TLS_DHE_RSA_WITH_AES_128 CBC_SHA,
TLS_DHE_DSS_WITH_AES_128 CBC_SHA"/>

Note:
o ciphers values can be adjusted according to your needs.

o The list of ciphers must be coordinated with the Security team.

o Disable all weak algorithms in the BPMs. For details, see "How to Disable Weak
Algorithms" on page 181.

c. Add information about your keystore (location, password, type). If your server certificate is in
PKCS12 format, the keystore type should be "PKCS12", otherwise, it should be "JKS". For
example:

JKS:

keystoreFile="<location>mykeystore" keystoreType="JKS"
keystorePass="myprivatekeypassword"

PKCS12:

keystoreFile="<location>mykeystore" keystoreType="PKCS12"
keystorePass="myprivatekeypassword"

d. Add information about your key alias.
keyAlias="<your server>"

e. Save your changes.
5. Import the root authority certificate into the truststore used by BPM using the following command:
o Windows:
cd <BPM installation directory>\JRE\bin

> keytool -import -alias <myCA> -file c:\myCArootcert.cer -keystore
..\lib\security\cacerts -trustcacerts -storepass changeit

o Linux:

cd <BPM root directory>/JRE/bin
> keytool -import -alias <myCA> -file ~/myCArootcer.cer -keystore
../lib/security/cacerts -trustcacerts -storepass changeit

6. Restart BPM.
7. Verify that you can open the BPM Admin console using the secure connection:
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https://<BPM server FQDN>:8443

8. When you have succeeded in connecting securely, close the unsecure port in the server.xml by
commenting out the section with Connector port="2696".

9. Restart BPM.

10. In EUM Administration in APM, modify the BPM console URL to use the secure connection. For
details, see "Edit Business Process Monitor Properties Dialog Box" in the APM Application
Administration Guide.

If you are unable to access the BPM Admin console via SSL, see "Unable to access the BPM Admin console
using SSL" on page 181 below.

How to Configure Authentication for BPM Admin

Authentication settings (user, domain/group, password) define the web users permitted to access BPM
Admin using basic authentication.

This can be set during installation in the Server Authentication page of the BPM Configuration wizard, or set
manually using the procedures below.

Caution:

« If authentication is not set, all users will be able to access the Admin interface in BPM without secure
authentication.

o Werecommend using SHA-512 which is stronger than the default algorithm. SHA-512 authentication
cannot be set during the wizard and must be configured manually. For details, see the note at the end
of the procedures below.

Note: If you configure basic authentication for the BPM Admin console, you cannot use the following
utilities in the EUM application in APM:

« BPM Page Component Breakdown on Demand
« BPM WebTrace on Demand

« BPM Transaction Invocation

To manually set basic authentication after installation:

Stop BPM and make sure that all processes are stopped.

2. Open the following file in a text editor:
<BPM installation directory>\ServletContainer\confiweb.xml

3. Uncomment the section Security Constraint and Login Configuration and save the file.

Note: The web.xml file should not contain additional <security-constraint> tags.

4. Open the following file in a text editor:
<BPM installation directory>\ServletContainer\confitomcat-users.xml

5. Add the list of allowed users for BPM. All users must be assigned roles="bpm_admin".

To store passwords in a secure manner, encrypt the password prior to setting it in the tomcat-users.xml
using the following procedure:
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a. Editthe REALM in the <BPM installation directory>\ServietContainer\confiserver.xml and if it
is not already set, add the attribute digest="sha".

b. Execute the following command to generate the HASH of the password:

<BPM installation directory>\ServletContainer\bin\digest.bat -a sha password

Note:

o If you receive notification that the CATALINA_HOME environment variable is not defined
correctly, set CATALINA_HOME=<BPM installation directory>/ServietContainer

o If you receive notification about an undefined Java environment, set
JRE_HOME=<BPM installation directory>/JRE

c. Setthe password in tomcat-users.xml.

For example, the line:
<user username="userl" password="encrypted_password" roles="bpm_admin" />

adds a user called "user1" with a password of "password" to the users who are allowed to access
BPM Admin.

Note: We recommend using a strong password with at least eight characters including both
capital and lower case letters and numbers or special characters.

d. If there are other users defined in tomcat-users.xml, repeat steps b and c for each user's password.
6. Save the file and Restart BPM.

Note: There is an option to use a stronger algorithm to store passwords using SHA-512:

« Instep 5 above, replace steps a and b with the following:

a. Editthe REALM in the <BPM installation directory>\ServietContainer\confiserver.xml and if it
is not already set, add the attribute digest="sha-512"

b. Execute the following command to generate the HASH of the password:

<BPM installation directory>\ServletContainer\bin\digest.bat -a sha-512 password

How to Convert Existing SSL Scripts to TLS
1. Download all scripts and add the following command:
web_set_sockets_option("SSL_VERSION","{SecureProtocolType}");

2. Foreach script with a default value of TLS, define a new file type parameter named
SecureProtocolType.

3. Upload the scripts to APM.

In the future, if you move to a different security type, you can search and replace the parameter name
SecureProtocolType with a different security value, and replace the TLS parameter value with the required
value.
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How to Disable Weak Algorithms

There is a potential security issue when using old or outdated cipher suites. Outdated cipher suites may allow
attackers to gain access or successfully tamper with data while in transit. For detailed information, see
https://cve.mitre.org/cgi-bin/cvename.cgi?name=CVE-2015-4000

Toresolve this issue, disable the algorithms MD5, SSLv3, DSA, DES, DHE, and RC4.

1. Open the file java.security (by default located in the directory C:\HP\BPM\JRE\lib\security\)
2. Add the following parameter to the end of the file:

jdk.tls.disabledAlgorithms=MD5, SSLv3, DSA, DES, DHE, RC4

Ul Description

See "Security Settings Page" on page 53.

Troubleshooting/Limitations

Unable to access the BPM Admin console using SSL
If it is still impossible to access the BPM Admin console after configuring SSL, check the following files:

 Linux: /opt/HP/BPM/workspace/logs/bpm_bsm_comm.log

« Windows: Check the latest catalina.<current date>.log file located in
C:\ProgramData\HP\BPM\Tomcat\logs

BPM cannot create a connection to APM

If a signed server certificate has expired or has been changed, BPM may not be able to create a connection to
APM.

Solution: Import a new server certificate and restart BPM.

Restricting Access to BPM Admin

You can configure secured access for BPM Admin, thereby controlling who can access the BPM Admin user
interface.

When secured access is activated, access to BPM Admin is limited to:

« Local users (that is, those users who connect to BPM Admin on the actual BPM machine using the URL
http://localhost:2696).

« Users who access a BPM Admin from APM (select Admin > End User Management > Settings >

BPM Agents, select a BPM and click the Open a Business Process Monitor Agent's Console ™
button) sending the configured authentication.

Any other attempt to access BPM Admin fails.
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When you access BPM Admin from APM, a secured token is included in the URL sent by APM, which is
decrypted and validated by BPM. Only successful validation of the token enables access to BPM Admin.

The secured access mechanism uses LW-SSO to generate and validate the secured token that is passed
between APM and BPM. For details on working with LW-SSO, refer to the APM Platform Administration
Guide.

Task

How to Configure BPM for Secure Access
Log into APM.

In a browser on the APM Gateway Server, enter the URL of the JMX console:
http://localhost:29000/

Enter your JMX console authentication credentials.

N

Under the domain name Topaz, click service=LW-SSO Configuration.
Locate the initString attribute and copy the value in the New Value column.
Copy the value of the Token Creation Key (initString) property.

N o o b~ w

On the BPM machine, paste the copied value in the initString parameter in the following file:
<BPM installation directory>\ServletContainer\webapps\ROOT\WEB-
INF\classes\lwssofmconf.xml

For example:
<lwssoValidation id="ID0000O1">
<domain></domain>
<crypto cipherType="symmetricBlockCipher" directKeyEncoded="false"
directKeyEncoding="Hex" encodingMode="Base64Url" engineName="AES"
initString="<value copied from JMX Console>" keySize="256"
paddingModeName="CBC" />
</lwssoValidation>

8. Onthe BPM machine, edit the <BPM application directory>\config\topaz_agent_ctrl.cfg file and in
the General section, change the setting for the SecureAccess parameter to 1.

Note: If this parameter does not exist, add it to the file.

Troubleshooting/Limitations

Limitations

« You can only implement one type of authentication. You can not use both LW-SSO and regular BPM
authentication.

« Secured access is only applicable to BPM versions 9.22 and later, and APM versions 9.21 and later.

« APM sends the secured token to all BPM 9.22 or later installations, regardless of whether the BPM is
configured for secured access. For BPM installations earlier than version 9.22, APM sends the regular
URL without a secured token.

« Therequest generated by the APM is valid for only one minute.
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« IfBPM Admin is open in a browser tab, after having been securely accessed, access to the same BPM in
other browser tabs is also possible as the session has already been validated.

« A BPM can only be configured for secure access with one APM system, but a APM system can securely
access multiple BPMs.

« The APM URL configured for the APM site in BPM (topaz_agent_ctrl.cfg file > specific site section >
SiteUrl parameter) must be exactly the same (without port numbers) as the APM URL that is sent by APM

for secured access with BPM.
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This chaptersection includes:

« "How to Change the Default Port" below

« "How to Run Tomcat as a Specific User" on the next page

« "How to Disable the Close Application Mechanism" on page 186

« "How to Enable Access to Windows Mapped Network Resources Within a Script" on page 186
« "How to Change the QTP/UFT User" on page 186

How to Change the Default Port

By default, BPM Admin uses port 2696 on the host machine. If required, you can change the port. Use the
new port value in the URL when accessing BPM Admin from a browser window.

To change the default port:
On Windows:

1. Select Start > Programs > Business Process Monitor, then right-click the Business Process
Monitor Admin link. Select Properties from the displayed menu to open the BPM Admin Properties
dialog box.

2. Ifthe Business Process Monitor Admin Properties dialog box contains a Web Document tab, open the
tab and change the port in the URL box to the new port value, then click Apply. Skip to Step 12 below.

If the Business Process Monitor Admin Properties dialog box does not contain a Web Document tab,
continue with the next step.

3. Open the General tab and find the Location field. Open a Windows Explorer window and browse to the
path that appears in the Location field (for example, C: \Documents and Settings\All Users\Start
Menu\Programs\HP Business Process Monitor).

Delete the BPM Admin shortcut from the folder.
Select File > New > Shortcut. The first page of the Create Shortcut Wizard is displayed.

In the Type the location of the item box, enter the BPM Admin URL using the new port number:
http://localhost:<new port value>/.

Click Next.
In the Type a name for this shortcut box, enter Business Process Monitor Admin.
Click Finish.

10. Check that a new Internet shortcut has been created in the folder.

11. Select Start > Programs > Business Process Monitor, right-click the Business Process Monitor
Admin link, and select Properties. In the displayed Business Process Monitor Admin Properties dialog
box, access the Web Document tab and check that the new port value is now displayed in the URL
box.

12. Restart BPM.
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On Linux:

Stop BPM and make sure that all processes are stopped.
Open <BPM root directory>\ServletContainer\confiserver.xml in a text editor.

3. Look for the XML element Connector with an attribute scheme set to http or https. Change the attribute
port to the required port value, and save the file.

4. Restart BPM.

How to View the Catalina Command Prompt Window

By default, the Catalina Command Prompt window is hidden when running BPM. You can use the following
procedure to keep it visible.

To view the Catalina Command Prompt window:
Open the <BPM Root directory>\launch_service\dat\nanny\catalina.nanny file in a text editor.
2. Change the line:
show_window= ©
to
show_window=1

3. Savethefile.
Restart BPM.

How to Run Tomcat as a Specific User

BPM Admin uses Tomcat (Catalina) as its web server. To improve security, we recommend not running
Tomcat:

« As asystem user
« As auser with administrator/root permissions

By default, Tomcat runs under the same user to which BPM is configured—the system user (default setting).
You can configure Tomcat to run as a specific user as follows:

Configuring Tomcat to Run as a Specific User During Installation

When installing BPM, in the Configuration Wizard > Run as User page, select the Run as specific user
option and enter the relevant credentials.

Configuring Tomcat to Run as a Specific User After Installation
If BPM is already installed and has been configured to run as the system user (default setting):
1. Access the Set User Credentials on Agent dialog box using one of the following in the BPM web console:

=
« Select the host in the BPM tree and then click the Set User Credentials |“*| button.
« Right-click the host in the BPM Tree to display a Shortcut menu and select Set User Credentials.

2. Inthe Set User Credentials on Agent dialog box:
« Select the Other user option and enter the relevant credentials.

« Savethe changes and restart BPM.
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o Windows: Click the Set and Restart BPM button.
o Linux: Click the Set button and then manually restart BPM.

How to Disable the Close Application Mechanism

The mechanism to automatically close the application being tested when running QTP/UFT scripts (described
in "QuickTest Professional (QTP) and Unified Functional Testing (UFT) Scripts" in "Requirements and
Limitations for Running Tasks" on page 20) is enabled by default for scripts run on BPM.

If required, you can disable the mechanism for a specific script.
To disable the mechanism:

1. Browse to the script folder and open the default.cfg file in a text editor.
2. Inthe General section, add the following:

DisableEndProcessesOnFail=1
Note: To re-enable the mechanism, delete the statement.

3. Save the file. The mechanism no longer closes an application being tested if the QTP/UFT script fails
before it runs the last step (which closes the application).

How to Enable Access to Windows Mapped Network Resources Within a Script
Open the wrapper.conf file (located under <BPM installation directory>/yajsw/conf).

2. Uncomment the following line by removing the # symbol:
#wrapper.app.pre.script=scripts/mapNetworkDrive.gv

3. Open the mapNetworkDrive.gv script file (located under <BPM installation
directory>/yajsw/scripts).

4. Update the drive mapping command.

Examples:

« 'net use k: \\\myserven\$c'.execute().text
« 'net use J: \\\\myserven\c$ /USER:usemame password /PERSISTENT:no'.execute().text

« 'netuse J: \\\\myserver\\ /USER:usemame password /PERSISTENT:no'.execute().text

Note: Currently, you are unable to use mapped network resources on Linux.

How to Change the QTP/UFT User

If you have enabled BPM integration with QTP/UFT and want to change the user name that runs tests:

1. Stop BPM.
2. Gotothe <BPM application directory>\config\agent1.cfg file and change the following parameters
accordingly:

« QtpUserName
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« QtpDomainName

3. Start BPM.
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In Business Process Monitor 9.40, an AES (256-Bit) encryption algorithm enables you to use passwords with
strong encryption.

Learn About

This feature enables you to use passwords with strong encryption using the AES (256-Bit) encryption
algorithm.

This approach uses key pairs. You can generate a list of key pairs that can be used in BPM and VuGen. Both
keys are needed for encryption and decryption and they have to be installed on each BPM and VuGen
machine.

These passwords can be used to create secure VuGen scripts. Each BPM/Vugen combination have a
separate key pair.

Required Files

The utilities used for encrypting passwords and running the scripts that use them are located in the following
directories:

« BPM (for running scripts that use encrypted passwords) - <LoadGeneratorHome>\bin
Where the <LoadGeneratorHome> directory lies in the following path:
<BPM installation directory> \..\LoadGenerator\bin.

« VuGen (for creating and testing scripts that use encrypted passwords) - <VuGen installation
directory>\bin

The following utilities are used:

« aes_crypt_tool_gui.exe - Ul application that enables you to:

« Encrypt plain text passwords
« Re-encrypt existing passwords
« Decrypt AES passwords

« aes_crypt_tool_cmd.exe - Command line utility that enables you to:

« Generate encryption keys for each machine
« Encrypt passwords

« Decrypt encrypted passwords
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Re-encrypt old encrypted passwords

Convert AES encrypted passwords to old encrypted passwords

« aes_crypt.dll - A dll that enables BPM and VuGen scripts to use newly encrypted passwords.

« Other dlls - The following other dlls are required for aes_crypt_tool cmd.exe and aes_crypt_tool_gui.exe:

Crtlnitiator.dll

CrtLoader_VS6.dIl
CrtLoader VS8 0 50727 _1433.dll
CrtLoader VS9 0 21022_8.dll
mosifs32.dll

thrdutil.dll

You can copy these files to other BPM and VuGen machines as necessary.

The following diagram summarizes the process of implementing password encryption:

Use aes_crypt_ Set a key pair for Qopy aes_crypt.dil Create scripts that
tool_cmd.exe to each BPMand to the <VuGen>\bin use the new
generate key pairs VuGen machine directory encryption method

Use encrypted
scripts as you
would use regular
scripts

Use aes_crypt_ Set a key pair for Copy aes_crypt.dil Create scripts that
tool_cmd.exe to each BPM and to the <VuGen>\bin use the new
generate key pairs VuGen machine directory encryption method

Use encrypted
scripts as you
would use regular
scripts

Tasks

How to Generate and Deploy Encryption Keys

To generate and deploy encryption keys:

1.

On a BPM or VuGen machines, open a command prompt and navigate to the <LGSA or VuGen
installation directory>\bin folder.

Run the following command:
aes_crypt_tool_cmd.exe 1 <number of BPM and VuGen machines>
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For example, if you need keys for 20 machines the command is: aes_crypt_tool_cmd.exe 120

The EncryptionKeysFile.txt file is created in the same directory. The file contains a row with 2 keys for
each machine, separated by commas. The first key is the VuGen key and the second is the machine
key.

On each machine, in the <LGSA or VuGen installation directory>\config directories, create the following
sub folders:

« VugenConf

« MachineConf

Note:

The default path for configuration files on BPM is:
c:\HP\LoadGenerator\config\

The default path for configuration files on VuGen is:
c:\Program Files (x86)\HP\Virtual User Generator\config\

On each of the machines, in the VugenConf folder created in the previous step, create a file named
VugenlnitConf.txt that contains the key generated in the VuGen Key column of
EncryptionKeysFile.txt.

On each of the machines, in the MachineConf folder created in step 4, create a file named
MachinelnitConf.txt that contains the corresponding key generated in the Machine Key column of
EncryptionKeysFile.txt.

How to Use aes_crypt_tool_cmd.exe

Once you have generated and deployed the encryption keys, you can start encrypting and decrypting
passwords and using them in scripts.

The aes_crypt_tool_cmd.exe, located in the <VuGen or LGSA installation directory>\bin folder, enables you

to:

Generate encryption keys as described above.
Encrypt passwords (command option 2). For example, to encrypt the password MyPass:
aes_crypt_tool _cmd.exe 2 MyPass

Decrypt passwords (command option 3). For example, to decrypt the encrypted password
02bacc3b17ea2b501643450f310e4906:

aes_crypt_tool_cmd.exe 3 ©2bacc3bl7ea2b5016434501310e4906

Re-encrypt old encrypted passwords (command option 4). For example, to re-encrypt the old encrypted
password 5562f10c524e2c6c¢:

aes_crypt_tool cmd.exe 4 5562f10c524e2c6¢c

Convert AES encrypted passwords to old encrypted passwords (command option 5). For example, to
convert the AES encrypted password 02bacc3b17ea2b501643450f310e4906:

aes_crypt_tool _cmd.exe 5 02bacc3bl7ea2b5016434501310e4906

How to Use the aes_crypt_tool_gui.exe GUI Tool

This tool has a graphic user interface and enables you to:
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« Encrypt passwords. When you enter a password and click Encrypt Plain Text and Copy, the password
is encrypted and copied to the clipboard.

« Encrypt old passwords (passwords that are already encrypted by the old encryption in VuGen). When you
enter the old password and click Encrypt Old Password and Copy, the password is encrypted and
copied to the clipboard.

« Decrypt passwords. When you enter the encrypted password and click Decrypt Password and Copy,
the password is decrypted and copied to the clipboard.

How to Use Encrypted Passwords in Scripts

1. Declare the encryption/decryption functions you want to use in the script. The declaration must be done
before the start of vuser_init() or Action() functions. The declaration is necessary as LoadRunner
requires a declaration for every external function that returns a value other than int. The following
example shows the declaration of both the available functions:

extern char * convertAESPass20ld (char *, int);
extern char * decryptAES(char *, int);

2. Before using the functions you must load the dil that handles the encryption or decryption (aes_crypt.dll).
This dll is located in the \bin directory on the BPM and VuGen machines.

Toload the dll, use the the vuser_init() or Action() functions.

Example

1r_load_dl1l("aes_crypt.dll");

3. You can now call the functions:

« convertAESPass20ld(“<The AES encrypted password>", -1)
This function gets the AES encrypted password as a parameter and converts it to an old encrypted
password.

Use this function when the script requires a password encrypted in the old way as a parameter.
Example

convertAESPass201d("02bacc3bl7ea2b501643450f310e4906", -1) ;

o decryptAES (“<The AES encrypted password>", -1)
This function gets the AES encrypted password as a parameter and converts it to plain (unencrypted)
text.

Use this function when the script requires a password in plain text as a parameter.

Example

decryptAES (“ab855cd354”, -1) ;

Note: The following functions are equal:
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1r_decrypt(convertAESPass201d(“©2bacc3bl7ea2b5016434501f310e4906”, -1))

decryptAES (“©2bacc3bl7ea2b5016434501310e4906, -1)

Example 1 - Script Using Two Functions
The following is an example of the Action section of a script in which the two functions are used:

extern char *convertAESPass20ld(char *, int);
extern char *decryptAES(char *, int);

Action()

lr_load_dll("aes_crypt.dll ");

1r_message("New 2 0ld Pass ='%s'", convertAESPass201ld
("96862f667ed76elcd@a7d30fdll24efa", -1));

1r_message("decrypt New Pass to plain text='%s'", decryptAES
("96862f667ed76elcd@a7d30fdll24efa", -1));

return 0;

}

Example 2 - Script Using Parameters

The following is an example of the Action section of a script in which one of the functions uses
parameters:

extern char *convertAESPass20ld(char *, int);

Action()

{
lr_load_dll("aes_crypt.dll ");
lr_save_string(convertAESPass20ld("d@a7d30fdil24efa ", -1), "prmPassword");

web_edit_field("PASSWORD",
"Snapshot=t2.inf",
DESCRIPTION,
"Type=password",
"Name=PASSWORD",
ACTION,
"SetEncryptedValue={prmPassword}",
LAST);

return 0;

How to Enter Passwords not Using Functions
In some cases, you may need to enter passwords in a script, but cannot use functions.
« Thefollowing is an example of a script that cannot use functions and requires a plain text password:

web_edit_field("PASSWORD",
"Snapshot=t2.inf",
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DESCRIPTION,

"Type=password",
"Name=PASSWORD",

ACTION,
"SetValue=myPlainTextPassword",
LAST);

Use the following command to store the password in a parameter:
1lr_save_string(decryptAES("ab855cd354", -1), "prmPassword");
Then use the parameter in the script

web_edit_field("PASSWORD",
"Snapshot=t2.inf",
DESCRIPTION,
"Type=password",
"Name=PASSWORD",
ACTION,
"SetValue={prmPassword}",
LAST);

« The following is an example of a script that cannot use functions and requires a password that uses the old
VuGen encryption:

web_edit_field("PASSWORD",
"Snapshot=t2.inf",
DESCRIPTION,
"Type=password",
"Name=PASSWORD",
ACTION,
" SetEncryptedValue=myEncryptedPassword",
LAST);

Use the following command to convert the password to the required encryption and store it in a parameter:
lr_save_string(convertAESPass20ld ("ab855cd354", -1), "prmPassword");
Then use the parameter in the script:

web_edit_field("PASSWORD",
"Snapshot=t2.inf",
DESCRIPTION,
"Type=password",
"Name=PASSWORD",
ACTION,
" SetEncryptedValue={prmPassword}",
LAST);

How to Enter Passwords Using the Script Parameterization Feature (integrated in
BSM EUM Admin and VuGen)

If you want to enter passwords in a script using the Script Parameters feature which is integrated in BSM and
VuGen, you must:
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1. Convert the script parameter to a VuGen String object.
2. Decrypt it using one of the two decryption functions.

In the following example, a parameter called PrmPassword2 is converted to a String object using the Ir_
eval_string function, decrypted using the decryptAES function, and then saved as another parameter for
later use using the Is_save_string function. Finally, the new parameter that includes the decrypted password
PrmPassword is used in the web_submit_form function.

1r_save_string(decryptAES(1lr_eval string("{PrmPassword2}"), -1), "PrmPassword");
web_submit_form("login.pl",
"Snapshot=t9.inf",
ITEMDATA,
"Name=username", "Value=jojo", ENDITEM,
"Name=password", "Value={PrmPassword}", ENDITEM,
"Name=1login.x", "Value=59", ENDITEM,
"Name=login.y", "Value=13", ENDITEM,
LAST);

For more information on the script parameterization feature in BSM, refer to the "Script Parameter
Management Overview" section in the the APM User Guide.

For more information on the script parameterization feature in VuGen, refer to the "Parameter Overview
section in the VuGen User guide.

How to use Java-based protocols
Java-based protocols can use AES encryption password if they load aes_crypt.dll.

The following is an example of protocols Java VUser:

Note: Note that this example uses jna. You have to download jna.jar and add it as Extra Files into the
script.

File Actions:

import lrapi.lr;
import com.sun.jna.Library;
import com.sun.jna.Native;
import com.sun.jna.Nativelong;
import com.sun.jna.Platform;
public class Actions
{
// Import dll
public interface aes_crypt extends Library {
aes_crypt INSTANCE = (aes_crypt) Native.loadlLibrary("aes_crypt", aes_
crypt.class);
String convertAESPass201d(String aesEncryptedPassword, int
customerId);//extern char * convertAESPass20ld (char *, int);
String decryptAES(String aesEncryptedPassword, int customerId);//extern char
* decryptAES(char *, int);
}

public int init() throws Throwable {
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return 0;
}//end of init

public int action() throws Throwable {
lr.start_transaction("@1l. Load aes_crypt.dll");
aes_crypt aes = aes_crypt.INSTANCE;
lr.end_transaction("@1. Load aes_crypt.dll", 1r.AUTO);

1r.start_transaction("02. Decrypt AES256 password");

// customerId and AES256Password are script’s parameters.

int id = 1lr.eval_int("{customerId}");

String aes256Password = lr.eval string("{AES256Password}");

lr.output_message("The decrypted AES256 password: + aes.decryptAES
(aes256Password, id));

return 0;
}//end of action

public int end() throws Throwable {
return 0;
}//end of end

}

Limitations
« This approach can be used only for BPMs that are installed on Windows.
« You cannot use the AES encryption password for TruClient protocols.
« You cannot generate additional key pairs to encrypt or decrypt existing passwords.
If you need to encrypt or decrypt existing password, use one of the following workarounds:

o Generate a new list with key pairs and update encrypted password in your script and update keys one
each BPM and VuGen machine.

« Use an existing key pair on several BPM or VuGen machines.
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Send Documentation Feedback

If you have comments about this document, you can contact the documentation team by email. If an email
client is configured on this system, click the link above and an email window opens with the following

information in the subject line:
Feedback on Business Process Monitor Administration Guide (Business Process Monitor 9.40)
Just add your feedback to the email and click send.

If no email client is available, copy the information above to a new message in a web mail client, and send
your feedback to docteam@hpe.com.

We appreciate your feedback!
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